
 
 

 

 

 

 

Sage 500 ERP  
Installation and System 

Configuration Guide 

 
March 2024 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
© 2024 The Sage Group plc or its licensors. All rights reserved. Sage, Sage logos, 

and Sage product and service names mentioned herein are the trademarks of The 

Sage Group plc or its licensors. All other trademarks are the property of their 

respective owners. 

Business Objects® and the Business Objects logo, BusinessObjects®, and 

Crystal Reports® are trademarks or registered trademarks of Business Objects 

Software Ltd. in the United States and in other countries. Business Objects is an 

SAP company. 

Microsoft® and Microsoft SQL Server® are either registered trademarks or 

trademarks of the Microsoft Corporation in the United States and/or in other 

countries. 

Your use of this document and the Sage product(s) described herein is governed 

by the terms and conditions of the Sage End User License Agreement ("EULA") 

or other agreement that is provided with or included in the Sage product. Nothing 

in this document supplements, modifies or amends those terms and conditions. 

Except as expressly stated in those terms and conditions, the information in this 

document is provided by Sage "AS IS" and Sage disclaims all express, implied or 

statutory warranties of any kind, including but not limited to the warranties of 

merchantability, fitness for a particular purpose or of non-infringement. No implied 

license is granted to you under any Sage intellectual property or trade secret right. 

Sage reserves the right to revise, supplement or remove information in this 

document at any time without notice to you or others. 



Installation and System Configuration i 
 

 
 
 
 

Contents 

 
Chapter 1: Getting Started with Installation ............................... 1 

Information You Need ............................................................................................ 2 

Installing the Credit Card Module ......................................................................... 2 

System Requirements ........................................................................................................3 

Additional Sources of Information ......................................................................... 3 

Customer Support ............................................................................................................. 4 

Choosing an Installation Method ..................................................................... 5 

Overview .................................................................................................................................. 5 

Starting the Installation ......................................................................................... 7 

Overview .................................................................................................................................. 7 

Prerequisites for Installation .........................................................................................7 

Opening the Installation Screen ............................................................................. 7 

Third-Party Utilities and Program Updates ...................................................... 8 

Chapter 2: Overview of Installation ........................................... 10 

Structure ........................................................................................................................ 11 

Sage 500 ERP Architecture ..........................................................................................12 

Databases ............................................................................................................................... 13 

Client Systems .................................................................................................................. 14 

Additional Internet and Intranet Interfaces ................................................ 14 

Security .................................................................................................................................... 15 

 

 

 



Installation and System Configuration ii 
 

 

Installation .................................................................................................................... 17 
 
Installation Process ......................................................................................................... 17 

Upgrade Process ................................................................................................................18 

Registration Process .......................................................................................................20 

Registration Grace Period ......................................................................................... 23 

Number of Systems per License ............................................................................. 25 

Additional Software to Install ................................................................................ 26 

Chapter 3: Database Creation and Upgrade ............................. 27 

Using the Database Express Installation .....................................................28 

Overview ............................................................................................................................... 28 

Running the Database Express Installation ................................................... 28 

Installing the Database Utilities ....................................................................... 29 

Overview ............................................................................................................................... 29 

Preliminary Steps ............................................................................................................. 30 

Demo Data ........................................................................................................................... 31 

Installation Flow Chart ............................................................................................... 32 

Installing the Database Utilities ............................................................................ 33 

Creating New Databases ....................................................................................... 36 

Overview ............................................................................................................................... 36 

Starting the Database Creation Utility .............................................................. 36 

Which Databases to Create ...................................................................................... 37 

Database Naming Requirements .......................................................................... 37 

Default Administrative Logon ................................................................................ 39 

Procedure for Creating Databases ........................................................................ 40 

Upgrading Existing Databases .........................................................................42 

Overview ............................................................................................................................... 42 

Overview of the Upgrade Process ....................................................................... 42 

Upgrading Customized Databases ...................................................................... 43 

Adding Databases to an Existing Installation .............................................. 45 

Preliminary Steps ............................................................................................................. 46 

Starting the Database Upgrade Utility .............................................................. 48 

Comparing Databases .................................................................................................. 49 

Upgrading Databases .................................................................................................... 52 

Database Auditing Triggers ..................................................................................... 55 

 
 
 
 
 
 
 



Installation and System Configuration iii 
 

 
Establishing a Maintenance Plan ....................................................................56 

Overview ............................................................................................................................... 56 

Starting the Database Maintenance Wizard ................................................. 56 

Setting Up Database Maintenance ....................................................................... 57 
Running and Viewing Scheduled Tasks ......................................................... 59 

Chapter 4: Client Installation ..................................................... 63 

Preliminary Steps ..................................................................................................... 64 

Overview ............................................................................................................................... 64 

Options for Installing Client Software ............................................................ 64 

Preliminary Steps for Upgrades .............................................................................. 65 

Prerequisite Steps for Clients on SQL Server................................................ 65 

Use of Windows Installer .......................................................................................... 66 

Pre-installation Checklist for Client Installation ....................................... 66 

Installing the Client Software .......................................................................... 67 

Overview ............................................................................................................................... 67 

Installing Client Software ......................................................................................... 67 

Changing the Installation ......................................................................................... 70 

Enabling .Net framework 3.5 on Windows and Windows Server72 

Terminal Services Installation ........................................................................... 74 

Overview ............................................................................................................................... 74 

Precautions on Using Terminal Services ........................................................ 74 

Using Add/Remove Programs ................................................................................ 75 

Using the Change User Function ........................................................................ 76 

Configure Windows Server 2008 Terminal Services RemoteApp 
using TS Web Access .................................................................................................... 77 

Completion of Client Installation .................................................................. 79 

Overview ............................................................................................................................... 79 

Sage 500 ERP Shortcuts ............................................................................................... 79 

ODBC, Registry, and OLE DB Additions ......................................................... 80 

Installing the Sage Advisor Update ................................................................ 81 

Installing the Sage Advisor Update .................................................................... 81 

Installing Crystal Reports Designer ................................................................ 85 

Overview ............................................................................................................................... 85 

Prerequisites ........................................................................................................................ 85 

Installing Crystal Reports Designer .................................................................... 86 

 

 

 



Installation and System Configuration iv 
 

 

Chapter 5: Registration and Security ........................................ 87 

Starting Sage 500 ERP as an Administrator ................................................ 88 

Overview ............................................................................................................................... 88 

Default Logon .................................................................................................................... 88 
Logging on as an Administrator ........................................................................... 89 

Registering the Software ....................................................................................... 91 

Overview ............................................................................................................................... 91 

Prerequisite Steps .............................................................................................................. 91 

Registration Procedure ................................................................................................. 92 

Registration Renewals ................................................................................................... 97 

Troubleshooting Automatic Registration .......................................................99 

Setting Up Companies and Modules .......................................................... 100 

Overview ............................................................................................................................ 100 

Information Used in Setting Up Companies ........................................... 101 

Setting Up the Company ....................................................................................... 101 

Activating Modules ..................................................................................................... 102 

Editing Companies ....................................................................................................... 104 

Deleting Companies .................................................................................................... 105 

Setting Up Users .................................................................................................... 106 

Overview ............................................................................................................................ 106 

Set Up Security Groups ............................................................................................. 106 

Setting Up Users ........................................................................................................... 110 

Security Options ............................................................................................................. 116 

Changing User Settings ............................................................................................ 117 

Chapter 6: Managing and Protecting Databases ................... 119 

Using the Database Synchronization Utility .......................................... 120 

Overview ............................................................................................................................ 120 

Precautions ........................................................................................................................ 120 

Starting the Database Synchronization Utility ......................................... 121 

Using the Utility........................................................................................................... 122 

Connecting the Client ............................................................................................. 123 

Options for Copying or Moving Databases ............................................ 124 

Overview ............................................................................................................................ 124 

Copying Data Between Companies .................................................................. 124 

Single-User Unique Set on the Same SQL Server ................................... 125 

Multi-user Duplicate Set on the Same SQL Server ................................ 125 

Multi-user Duplicate Set on a Separate SQL Server .............................. 127 

 



Installation and System Configuration v 
 

 

Chapter 7: System Configuration and Management ............. 129 

Desktop Customizations ....................................................................................... 130 

Overview ............................................................................................................................ 130 
Prerequisites for Making Administrative Customizations ................. 131 

Changing and Saving Task Menus ................................................................... 131 

Setting Task Menus for Users............................................................................... 133 

Adding Custom Reports ......................................................................................... 135 

Search Form Customization .................................................................................. 137 

System Management ............................................................................................. 141 

Overview .............................................................................................................................141 

Setting the Business Date ........................................................................................141 

Monitoring System Usage ...................................................................................... 143 

Viewing System Settings ......................................................................................... 144 

Chapter 8: Working with Visual Process Flows ..................... 149 

Requirements .................................................................................................................... 150 

Launch Sage 500 ERP Task Embedded within Visual Process 
Flows ...................................................................................................................................... 150 

Edit a Visual Process Flow ....................................................................................... 151 

Create a Visual Process Flow ................................................................................. 152 

Embed a Sage 500 ERP Task into a Visual Process Flow...................... 153 

Embed Link to Another Sage 500 ERP Visual Process Flow............ 155 

Add a Visual Process Flow to Menu ................................................................. 156 

Changing Desktop Users ........................................................................................ 158 

Add Visual Process Flow Toolbar Option ......................................................158 

Export/Import .................................................................................................................. 160 

Miscellaneous ................................................................................................................. 162 

Appendix A: Working with Reports ............................................ 163 

System Manager Reports ................................................................................... 164 

Overview .............................................................................................................................164 

System Activity Log .................................................................................................... 164 

Maintenance Audit Log ........................................................................................... 165 

Company Profile Report ......................................................................................... 166 

Company User Group Permissions Report ................................................ 167 

System Manager Lists .......................................................................................... 168 

Overview .............................................................................................................................168 

User List ............................................................................................................................... 168 

Security Group List ......................................................................................................169 

Company List ..................................................................................................................169 



Installation and System Configuration vi 
 

 

Site Profile List ................................................................................................................ 170 

Assisted Company Setup List ................................................................................ 170 

Appendix B: Data Import Manager ............................................. 172 

Installation and Configuration Checklists ............................................. 173 

Overview ............................................................................................................................ 173 

Server-Side Checklist .................................................................................................... 174 

Client-Side Checklist .................................................................................................. 175 

SQL Server Installation and Configuration ............................................. 176 

Overview ............................................................................................................................ 176 

Installing Services and Utilities ........................................................................... 177 

Working with Multi-Format Text Files ......................................................... 177 

Data Import Manager Database Upgrade and Relocation ................ 178 

Data Import Manager Configuration for SQL Server 2008 64-bit... 
179 

Sage 500 ERP Installation and Configuration Requirements ....... 180 

Overview ............................................................................................................................ 180 

Sage 500 ERP Client Installation and Configuration Requirements 
. ................................................................................................................................................. 181 

Creating the Logon Accounts for Users Working with Data Import 
Manager .............................................................................................................................. 184 

Configuring the Sage 500 ERP Credential After Installing 
Sage 500 ERP .................................................................................................................... 185 

Setting Passwords for Sage 500 ERP Accounts with a Standard 
SQL Server Logon .......................................................................................................... 186 

Accessing Source Files and Shared Folders for Hosting ...................... 188 

Accessing Data Import Manager Tasks .......................................................... 189 

Appendix C: Working with Alerts ............................................... 193 

SQL Server Agent ................................................................................................... 194 

Overview ............................................................................................................................ 194 

Database Mail ........................................................................................................... 195 

Overview ............................................................................................................................ 195 

Configuring Database Mail For SQL 2008 .................................................. 196 

Appendix D: Protocol Issues ...................................................... 204 

Named Pipes over TCP/IP ................................................................................. 205 

Multi-Protocol over TCP/IP ............................................................................. 207 

TCP/IP Sockets over TCP/IP Protocol ......................................................... 209 



Installation and System Configuration vii 
 

 

Appendix E: Silent Installation .................................................... 211 

Using Silent Installation .................................................................................... 212 

Overview .............................................................................................................................212 

When to Use Silent Installation ......................................................................... 212 

Precautions ......................................................................................................................... 213 

Installing with Defaults ........................................................................................... 213 

Installing with Parameters ................................................................................... 214 

Appendix F: Desktop and Command Shortcuts ........................ 217 

Command Formats ............................................................................................... 218 

Overview .............................................................................................................................218 

Methods for Creating Shortcuts ........................................................................ 218 

Command Syntax ....................................................................................................... 218 

Directly Launched Tasks and the Desktop ................................................. 223 

Task lDs and Programs ....................................................................................... 224 

Overview .............................................................................................................................224 

Obtaining the Task ID .............................................................................................. 224 

Appendix G: Best Practices for SQL Server Maintenance ........ 227 

Best Practices to Perform Once ...................................................................... 228 

Daily Best Practices .............................................................................................. 229 

Weekly Best Practices.......................................................................................... 230 

Monthly Best Practices ....................................................................................... 231 

Miscellaneous Best Practices ........................................................................... 232 

Appendix H: Upgrading from SQL Server version 

2008 R2 SP3 or 2012 ..................................................................... 233 

Upgrading from 2008 R2 SP3 or 2012 ....................................................... 234 

Appendix I: Error Messages ...................................................... 235 

Setup and Configuration Errors .................................................................. 236 

Registration Errors ............................................................................................... 237 

System Configuration Errors ......................................................................... 240 

Additional Error Messages ................................................................................ 242 

Index ............................................................................................. 243 



Installation and System Configuration 1 

 

 

 
 
Getting Started with  
 
Installation 

 

 

 

Sage, a recognized leader in accounting software for mid-sized businesses, welcomes 

you to Sage 500 ERP business software that provides superior power, flexibility, and 

integration with your existing line of business applications. 
 

This chapter provides information you need to start the installation and shows how 

to start the installation programs. 

In this chapter 

Information You Need .......................................................................................... 2 

Choosing an Installation Method .................................................................. 5 

Starting the Installation ........................................................................................ 7 

1 
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Information You Need 
 

 
Introduction 

This Installation and System Configuration guide describes the procedures for installing 

and configuring the system. It also includes procedures for the System Manager 

module, which is part of the installation and configuration process. 

Read this guide and additional sources of information before proceeding with the 

installation. 

Tip: If you are viewing this document online in Adobe Acrobat, click any of 

the blue text to jump to the indicated heading or Web site. 

 

Installing the Credit Card Module 
 

Setting Up Credit Card Processing 

To set up the Credit Card module: 

1 Obtain a merchant ID and merchant key from Sage Payment Services. 
 

2 Activate the credit card module in Maintain Companies. 

3 Back up your database master key. THIS IS VERY IMPORTANT. Refer to 

Protecting Merchant Information in the Help system for the Credit Card 

module, Getting Started with Credit Cards/Setup Tasks. 

4 Set up credit card processor accounts, deposit groups, and tender types. 
 

For more information, refer to Getting Started with Credit Card and Flowcharts for 

Credit Card help in the Help system. 
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System Requirements 
 

Compatibility and Resource Guide 

For information about system requirements, supported platforms, and 

recommended configurations, refer to the Compatibility and Resource Guide located in 

the Support page on the Sage Customer Portal at: 

https://customers.sagenorthamerica.com 

 

Additional Sources of Information 
 

Introduction 

This section lists other documentation you should read. 

 
Additional installation guides 

The following components have separate installation guides: 
 

Product Installation Guide 

Business Insights Dashboard Internet Applications guide 
 

 

Software Development Kit (SDK) documentation 

If you plan to customize the software, read the documentation provided with the 

Sage 500 ERP SDK to determine the extent of the customization and to plan how the 

customizations will be added. The SDK release notes provide important information 

about new releases. 

https://customers.sagenorthamerica.com/
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Customer Support 
 

Introduction 

Customer support is available on the Sage Customer Portal at: https:// 

customers.sagenorthamerica.com 

 
Telephone 

Contact Support at the following telephone numbers: 

 
Telephone Fax 

(800) 944-5487 (800) 864-7698 
 

https://customers.sagenorthamerica.com/
https://customers.sagenorthamerica.com/
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Choosing an Installation Method 
 

 
Overview 

 
Introduction 

There are several methods for installing the software. Use the flowchart to select the 

installation program you need to run. For installation instructions, see Starting the 

Installation on page 7. 
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Starting the Installation 
 

 
Overview 

 
Introduction 

This section describes how to start the installation and use the window that launches 

the installation software. 

 

Prerequisites for Installation 
 

Internet Explorer requirement 

If you are using the Business Insights Dashboard, you need Microsoft Internet 

Explorer. For more information, refer to the Business Insights Dashboard guides. 

 
Adobe Flash 

Adobe Flash must be installed on the client workstation to view or edit Visual 

Process Flows. This component is not installed by the Sage 500 ERP installation. This 

component can be downloaded from Abode’s website. 

 

Opening the Installation Screen 
 

Procedure 

To start the installation, download the installation executable file from the location 

specified in your e-mail from Sage. Double-click the executable file to start the 

installation program. 
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Using the Installation window 

The Installation window appears. Click the button on the left to select the 

installation program or document to use. 

 
Viewing guides 

A number of documents are provided in PDF. 

 
Documentation about software installations 

This Installation and System Configuration guide describes how to use the Express 

Installation of databases and all components and the standard client and database 

utilities installation. For instructions on installing other Sage 500 ERP software, refer 

to the following guides: 

• Web-Based Applications: Refer to the Business Insights Dashboard guide. 

• Schema Browser: Refer to the Development Utilities guide of the SDK. 

 
 

Third-Party Utilities and Program Updates 
 

Introduction 

The installation window also allows you to install required service packs and product 

updates. 
 

The following third-party utilities and program updates are available on the Sage 

website. Refer to the software manufacturer if you encounter any problems applying 

these updates. 

 
Microsoft Data Access Components 2.8 

Microsoft Data Access Components (MDAC) 2.8 is automatically installed during the 

Sage 500 ERP client installation. The MDAC installation contains the core 

components (ADO, OLE DB, and ODBC) and additional OLE DB providers and ODBC 

drivers for various data stores. Use these components to integrate information from 

a variety of both relational (SQL) and nonrelational sources. 
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Scripting 

The scripting components support the Customizer module. The Sage 500 ERP client 

installation automatically installs the portions of the scripting components required 

for Customizer. 

 
Microsoft Service Packs 

Use the links on the Installation screen to go to the appropriate pages of the 

Microsoft Web site where you can download or order the service packs. 
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Overview of  
 
Installation 

 
 

This chapter provides an overview of the installation process. This section will give 

you an understanding of how the software works so that you can plan your 

installation. 

In this chapter 

Structure ....................................................................................................................... 11 

Installation ................................................................................................................... 17 

2 
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Structure 
 

Overview 
 

Introduction 

To help you in planning and preparing to install the software, this section explains 

the architecture used by the system and provides an overview of the processes for 

installing or upgrading a new system. 
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Sage 500 ERP Architecture 
 

Description 

The software is a two-tier client/server application. The following figure shows an 

overview of the system, which is explained in the following sections. 
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Databases 
 

Types of databases 

The core of the system is the Application database containing the information. This 

database contains the following types of information. 

► System information shared by all modules (for example, user 

identification, security groups, and company information) and seed data 

used to activate modules. 

► Enterprise resource planning (ERP) information shared by companies. More 

than one company can use the same database. 

 
Transaction logs 

As with all SQL Server databases, the databases have transaction logs. 

 
Database maintenance 

Treat all of the databases as one unit when performing maintenance. For example, 

all databases should be backed up at the same time. 

 
SQL Server databases 

Along with the Sage 500 ERP databases, you should also be aware of SQL Server 

databases that affect the access performance and security of Sage 500 ERP data: 

• tempdb: The tempdb database is used for temporary data storage while data is 
being written to and from databases. For best performance, set the database 
sizes as recommended in the Sage 500 ERP Compatibility and Resource Guide 
located in the Support page on the Sage Customer Portal at: 
https://customers.sagenorthamerica.com 

• master: The master database contains all system-level information and 
identifies the presence of all databases on the SQL Server, including the Sage 
500 ERP databases. 

Warning: If the master database becomes corrupted, you can lose your data. 

Back up the master database and do not modify it manually. 

https://customers.sagenorthamerica.com/
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Client Systems 
 

Description 

The client systems serve as the front end to the Sage 500 ERP data. The client systems 

are connected to the server through a TCP/IP-compatible network, which can 

include local-area networks and remote connections. 

 
Parts of client systems 

To use the data, the systems need the client software. The client software consists of 

the following: 

• Applications (including COM objects and system DLLs) for accessing data 

• Crystal Reports runtime for generating reports 

• Help system 

 
Methods of installing client software 

You can install the client software in the following ways: 

• Install the client software directly on the system. 

• Access the client software through a system with Terminal Services. 

 

Additional Internet and Intranet Interfaces 
 

Description 

The Internet Applications allow users to access data through the Internet or an 

intranet by using a Web browser. For more information, refer to the Business Insights 

Dashboard guides. 
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Security 
 

Description 

Several security measures are used to protect your crucial and confidential business 

data at the server and client. 

 
Security groups 

Security groups allow you to grant access to modules and tasks. For example, you can 

create a security group to grant invoice entry clerks read/write access to invoice entry 

windows and no access to any of the other features. You then grant access to 

individual users by assigning them to security groups. 

 
Logon requirements 

Users must log on to use the software. You can use either SQL Server authentication 

where users need to enter their SQL Server user name and password each time they 

start the software, or you can use Windows authentication that logs users on using 

their Windows user name and password. 
 

To enable a user to log on to the software using Windows authentication, set up the 

user in a Windows domain. When you add the user, the system records the domain 

and logon name. A Windows authenticated logon is also created in the SQL Server. 

After users have logged on for the first time with Windows authentication, they can 

optionally start the software without seeing the logon window. 

 
Application role 

You can set the software to use an application role to grant access to databases only 

when the user is logged into the software. For more information, see Chapter 5, 

Registration and Security. 
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DI package user and administrator roles 

You can set roles for users who will be creating, maintaining, or running import jobs 

within the Data Import Manager module. These roles are established in the Maintain 

Users window by selecting the DI Package User or DI Package Administrator check 

boxes for users. 

Note: The user must also belong to a Sage 500 ERP security group that has 

access to all Data Import Manager tasks. 
 

For more information about installing and configuring the Data Import Manager 

module, see Appendix B, Data Import Manager Installation & Configuration. 



Overview of Installation 

Installation and System Configuration 17 

 

 

 

Installation 
 

Overview 
 

Introduction 

This section provides overviews of the installation and upgrade processes. Full 

procedures are described in the other chapters of this guide. 

 

Installation Process 
 

General steps 

This section provides an overview of the steps to perform when you install the 

software for the first time or install it on a new server. Installation includes the 

following general steps, which are described in detail in this guide: 

Note: For more information about system requirements, refer to the 

Compatibility and Resource Guide located in the Support page on the Sage 

Customer Portal at: 

https://customers.sagenorthamerica.com 

 
For more information about installing and configuring the Data Import 

Manager module, see Appendix B, Data Import Manager Installation & 

Configuration. 

1 Complete tasks for planning and assessing system requirements. Make any 

upgrades that are necessary. 

2 Create databases by performing one of the following: 

► Run the Database Express Installation to create databases without installing 

software. For more information, see Using the Database Express Installation on 

page 28. 

https://customers.sagenorthamerica.com/
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► Install the Database Utilities and run the Database Creation Utility. For 

more information, see Chapter 3, Database Creation and Upgrade. 

To determine which installation method to use, see Choosing an Installation Method 

on page 5. 

3 Use the Client Installation wizard to install the client software. 

4 Run the Client Configuration Utility to set the database and server to access 

from the client software. 

5 Run System Manager to register the software and grant access rights to your 

users. 

 

Upgrade Process 
 

General steps 

If you are upgrading an existing system, follow a different set of steps from a fresh 

installation. These are described in detail in this guide. The following lists the 

general steps for performing an upgrade: 

1 Prepare for the upgrade by performing the following: 

► Review the system requirements as shown in the Compatibility and Resource 

Guide located in the Support page on the Sage Customer Portal at: 

https://customers.sagenorthamerica.com 

► Review the new software features described in the Release Notes. The new 

features may affect how you change the configuration and implementation 

of the software. 

► Back up your databases. 

► Upgrade SQL Server, if necessary. 

Note: If you plan to use the Data Import Manager module to import data 

from source tables into the destination (permanent) tables, refer to the 

Compatibility and Resource Guide located in the Support page on the Sage 

Customer Portal at: 

https://customers.sagenorthamerica.com 

For more information about installing and configuring the Data Import 

Manager module, see Appendix B, Data Import Manager Installation & 

https://customers.sagenorthamerica.com/
https://customers.sagenorthamerica.com/
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Configuration. 

2 Run the Database Utilities Installation to install components on your local 

drive for updating databases. When the Server Install is finished, you are 

prompted to run the Database Creation Utility. Click No. 

3 Run the Database Upgrade Utility to upgrade the database to the new version. 

If your database schema has been customized, use the Database Upgrade Utility 

to run a comparison between your database and a standard database or another 

database. The utility can also generate custom database update scripts that can 

be used to retain your schema modifications. 

4 Upgrade the client software by clicking Client Install. You can install the client 

software on each system or from a network sharepoint. 

5 Run the Client Configuration Utility to set the database and server to access 

from the client software. To access this utility, select Windows Start menu 

> Sage > Sage 500 ERP 2023 > Utilities > Client Configuration Utility. 

6 Run System Manager to register the software and grant access rights to your 

users. 
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Registration Process 
 

Introduction 

When you install a Sage 500 ERP database, the database can be used for evaluation 

purposes for 45 days. To use the database, it must be registered. You can register the 

database at any time. The registration process registers all the modules you 

purchased. 

This section provides an overview of the registration process. For instructions on 

performing registration, see Chapter 5, Registration and Security. 

 
About the registration system 

When you purchase the software, Sage records information about the license you 

purchased in a central registration database. You submit a registration request to 

Sage to retrieve an encoded string that gives you access to the software according to 

your license. 

With your package, you receive a packing list with the following information: 

• Customer number 

• System Manager serial number 

• System Manager unlocking key 
 

If you are upgrading, use the customer number, System Manager serial number, and 

System Manager unlocking key from your current version of the software. If you are 

unable to get this information, contact Customer Support. 
 

You enter this information into the software, which generates a registration request 

string based on your system and the software you have installed. The registration 

request string is sent back to Sage, either automatically or manually at the 

registration site. Sage returns a registration string that you enter into the software. 

This string gives you access to the modules and the number of users, companies, and 

other settings defined in your license. 
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The following figure shows the registration process: 

 

Customer number, 
serial number, and 
unlocking key on 
packing list 

 
 

Enter information into 
Maintain Site 

 
 
 
 
 
 
 

Registration request 
sent to Sage 

 
 

 
Information about 
your company and 
your license 

 
Registration 

database 

 
Sales 

database 

 

Sage 
 

 
 
 
 

 
Sage 500 ERP 

Registration string for customer 
number, serial number, and 
unlocking key (sent either 
automatically to the server or copy 
and pasted manually into Maintain 
Site) 
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Methods of registration 

The following methods of registration are available: 

 
Method Description When to use 

Automatic The system sends 
registration 
information to Sage 
and automatically 
updates the system 
with the information. 

 

Manual Visit the registration 
Web site. Copy the 
registration request 
message generated in 
Maintain Site and 
paste the registration 
message generated on 
the page. 

If you want 
registration updates 
to be sent 
automatically. 

 
 

If you do not have 
continuous Internet 
access and SQL Server 
scheduling. 

If automatic 
registration does not 
work because of a 
firewall that blocks 
messages. 

If you prefer full 
control over the 
registration process. 
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Registration renewal 

You need to register the software again when it is time to renew your maintenance 

and support agreement. If you decide not to renew the maintenance and support 

agreement, you must obtain a new registration string, which allows you to continue 

using the software for an unlimited time, but does not allow you to install patches 

and updates. 

 
Registration and hardware changes 

The registration processes uses the SQL Server name, database name, the MAC 

address, customer number, System Manager serial number, and System Manager 

unlocking key to uniquely identify your installation. If any of this information is 

altered, the registration message becomes invalid and the system becomes 

unregistered. 

During the logon, you will receive notification about your system's registration 

status and the number of days left in the registration grace period. If you do not 

register the system within the grace period, it will become unusable. (For an 

explanation about test systems, see Number of Systems per License on page 25.) Contact 

Sage Customer Support to reinstate your production license. 

 
Registration and fail-over clustering 

If you configure your SQL Server for fail-over clustering, install the Sage 500 ERP 

Database Utilities on each fail-over SQL Server. This enables a production system to 

stay registered when a node is down because of failure or maintenance. 

 

Registration Grace Period 
 

Introduction 

You have 45 days to register the software after the Sage 500 ERP databases have been 

installed. The 45-day grace period also applies after the registration expires. You 

need to renew registration within 45 days of the expiration of the maintenance and 

support agreement to continue using the software, whether or not you plan to 

continue the agreement. 
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Handling of unregistered modules 

If Sage 500 ERP is not registered or if the registration has expired, a message window 

appears when you log on. 

 
Click OK to continue to open the software. 

 
If this message window appears even though the registration was renewed, Sage 500 

ERP may have been unable to access the Sage registration system through the 

Internet. Perform a manual registration or register from another client system. For 

more information, see Registration Procedure on page 92. 

 
Access during the grace period 

During the grace period, the following access is available to you: 

• All modules available for activation 

• Data Migrator and DataPorter for demo data companies only 

• Five concurrent users 

 
After the grace period 

If you have not registered the modules within the 45-day grace period, you cannot 

access modules or the data in them until you register them. After that, you can access 

only the modules you have registered, and you will lose any data entered in modules 

you did not register; therefore, do not activate modules you do not intend to 

register. 
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Number of Systems per License 
 

Introduction 

The number of systems you can have depends on your license type. To register a 

system, enter the customer number, System Manager serial number, and System 

Manager unlocking key, or the indicated word in the Maintain Site window. For 

instructions, see Registration Procedure on page 92. 

You are automatically assigned a total of two systems: 

• One production system 

• One test system 
 

Both systems have the same number of users, companies, and other settings granted 

by the license. 
 

If you have a developer support license, you are assigned a development system in 

addition to the two end-user systems. 

 
Production licenses 

Use your production license for your actual production system accounting data. To 

register this production system, enter the customer number, System Manager serial 

number, and System Manager unlocking key from the packing list. 

 
Test licenses 

Use a test license for testing or training. It cannot be used for a production system. A 

test system by default is identical to the production license, except that a watermark 

appears on checks. 

 
Selecting a license type 

To select a license type for an installation, use Maintain Site in System Manager. For 

more information, see Registration Procedure on page 92. 
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Additional Software to Install 
 

Introduction 

With Sage 500 ERP, you may have purchased other applications provided on the 

Sage 500 installation website. Instructions for installing these applications are in the 

following locations: 

• For a new installation of the Crystal Reports Designer, see Installing Crystal 
Reports Designer on page 86. 

• To install the Business Insights Dashboard module, refer to the Business Insights 
Dashboard guide. 

• Abra Link is distributed by Sage Abra on their product website. Fixed Assets 
Link is distributed by Sage Fixed Assets on their product pages. These 
integration links will import data directly into General Ledger Journal 
Transactions. 

• The FAS Asset Accounting Interface requires the installation of the Fixed Assets 
SDK. You must have the Sage FAS windows client installed on your PC prior to 
installing the Fixed Assets SDK. The Sage Fixed Assets windows client is located 
on the Sage 500 ERP installation website. After installation, activate the Fixed 
Assets Link in Maintain Companies to enable the integration. 
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Database Creation 
 
and Upgrade 

 
 

This chapter shows you how to create new databases and upgrade existing ones. You 

can create databases in the following ways: 

• Run the Database Express Install to create a complete database set without 
installing the Database Utilities. 

• Install the Database Utilities to install or upgrade databases according to the 
settings you choose. 

 

To help you choose which method to use, see Choosing an Installation Method on 

page 5. 

In this chapter 

Using the Database Express Installation ................................................. 28 

Installing the Database Utilities ................................................................... 29 

Creating New Databases .....................................................................................36 

Upgrading Existing Databases ...................................................................... 42 

Establishing a Maintenance Plan ................................................................. 56 
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Using the Database Express 
Installation 

 

 
Overview 

 
Introduction 

Use the Database Express Installation to create a complete set of databases, including 

application databases, without installing additional software on your server. 
 

Run the Database Express Installation on the system where you plan to create the 

databases. To create databases on a remote SQL Server, install the Database Utilities. 

Prior to beginning the installation, verify the version and edition of SQL Server you 

have installed. If you are currently running version 2008 R2 SP3 or 2012, see 

Upgrading from SQL Server version 2008 R2 SP3 or 2012 on page 233. 

 

Running the Database Express Installation 
 

Procedure 

To run the Database Express Installation: 

1 Start the Database Express Installation by performing the following: 

► From the installation window, click New Databases. 

2 Use the Database Express Setup Wizard to install the databases on your 

computer. 
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Installing the Database Utilities 
 

 
Overview 

 
Introduction 

To create or update databases, you need to install the Database Utilities either 

directly onto the server or on a client workstation. 
 

For information about requirements for installing the software, refer to the 

Compatibility and Resource Guide located in the Support page on the Sage Customer 

Portal at: 

https://customers.sagenorthamerica.com 
 

Also, read the information in this section to verify the system meets the necessary 

requirements. 

 
Upgrade from Prior Versions 

Consider the following when upgrading to the current version. 

• If you are upgrading from version 7.4 through 7.8, you must first upgrade to 
version 2013 and then upgrade to version 2023. 

• If you are upgrading from version 2013, 2014, 2016, 2017, 2018, or 2019 
you can upgrade directly to version 2023. 

• Only three prior versions can be directly upgraded to the current version. 

 
Where to install the Database Utilities 

Note the following when deciding where to install the Database Utilities and 

databases: 

• The server where you install the databases can be located anywhere on the 
network, as long as the SQL Server is visible using SQL Server Enterprise 
Manager or SQL Server Management Studio. 

https://customers.sagenorthamerica.com/
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• If you configure your SQL server for fail-over clustering, install the Sage 500 

ERP Database Utilities on each fail-over SQL server. This enables a production 
system to stay registered even when a node is down because of failure or 
maintenance. 

 

Preliminary Steps 
 

Procedure 

This section provides information you need before starting the database installation. 

This includes preliminary steps and a flow chart to follow for installing new or 

updating existing databases. 

Before you create or update databases, perform the following: 

1 Log on to the server as local Administrator. 

2 Start the SQL Server service. 

3 Uninstall previous versions of the Database Utilities, service packs, and updates 

before installing the new version of the Database Utilities. 
 

If you need to move or copy databases as part of your database creation or upgrade 

procedures, see Chapter 6, Managing and Protecting Databases for instructions. 

 
Distributed Management Objects requirement 

The system where you install the Database Utilities needs to have Distributed 

Management Objects (DMO). To install DMO, install the client software provided 

with SQL Server. See the SQL Server documentation for instructions. 

 
Use of Windows Installer 

All installation programs use Microsoft Windows Installer. If you already have 

Windows Installer, the version of Windows Installer that is already on your system is 

used. If you do not already have Windows Installer, it is installed by Sage 500 ERP. It 

may take a moment to install the Windows Installer before the installation starts. 
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Demo Data 
 

Description 

You have the option of installing demo data when you create new databases. If you 

plan to install demo data, note the following information in this section. 

 
Demo data companies 

When you install demo data, three demonstration companies are added to the 

database for your use: CAD, COA, and SOA. 

Use the following demo companies for different types of evaluation and testing: 

• All modules: The Systems of America (SOA) company contains data in all of the 
Sage 500 ERP modules that you can use for testing or viewing. 

• Manufacturing: Consultants of America (COA) and SOA contains 
Manufacturing demo data. Use these companies for training and when 
following the examples in the Manufacturing Help system. 

• Accounting: The Canadian Inc. (CAD) company contains demo data for all 
accounting modules using Canadian dollars as the home currency. CAD does 
not contain manufacturing or replenishment demo data. 
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Start 

Yes 

Are you 
upgrading 

existing 
databases? 

No 

Are you 
upgrading to SQL 
Server 2008 R2, 
2012, or 2014? Yes 

No 
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Creation Utility 
to create new 

databases 

Upgrade to SQL 
Server 2005 or 

2008 

Run Database 
Upgrade Utility 

to upgrade 
databases 

Install 
Database 
Utilities 

Back up 
databases 

Run the 
Database 

Maintenance 
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Installation Flow Chart 
 

Flow charts 

The procedures you follow in this chapter depend on whether you are creating new 

databases or upgrading existing ones. The following chart shows the general steps for 

these procedures. 
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Installing the Database Utilities 
 

Introduction 

This section describes how to install the Database Utilities by using the Database 

Utilities Setup Wizard. 

 
Starting the installation 

Start the Database Utilities Setup Wizard by performing one of the following: 

• From the installation window, click Database Install. For information about 
starting installation, see Starting the Installation on page 7. 

• From the command line in the Run window or the Command Prompt, enter 
one of the following commands to run either the Database Creation or the 
Database Upgrade Utility after installing the Database Utilities. 

► Setup.exe INSTALLDATABASE=1 

Launch the Database Creation Utility at the end of the installation. The 

Database Creation Utility runs automatically if no parameter is specified. 

► Setup.exe /VUPGRAGEDATABASE=1 

Launch the Database Upgrade Utility at the end of the installation. 

 
Database Utilities Setup Wizard window 

When the installation starts, the Database Utilities Setup Wizard appears. 

 
Uninstallation of prior versions 

If you already have the Database Utilities on your system, the installation wizard 

detects them and gives you the option to remove them before you install the new 

software. Click Remove to uninstall the old software. The wizard then starts the 

installation process. 
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Procedure 

Click Next to start the installation and follow these steps: 

1 Review the license agreement that appears. Select I accept the terms in this 

license agreement and then click Next to continue. 

2 When you are prompted to enter your information, the fields display the name 

and organization recorded in the Windows Registry. You can change this 

information as desired. You can also select whether the software is available to 

all users or just yourself. Click Next to continue. 

3 You have the following installation options: 

► Select Complete to install all database components into C:\Program 

Files\Sage Software\Sage 500 ERP Database Utilities. 

► Select Custom to select the drive and folder where files will be installed and 

what will be installed. 

Select the option and click Next. 

If you selected Custom, go to the next step. If you selected Complete, go to step 5. 

4 If you selected Custom, the Custom Setup window appears. Perform one of the 

following: 

► To install the software in the default folder, click Next to continue. 

► To install the software in a different folder, click Change to select the 

folder from a window. Click Next to continue. 

Note: All of the features listed in the window must be installed. None of the 

items can be removed from the installation list. 

5 Click Install to install the software. A status bar indicates the progress. To 

cancel the installation, click Cancel. 
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Prompt when the installation is completed 

When the Database Utilities are finished installing, the following utility starts: 

• If you launched the Database Utilities Installation directly from the Sage 500 
ERP installation website or from the menu on the left side of the Installation 
window, the Database Creation Utility starts. 

• If you launched from a command prompt, the utility you specified with the 
variable appears. If you did not specify a variable, the Database Creation Utility 
starts. 

 

The logon window to start the utility appears. The following is the logon window for 

the Database Creation Utility: 
 

 

If you do not want to run the utility, click Cancel. To continue with the utility, 

perform the following: 

1 Select the server where you want to install or upgrade the databases. 

2 Type the system administrator logon name and password. 

3 Click Proceed. 

4 Continue the database installation or update process by going to the following 

section: 

► If you are creating new databases, see the next section, Creating New 

Databases on page 36. 

► If you are updating existing databases, see Upgrading Existing Databases on 

page 42. 
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When you are finished creating or updating the databases, you can install the client 

software as shown in Chapter 4, Client Installation. 

 

Creating New Databases 
 

 
Overview 

 
Introduction 

Follow the procedures in this chapter if you are creating new databases. Some of the 

situations for when to create a new database include the following: 

• Creating new production databases for a new installation. 

• Creating demo databases for evaluation, testing, or training. In this procedure, 
you set an option that creates the databases and automatically loads them with 
demo data. 

• Creating blank databases into which you will import data from another source. 
 

Do not use these procedures if you are upgrading an existing database. For more 

information, see Upgrading Existing Databases on page 42. 

 

Starting the Database Creation Utility 
 

Description 

Use the Database Creation Utility to create databases. Database creation is a lengthy 

process and can take up to one hour, depending on the server configuration. Plan 

accordingly before starting the database creation process. 

 
Starting the Database Creation Utility 

If you are prompted to start the program after the Database Utilities have been 

installed, click Yes to continue. 
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You can also start the Database Creation Utility at any time by selecting Windows 
Start menu > All Programs > Sage > Sage 500 ERP 2012 > Utilities > Database 
Creation Utility. 

 
 

Which Databases to Create 
 

Database requirements 

You must create an application database. 

 
Additional databases 

You also need to install databases that apply to the modules you are using. 
 

To use the additional databases, you must activate the associated module to 

populate the data in the database. For more information, see Setting Up Companies 

and Modules on page100. 
 

For an explanation of the databases used by Sage 500 ERP, see Databases on page13. 

Note: You can create more than one database set on the same SQL Server. 

For more information, see Chapter 6, Managing and Protecting Databases. 

 

Database Naming Requirements 
 

Introduction 

Note the following information when naming databases. By following these 

requirements, you will make your databases easier to identify and manage. 
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Base names and endings 

A database name includes a base name and an ending. The base name identifies the 

database set and the ending identifies the type of database. 

 

 

The following standard endings are used: 
 

Type of database End name with Default 

Application _app SAGE500_app 
 

 

Naming requirements 

Database names must meet the following requirements: 
 

Requirement Valid Examples Invalid Examples 

No spaces new_company_app 

NewCompany_app 

new 
company_app 

newcompany app 
 

No SQL reserved 
characters and 
wildcards 

 

First character 
alphabetical 

Standard ending 
(_app) 

 

Maximum 30 
characters, 
including ending 

dollarco_app $co_app 

 
 

company1_app 1company_app 

acctg_app  acctg_app_new 

nsbayseafood_app northshelterbay 

seafoodcompany_ 
app 
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Transaction log names 

The file names of transaction logs have the same name as the database with the letter 

L at the end. For example, the transaction log for SAGE500_app is SAGE500_appl. 

 

Default Administrative Logon 
 

Description 

As you create the database set, you are prompted to enter a default admin logon. This 

logon is used the first time you run the software so that you can set up the system, 

grant user access, and perform other administrative tasks. 

You should create a new logon instead of using an existing SQL Server user. The 

default administrative logon for Sage 500 ERP is also a SQL Server administrative 

logon. 
 

The default admin name and password you specify in the Database Creation Utility 

is saved in the Sage 500 ERP database set. Sage 500 ERP maintains its own table of 

user names and passwords. 

 
Default settings 

The Database Creation Utility provides the following default settings: 

• Default Admin name: admin 

• Password: (no password) 

 
Defining a logon 

If you do not want to use these defaults, type a user name and password when 

prompted by the Database Creation Utility. Entering a new logon and password 

automatically creates the administrator in SQL Server. 

Warning: Make a note of the default administrative logon name and 

password. You will not be able to log on for the first time without them. 
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Procedure for Creating Databases 
 

Procedure 

Follow these steps to use the Database Creation Utility: 

1 Log on to the server where you are creating the databases. Use the SQL Server 

password. The Database Options window appears. 

2 Enter a default admin name and create an admin password. 

3 If you want to include demo data, select the Load Demo Data check box. 
 

 

4 Click Proceed. The Database Information window appears. 

5 Type the name of the database followed with _app to indicate that it is an 

application database with system information. (For more information, see Base 

names and endings on page 38.) You can change the database names if needed. 

Tip: To make the databases easier to manage, give all of them the same base 

name. 

 
6 The path and file name fields display the drive and path on the SQL Server for 

the physical database and log files. When you type the database name, the file 

names change to match it. For information about these files, refer to the SQL 

Server documentation. 
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7 Type the sizes for the database and log. For more information, refer to the 

Compatibility and Resource Guide located in the Support page on the Sage 

Customer Portal at: 

https://customers.sagenorthamerica.com 

 

 
8 Click Proceed to start the database creation process. Allow for sufficient time 

for the process to complete. 

9 When the database creation process is finished, you have the option of 

running the Database Maintenance Wizard to set up periodic maintenance for 

the databases. If you do not run the wizard at this time, you can do so later. For 

more information, see Establishing a Maintenance Plan on page 56. 

https://customers.sagenorthamerica.com/
https://customers.sagenorthamerica.com/
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Upgrading Existing Databases 
 

 
Overview 

 
Description 

Follow the procedures in this section if you plan to upgrade existing databases. 

Before proceeding, verify you have installed the Database Utilities, including 

upgrade scripts for the version of Sage 500 ERP currently installed. 

 

Overview of the Upgrade Process 
 

General steps 

Upgrading databases consists of the following general steps: 

1 Post any outstanding batches in your production companies. The upgrade 

cannot proceed with unposted batches. 

2 Back up the following databases, especially if you have customizations: master, 

msdb, model, and Sage 500 ERP database. Also back up triggers and stored 

procedures. 

3 Upgrade to SQL Server 2008 R2 SP3 or later, SQL Server 2012, SQL Server 2014 

or SQL Server 2016. 

Note: If you plan to use the Data Import Manager module to import data 

from source tables into the destination (permanent) tables, you must install 

SQL Server Integration Services (SSIS) before installing the software. 

For more information about system requirements, refer to the Compatibility 

and Resource Guide located in the Support page on the Sage Customer Portal 

at: https://customers.sagenorthamerica.com 

For more information about installing and configuring the Data Import 

Manager module, see Appendix B, Data Import Manager Installation & 

Configuration. 

https://customers.sagenorthamerica.com/
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4 Start the Database Upgrade Utility, the program you use to upgrade the 

databases. 

5 If necessary, compare the databases and generate scripts for the upgrade. For 

more information, see Comparing Databases on page 49. 

6 Perform the upgrade. The system uses the scripts to update tables, stored 

procedures, and triggers and copy the data into the modified databases. 

7 Upgrade and recompile customized stored procedures or triggers after the 

database upgrade process. If you are using third-party products, create or 

upgrade to the version that supports this version of the software. 

 
Time requirements 

The database upgrade process takes considerable time, especially with large 

databases. Schedule the upgrade to have the least impact on your users. 

 

Upgrading Customized Databases 
 

Introduction 

If you have customized databases, the Database Upgrade Utility can generate scripts 

that identify schema changes and update the databases to work with these changes. 

 
Using database comparisons 

To find schema changes, run a comparison of the database to upgrade. You have the 

following options for performing the comparison: 

• Compare your database against the standard databases for a release. 

• Compare two databases. Use this option to identify modifications made 
between two previously created database sets. 
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Generated upgrade scripts 

From the comparison, the Database Upgrade Utility generates database upgrade 

scripts: 

• usc_sys.sql for the application database with system information 

• usc_appl.sql for the application database with enterprise resource planning 
(ERP) information 

 

The scripts created are saved in the ..\Program Files\Sage Software\Sage 500 ERP 

Database Utilities\DBUpgrade folder in a subfolder with the name of the version 

currently used by the database. 
 

To use them for database upgrade, rename the files to sc_app.sql and sc_sys.sql, 

respectively. 
 

You can generate a script when you are comparing databases. You can only compare 

the current version with one version prior. 

 
Effects of upgrades on customized objects 

The Database Upgrade Utility overwrites customizations in native Sage 500 ERP 

objects, including triggers and stored procedures. Tables outside of native Sage 500 

ERP objects are not affected, but objects such as custom triggers appended to native 

Sage 500 ERP objects might be dropped; therefore, back up all customized objects 

before performing the upgrade. Add the customizations, as needed, manually into 

the new triggers and stored procedures installed with the new version. 
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Adding Databases to an Existing Installation 
 

Introduction 

To add a database to an existing database installation, upgrade the existing databases 

to the current version and then add the new databases. This procedure is explained 

in this section. 

 
Procedure 

Follow these steps: 

1 Upgrade your existing databases by using the Database Upgrade Utility as 

shown in Upgrading Databases on page 52. This upgrades the databases to the 

new version and enables the application database to work with the new 

databases. 

2 Start the installation of the new database by running the Database Creation 

Utility as shown in Creating New Databases on page 36. 

3 Log on to either the SQL Server where your upgraded application database is 

located or into a different SQL Server. 

4 In the window that displays which databases you are creating, select only the 

databases you are adding. 

Warning: Do not use database names that already exist. Creating a new 

database with the same name as an existing one overwrites it. 

 
5 Select the application database to which the new databases are to be attached 

at the Link to App DB field. This field is available only if the Application check 

box is cleared. Click Proceed to continue. 

6 In the Database Information window that appears, type the information for 

each database you are adding. Only the tabs of the databases you are adding 

become enabled. Click Proceed to create the databases. 

7 Activate the modules for the databases you have added to populate the data in 

them and enable them to be used. For instructions, see Setting Up Companies and 

Modules on page 100. 
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Preliminary Steps 
 

Introduction 

Before upgrading the databases, complete the tasks shown in this section. 

 
Database protection 

Because your databases contain crucial information, it is important you perform the 

following before upgrading: 

1 Post all batches in all of your current modules and companies. If you have 

posted Sales Order batches, verify they have been made into open Accounts 

Receivable batches and posted through Accounts Receivable. 

2 Back up the databases and test the backup. Keep the backup copy until you are 

sure the upgraded databases are working properly. For instructions on backing 

up the databases, refer to the documentation for Enterprise Manager, SQL 

Server Management Studio, or the backup utility. 

The Database Upgrade Utility also prompts you to back up the databases before 

proceeding with the upgrade. 

3 Perform a test upgrade on copies of your production databases before you 

perform the actual upgrade. You can test and verify the upgrades before 

performing the upgrade on your production data. 

For instructions on copying databases, see Chapter 6, Managing and Protecting 

Databases. 
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Upgrade databases to SQL Server version 2008 or later 

If you are using Microsoft SQL Server 2005, you must upgrade the Sage 500 ERP 

databases to SQL Server 2008 R2, SQL Server 2012, SQL Server 2014, or SQL Server 

2016. Before upgrading the databases to this version of Sage 500 ERP. For more 

information about system requirements, refer to the Compatibility and Resource Guide 

located in the Support page of the Sage Customer Portal at: https:// 

customers.sagenorthamerica.com 

Follow these steps: 

1 Make backups of your databases. 

2 Upgrade Microsoft SQL Server to version 2008 R2, 2012, 2014, or 2016 as 

shown in the SQL Server Documentation on the Microsoft Web site. 

Perform the following: 

► For best results, use the Direct Pipeline method for upgrading. 

► Be sure to include the application database when you upgrade. 

Note: If you plan to use the Data Import Manager module to import data 

from source tables into the destination (permanent) tables, you should 

perform the items mentioned in this step. For more information, see 

Appendix B, Data Import Manager Installation & Configuration. 

https://customers.sagenorthamerica.com/
https://customers.sagenorthamerica.com/
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Starting the Database Upgrade Utility 
 

Procedure 

If you are prompted to start the program after the Database Utilities have been installed, 
click Yes to continue. You can also start the Database Upgrade Utility by selecting 
Windows Start menu > All Programs > Sage > Sage 500 ERP 2023 > Utilities 
> Database Upgrade Utility. 

Run the Database Upgrade Utility. When prompted, log on to the SQL server 

containing the databases. Use your system administrator password. 
 

The Database Upgrade Utility window appears: 

 

Tip: Use the toolbar for common commands. Place the pointer over a 

button to see a tooltip. 
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Comparing Databases 
 

Introduction 

The comparison feature allows you to generate upgrade scripts by comparing the 

database you are upgrading to a standard database for that release or against another 

database. The comparison shows differences in the schema and does not examine 

customized procedure code. 

 
Determining if you need to do a comparison 

There are some situations when you do not need to run the comparison. Refer to the 

following chart: 
 

Type of database 

upgrade 

Database set has no 
customizations. 

 

To compare the 
database against a 
standard database set 
for this release. 

 
 
 

To compare the 
database against 
another set of 
customized databases. 

 

To modify the 
upgrade scripts. 

 
Comparison needed? 

 
No. Skip to Upgrading Databases on 
page 52. 

 

Optional, because the upgrade can 
generate a script against a standard 
database set as it does the upgrade. 
To review the upgrade script before 
you perform the upgrade, perform 
the comparison as shown in this 
section. 

 

Yes. 

 
 
 

Yes. Use the comparison to generate 
scripts to customize. 

 
 

 

For more information about upgrading customized databases, see Upgrading 

Customized Databases on page 43. 
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Time for performing the comparison 

This comparison process takes a considerable amount of time, depending on the size 

of the databases and amount of customizations. Allow sufficient time for the process 

to complete. 

 
Procedure for running the comparison 

Follow these steps to run the database comparison: 

1 Select Tools menu > Compare Databases. The following window appears. 

 

Complete the window as follows: 

a At the Upgrade From database fields, select the databases to compare. 

b To use the standard database for comparison, select the Compare with Pre- 

processed Database Information check box. The version of the software 

used for that database automatically defaults to the Compare with Version 

field. If the version is not correct, select the correct version. 

Warning: At the Compare with Version field, select the version you 

are currently using, not the version to which you are upgrading. If 

you select the wrong version, the upgrade information will be 
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incorrect, creating errors in the upgraded databases. 

 
c To compare the databases you are upgrading to another database, clear the 

Compare with 

Pre-processed Database Information check box. Select the databases you are 

comparing at the Upgrade To fields. 

d To have the Database Upgrade Utility generate the upgrade scripts, select 

the Generate Database Upgrade Script check box. This check box is 

available only if you are comparing a database with databases or the 

version immediately before it. If the comparison is greater than one 

version, this check box is not available. 

2 Click Proceed. The following changes occur in the Database Upgrade Utility 

window: 

► The left pane shows the objects in the database. 

► The right pane shows any differences identified in a database object. 

► A status bar shows the progress of the comparison process. 

3 Review the changes identified by the database comparison. To get a complete 

report, select Reports menu > Schema Changes. 
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Upgrading Databases 
 

Procedure 

When you are ready to upgrade the databases, follow these steps: 

1 Select Tools menu > Upgrade Existing Databases. The following window 

appears: 

 

 
2 Select the system and application database to upgrade. The Database Version 

field displays the version of the software used for that database. 

3 Indicate how you want to upgrade the databases by performing the following. 

Warning: Follow the instructions in this step carefully. If you choose the 

wrong selections for your type of upgrade, you can lose your data, 

customization, or customized scripts. 

 

Upgrade you are performing What to do 

Database has no 
customizations. 

Verify that the Update To 
Version field displays the 
correct version of the 
software. 

Select the Use Pre-generated 
Sage 500 ERP Database 
Upgrade Script check box. 
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Upgrade you are performing What to do 

Database set has 
customizations, you are not 
comparing against another 
customized database set, and 
you want to generate scripts 
while performing the 
upgrade. 

 
You want to use scripts you 
generated in Comparing 
Databases on page 49. 

Verify that the Update To 
Version field displays the 
correct version of the 
software. 

Clear the Use Pre-generated 
Sage 500 ERP Database 
Upgrade Script check box. 

 

In the ..\Program Files\Sage 
Software\Sage 500 ERP 
Database 
Utilities\DBUpgrade folder, 
look for the folder for the 
version currently used by the 
database. Find the files 
usc_app.sql and usc_sys.sql 
and rename them to 
sc_app.sql and sc_sys.sql, 
respectively. For more 
information, see Upgrading 
Customized Databases on 
page 43. 

Verify that the Update To 
Version field displays the 
correct version of the 
software. 

Select the Use Pre-generated 
Sage 500 ERP Database 
Upgrade Script check box. 
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Upgrade you are performing What to do 

The current databases are 
more than one version prior 
to the version you are 
upgrading to. 

The Use Pre-generated 
Database Upgrade Script 
check box is automatically 
selected and can only be 
viewed. 

To use a script generated by a 
comparison, in the 
..\Program Files\Sage 
Software\Sage 500 ERO 
Database 
Utilities\DBUpgrade folder, 
rename usc_app.sql to 
sc_app.sql and usc_sys.sql to 
sc_sys.sql. For more 
information, see Upgrading 
Customized Databases on 
page 43. 

 
 

 

4 Select the Use Pre-Generated Database Upgrade Script check box. 

Note: Clear this check box if you are upgrading a system that has schema 

modifications that you want to retain. When the check box is cleared, the 

usc_appl.sql customer upgrade script is generated and can be used in the 

upgrade process. 

5 Click Proceed. You are shown the last time the databases were backed up and 

prompted whether to back up the databases, continue with the upgrade 

without performing a backup, or cancel. Respond to the prompt as follows: 

► Click Backup Now to back up the databases before continuing the upgrade. 

The Database Maintenance Wizard appears. (For more information, see 

Establishing a Maintenance Plan on page 56.) To use another backup utility, 

close the Database Maintenance Wizard by clicking Exit and run the 

utility. When you are finished with the backup, go back to the Database 

Upgrade Utility window and continue the upgrade. 

► If you have already backed up the databases, click Continue. The upgrade 

starts. 

► If you do not want to continue the upgrade, click Cancel. 
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6 When the database upgrade is completed, the Database Upgrade Utility 

displays a log of the operations that occurred. 

To save a report of the operations, select Reports menu > Schema Changes. The 

report is saved to the ..\Program Files\Sage Software\Sage 500 ERP Database 

Utilities\DBUpgrade\StrtChng.txt file. To view the report, click Yes when you are 

prompted to open the file. 

7 Review the DBError.log file generated by the upgrade process. This is saved in 

the following folder: C:\\Users\<user ID>\AppData\Roaming\Sage 

Software\Sage MAS 500 

The file contains information about the upgrade and any errors encountered in 

the process. 

8 When the database upgrade process is finished, you have the option of 

running the Database Maintenance Wizard to set up periodic maintenance for 

the databases. If you do not run the wizard at this time, you can do so later. For 

more information, see the next section, Establishing a Maintenance Plan on 

page 56. 

 

Database Auditing Triggers 
 

Introduction 

Triggers are used to keep track of modifications (changes) made to the system. The 

database trigger tracks changes made by non-Sage 500 ERP applications to the database 

tables. The application trigger tracks changes made to the applications for deletions, 

additions, and modifications. These auditing triggers are enabled by default. 

 

Procedure 

To enable or disable the Database Auditing Triggers, perform the following: 

1 Run the SQL Server Management Studio. 

2 In the SQL Server Management Studio window, launch a new query. 

3 Select your Sage 500 ERP database. 

4 To disable triggers, execute the following command: 

spEnableDBAuditTriggers  0 
5 To re-enable triggers, execute the following command: 

spEnableDBAuditTriggers  1 
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Establishing a Maintenance Plan 
 

 
Overview 

 
Introduction 

When the databases have been created or upgraded, you have the option of 

scheduling and performing the following database maintenance tasks: 

• Validation 

• Optimization 

• Backup 
 

Use the Database Maintenance Wizard to set up and schedule these tasks. All 

database objects are maintained. 

 

Starting the Database Maintenance Wizard 
 

When you are prompted to start the wizard 

You have the option of starting the Database Maintenance Wizard in the following 

situations: 

• On completion of the Database Creation Utility or Database Upgrade Utility. 

• Before starting a database upgrade so that you can use the wizard to back up 

the databases before continuing. 

You can also start the wizard at any time by using the procedure shown in this 

section. 
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Starting the wizard 

To start the Database Maintenance Wizard, perform the following: 

1 Select Windows Start menu > Run. 

2 Click Browse to locate CreateDB.exe. The .exe file is located at C:\Program 

Files\Sage Software\Sage 500 ERP Database Utilities\DBInstall. Select the file 

and click Open. 

3 In the Run window, the Open field displays the file name and path for 

CreateDB.exe. Add /M to the end of the line as shown, and click OK: 

"C:\Program Files\Sage Software\Sage 500 ERP Database 

Utilities\DBInstall\CreateDB.exe" /M 

4 The Sage 500 ERP Database Install Login window appears. Type the password 

and click Proceed. 

 
 

Setting Up Database Maintenance 
 

Fields to complete 

Complete the Database Maintenance Wizard as follows: 

• Application: Select the database for which to schedule maintenance tasks. 

• Data Validation: Select this check box to have the system run consistency 
tests on the databases. The system runs DBCC CHECKDB to report on data and 
index page consistency, and DBCC CHECKCATALOG to report on the 
consistency of the system tables. 

• Data Optimization: Select this check box to optimize table indexes for 
improved performance. The system rebuilds the table indexes using the free 
space percent value as the inverse of the index fill factor. This option also 
updates the index statistics used in the compilation of stored procedures. 



Database Creation and Upgrade 

Installation and System Configuration 58 

 

 

 

 
• Backup Options: Select the Perform Scheduled Backups To check box to 

perform periodic backups. Select the drive and path to store the backup files 
and whether to delete backup files older than the selected number of weeks. 

Note: Do not select a folder on the same drive as your database. The server 

must always have access to the folder selected. The file names of the backup 

files are created at run time as the database name with a current date 

(YYYYMMDD) extension. 

 
• Plan Frequency: Select the task to be performed daily, weekly, or monthly. 

Select the start time at the At Time field. For weekly tasks, select the day of the 
week at the On Day field. 

Tip: If you have a large number of transactions, select the task to be 

performed daily. Schedule the tasks at off hours. 

 
• Generate Report To: Enter the path to which the results of the maintenance 

activities will be created. A valid path is required at this field. 

• E-Mail To: Select an established SQL Server Operator to whom completion 
messages will be sent. For more information on how to create SQL Server 
Operators, see the Microsoft SQL Server Online Help topic, Creating an Operator. 

 
Starting the backup 

To back up the databases immediately, click Backup Now. The system backs up the 

selected databases using the settings you selected. 

 
Accepting the changes 

When you have completed the desired maintenance plan, click Create Plan. You can 

create a maintenance plan for another database or click Exit. 

Note: The Create Plan button is not available when you launch the Database 

Maintenance Wizard prior to backing up the databases. At that point of the 

upgrade process, the wizard is provided only for backing up the databases. 

You have the option of running the Database Maintenance Wizard to set up 

a maintenance plan after the database upgrade is complete. 
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Running and Viewing Scheduled Tasks 
 

Introduction 

When you click Apply to save a maintenance plan, it is added to the schedule tasks 

for the SQL Server Agent. You can view and change the maintenance plan jobs in 

Enterprise Manager or SQL Server Management Studio. 

The SQL Server Agent also processes automatic registration and data update tasks for 

the Business Insights Dashboard. 

 
Viewing maintenance plans 

To view the maintenance plan in Enterprise Manager or SQL Server Management 

Studio, follow these steps: 

1 In the Tree pane, expand the listing for the SQL Server. Expand the 

Management folder, and then the listing for SQL Server Agent. 

2 Click Jobs. The jobs appear in the right pane, as shown in the following figure: 
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3 Locate the maintenance plan generated by the Database Update Wizard. Scroll 

across the right pane to get an overview of the status of the maintenance plan. 

To get more details about the plan or change settings, right-click it, and from the 

menu that appears, select Properties. The following window appears: 

 

 
Changing a maintenance plan 

Use the maintenance plan Properties window to change settings such as the 

following: 

• Servers where the job is run 

• SQL commands used in the job 

• Schedule for processing jobs 

• E-mail notifications when a job fails or finishes 
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Troubleshooting maintenance plans 

You can use the maintenance plan Properties window to correct problems or 

improve performance in processing. 
 

For example, if it takes too long to process a job, it might be caused by redundant 

options in the SQL command. If the command contains both -UpdSts and -RebldIdx, 

remove either of these options to improve performance. For information about these 

options, refer to SQL Server Books Online. 

Follow these steps to fix this and other errors in the SQL commands for a job. 

1 In the maintenance plan Properties window, click Steps. 

2 Select the step to change and click Edit. The following window appears. 

 

3 Verify that Operating System Command (CmdExec) is selected at the Type 

field. 

4 Type the changes in the Command box. 

5 Click the Advanced tab to set options for completed or failed jobs and select 

whether to generate an output file. Click OK. 
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Running maintenance plans 

The SQL Server Agent must be running in order for the maintenance plan jobs to be 

run. If the agent is not running, perform the following in Enterprise Manager or SQL 

Server Management Studio to start it: 

1 In the Tree pane, expand the listing for the SQL Server, and then the 

Management folder. SQL Server Agent appears below the Management folder as 

shown: 

 
 

 
2 Right-click SQL Server Agent. From the menu that appears, select Start. 

 
For more information about using SQL Server Agent, see SQL Server Books Online. 
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Client Installation 4 
 
 
 

This chapter guides you through the process of installing, removing, reinstalling, 

and upgrading the client software. 

In this chapter 

Preliminary Steps ................................................................................................... 64 

Installing the Client Software ....................................................................... 67 

Terminal Services Installation ......................................................................... 74 

Completion of Client Installation .............................................................. 79 

Installing Crystal Reports Designer ........................................................... 85 
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Preliminary Steps 

 

 
Overview 

 
Introduction 

This section describes the steps you need to perform before installing the client 

software, especially if you are upgrading from a previous version of the software. 

Also note the use of Windows Installer with the client installation. 

 

Options for Installing Client Software 
 

Description 

You have the following options for installing and running client software: 

• Install the software directly on each client system by running the installation 
wizard or by using the silent installation feature to install the software with the 
parameters you specify. 

• Use Terminal Services to run the software on a dedicated Terminal Services 
system and connect to it from other machines, instead of installing the 
software on each system. For information on Terminal Services requirements, 
refer to the Compatibility and Resource Guide located in the Support page on the 
Sage Customer Portal at: https://customers.sagenorthamerica.com 

 
Overview of procedures 

Perform the preliminary steps and then use the procedure that applies to your 

installation. For information on reinstalling components, changing an installation, 

or uninstalling the client software, see Changing the Installation on page 70. 

https://customers.sagenorthamerica.com/
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Preliminary Steps for Upgrades 
 

Introduction 

If you are upgrading the client software, you need to uninstall the previous version 

of the software and the version of Crystal Reports that came with it before you install 

this version of the software. 

 
Software that is uninstalled 

If you have the client software, the installation wizard detects it and gives you the 

option to remove it before installing the new software. This removes the application 

and any service packs, monthly updates, and hot fixes. It does not remove user files, 

form customizations, and any components added to the client. The wizard starts the 

installation process. 
 

When you remove the software, it also removes the runtime version of Crystal 

Reports if it is not used by other programs. If you have Crystal Reports Designer, or if  

Crystal Reports is used by another program, you need to uninstall it manually before 

installing the new version of the software. 

 
Preserving customizations 

If you have customizations to apply to the version of the software you are about to 

install, save the files used to create the customizations in a separate folder before 

continuing. 

 

Prerequisite Steps for Clients on SQL Server 
 

Description 

Before installing, reinstalling, or upgrading the client on a workstation or server 

running SQL Server, shut down all SQL Server services, including SQL Server, SQL 

Executive, and DTC. 
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Use of Windows Installer 
 

Description 

All installation programs use Microsoft Windows Installer. If you already have 

Windows Installer, Sage 500 ERP uses the version that is already on your system. 
 

If you do not have Windows Installer on a system, it is installed automatically when 

you run the Setup program. 

 

Pre-installation Checklist for Client Installation 
 

Introduction 

Before you begin installing the client software, verify you have the following 

information. Complete the following checklist: 

 
Information 

Where to   On each client workstation. Continue 
install the 
client 
software 

following the instructions in this section. 

 Remotely through Terminal Services. For 
instructions, see Terminal Services 
Installation on page 74. 

 

SQL Server   
 

Type of   Installation of new client workstation 
client 

installation 

software 

 Upgrading existing client workstation 
software 

 

User of the   All users of the system 
software 

 
Applications 
to install 

 Only the user who installs the software 

All applications are installed. 
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Installing the Client Software 
 

 
Overview 

 
Introduction 

Follow the procedures in this section if you are installing the client software directly 

from the Sage 500 ERP website to the local drive. 

 

Installing Client Software 
 

Procedure 

This section describes how to install the software by using the Client Installation 

Wizard. To use the silent installation feature, see Appendix E, Silent Installation. 

1 Verify you have logged on to the client system as the local Administrator. If 

not, log off the system and log back on as the local Administrator. 

2 Start the client installation by performing the following: 

a From the installation window, click Client Install. For information about 

starting the installation, see Starting the Installation on page 7. 

3 You are prompted to install the .NET Framework if it is not already installed. 

Click OK to continue. You need .NET Framework to run the Sage 500 ERP 

client software. 

Note: For information on supported .NET Framework version, refer to the 

Compatibility and Resource Guide located in the Support page on the Sage 

Customer Portal at: https://customers.sagenorthamerica.com 

 
4 The Client Setup wizard appears. Click Next to continue. 

5 Review the license agreement that appears. Select I accept the terms in this 

license agreement, and then click Next to continue. 

https://customers.sagenorthamerica.com/
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6 When you are prompted to enter your information, the fields display the name 

and organization as recorded in the Windows Registry. You can change this 

information, if necessary. 

Depending on your configuration, select one of the following options: 

► If you are installing on a dedicated client system, you have the option of 

selecting whether the software is available to all users or just yourself. 

► If you are installing on a Terminal Server, you must select All Users. 

Click Next to continue. 

7 If you are performing a new installation, you are prompted to type the name of 

the SQL Server you will be using with the client software. Type the name of the 

server and click Next. 

You are not prompted to type the name of a SQL Server if you are upgrading an 

existing installation. The new client software uses the SQL Server you previously 

used. 

8 The following options are available for setting up: 

► Select Complete to install all client components into a default folder on 

drive C. 

► Select Custom to select the drive and folder where files will be installed. 

Select the option and click Next. 

If you selected Custom, go to the next step. If you selected Complete, skip to step 

10. 
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9 If you selected Custom, the Custom Setup window appears. 

► Click Change to change the drive and path where the files will be installed. 

► Click Disk Usage to see how much space is available on your drives and how 

much space will be used by the database installation software. Note that some 

files will be installed on drive C. 

Note: All modules are installed except Sage Budgeting and Planning Client 

and Sage Advanced Allocations Client. You need to select these two clients 

if you want to install them. The Custom Setup window lists the modules, 

but none of them can be deselected from the installation. 

 
Click Next to continue. 

10 If you select to install the Sage Budgeting and Planning Client and/or the Sage 

Advanced Allocations Client, a Network Location window appears. This 

windows allows you to specify the network location where the application 

installs are located. 

► Click Browse to change the location for network location for the 

application. 

Click Next to continue. 

11 Click Install to start the installation. A status bar indicates the progress. To 

cancel the installation, click Cancel. 

12 You might need to reboot your computer to complete the installation. When 

prompted, click Yes to reboot. 

 
Installing CAD viewer software 

To view CAD drawings in Manufacturing, install the optional Dr. DWG ActiveView 

Pro software. The Sage 500 ERP website has a limited-use demo of the software with 

information on ordering the full product. The demo version expires 30 days after the 

installation. 

You can install the demo software before or after installing the Manufacturing 

client. Follow these steps: 

1 From the Windows Explorer, on the Sage 500 ERP installation, open the 

Support folder, and then the CADViewer folder. 
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2 Run ViewProfessional5.0Rest.exe. 

3 In the dialog box that appears, click Setup. Follow the instructions on the 

screen to complete the installation. 
 

To purchase the full version of the software, use the order form installed with the 

demo software. Select Windows Start menu > All Programs > Dr. DWG ActiveView 

Prof > Dr. DWG-ActiveView Order Form. 

 

Changing the Installation 
 

Introduction 

You can remove the software, change the configuration, or reinstall components by 

running the installation program. When you run an installation on a system that 

already has the current version of Sage 500 ERP software, the program detects the 

software and presents an appropriate set of options. 

 
Procedure 

Follow these steps to run the client installation to make changes: 

1 Start the installation by performing one of the following: 

► From the installation window, click the link for the software installation. 

For information about starting installation, see Starting the Installation on 

page 7. 

► Select Windows Start menu > Settings > Control Panel. In the Control 

Panel window, double-click Add/Remove Programs. In the Add/Remove 

Programs window, select the Sage 500 ERP software, and click Add/Remove. 

When the installation software starts, click Next to continue. 
 

2 The Program Maintenance window appears. 

Select one of the following options: 

► To review settings, click Modify. Click Next to continue. 



Client Installation 

Installation and System Configuration 71 

 

 

 

 
► If you experienced problems with the software or need to repair a 

corrupted installation, select Repair. This reinstalls any missing or damaged 

files. Click Next to continue. 

► To uninstall the software from the system, select Remove. Click Next to 

continue. 

Note: Selecting Remove in this window does not uninstall service packs, 

monthly updates, and hot fixes you added to the current version of the 

software. If you are running the installation program to update an older 

version, clicking the Remove button does remove those items. 

3 A window appears where you can confirm your action. Click Install (for Modify 

or Repair) or Remove to proceed. 
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Enabling .Net framework 3.5 on Windows and 
Windows Server 

 
Introduction 

Microsoft .Net Framework 3.5 is required for the Sage 500 ERP client application. 

.Net Framework 3.5 can be enabled, but not installed, on Windows version 8 and 8.1 

and Windows Server version 2008 R2, 2012, and 2012 R2. 

 
Enabling .Net framework 3.5 in Control Panel 

You can enable the .NET Framework 3.5 through the Microsoft Control Panel. In 

Control Panel: 

1 Choose Programs and Features. 

2 Choose Turn Windows features on or off. 

3 Select the Microsoft .NET Framework 3.5.1 check box. 

Note: This option requires an Internet connection. 
 

4 Click OK. 
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Enabling.NET Framework 3.5 using the installation media 

When enabling the .NET Framework 3.5 in the Control Panel, you may get error 

message 0x800f0906: “Windows couldn't connect to the Internet to download 

necessary files. Make sure that you're connected to the Internet, and click Retry to try 

again.” This message may appear for the following reasons: 

 
• Your computer is not connected to the Internet. Please connect, and then retry 

the operation. 
If you are unable to connect your computer to the Internet, you can enable the 
.NET Framework 3.5 by using the installation media (ISO image or DVD) from 
which you installed the Windows. Mount the installation media and type the 
following command from a command prompt: 

 
Dism /online /enable-feature /featurename:NetFx3 /All /Source:x:\sources\sxs /LimitAccess 

 
Where x: is the drive letter for the ISO image or DVD. 

• If your administrator has configured your computer to use Windows Server 
Update Services (WSUS) instead of Windows Update for servicing, ask your 
administrator to enable the policy to use Windows Update instead of WSUS. 

 
Enabling ..NET Framework 3.5 on Windows Server through Add 
Roles and Features Wizard 

To enable the framework on Windows Server version 2012, 2012 R2, or 2016 using 

the Add Roles and Features Wizard: 

1 Open Add Roles and Features Wizard. 

2 Select .NET Framework 3.5 Features and click Next. 

3 Select specify an alternate source path link in the Confirm installation 

selections screen. 

Path: D:\Sources\SxS (where D drive is installation media) and then click OK. 

4 Click the Install button. 
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Terminal Services Installation 
 

 
Overview 

 
Introduction 

If you are using Sage 500 ERP with Terminal Services, verify the system 

requirements. For system requirements, refer to the Compatibility and Resource Guide 

located in the Support page on the Sage Customer Portal at: 

https://customers.sagenorthamerica.com 

After verifying the requirements, you can install the software for multiuser access by 

performing one of the following: 

• Use Add/Remove Programs in Control Panel. 

• Use the change user command at the command prompt before and after 

installing the software. 

 

Precautions on Using Terminal Services 
 

Description 

Any changes you make to the software affect all users on Terminal Services, 

especially the following: 

• If you select Windows authentication, it applies to all other users who connect 
after this setting is saved. 

• Selecting new values for any of the fields or options in the Client 
Configuration Utility in a terminal server session affects all users connecting to 
the software through that Terminal Services. 

https://customers.sagenorthamerica.com/
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Using Add/Remove Programs 
 

Procedure 

Follow these steps: 

1 Log on to Terminal Services as the local Administrator. 

2 Close all other applications. 

3 Select Windows Start menu > Settings > Control Panel. Double click Add/ 

Remove Programs. 

4 On the Install/Uninstall tab, click Install. You are prompted to specify the 

installation program. Click Browse to locate the client installation, and then 

click Next. 

5 In the Change User Option dialog box, select All users begin with common 

application settings, and then click Next. 

6 Install the software on a local NTFS-formatted drive. 

7 In the Finish Admin Install dialog box, click Finish. 

 
Connecting to the Terminal Services section 

You are now ready to connect to the software. Review the Terminal Services 

documentation for information on connecting to, disconnecting from, and logging 

off of a Terminal Services session. 

If you establish a new session under the same Windows user account, and an old 

session is still open and running, attempting to run the software on the newly 

established session will fail. 
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Using the Change User Function 
 

Procedure 

Follow these steps: 

1 Log on to Terminal Services as the local Administrator. 

2 Close all other applications. 

3 Select Windows Start menu > All Programs > Accessories > Command Prompt. 

4 At the Command Prompt, type the following: 

change user/install 

To see whether execute mode is enabled and .ini file mapping is on, use this 

command: 

change user/query 

5 Install the software on a local uncompressed NTFS-formatted drive. 
 

6 When the installation is complete, type the following command: 

change user/execute 

 
Connecting to the Terminal Services section 

You are now ready to connect to the software. Review the Terminal Services 

documentation for information on connecting to, disconnecting from, and logging 

off of a Terminal Services session. 
 

If you establish a new session under the same Windows user account, and an old 

session is still open and running, attempting to run the software on the newly 

established session will fail. 
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Configure Windows Server 2008 Terminal 
Services RemoteApp using TS Web Access 

 
Description 

Windows Server 2008 includes Terminal Services RemoteApp (TS RemoteApp). Sage 

500 ERP can be deployed using TS RemoteApp programs, such as Terminal Services 

Web Access (TS Web Access). You can use TS Web Access to provide access to 

RemoteApp programs through a Web page on the Internet or over an intranet. 
 

Install the Terminal Services role before installing any application that is available to 

terminal server users. If a Terminal Service role is installed after any applications are 

installed, the application may not function correctly in a multi-user environment. 

 
Procedure 

To install the Terminal Service role service. 

1 Select Windows Start menu > Administrative Tools > Server Manager. 

2 Under Roles Summary, click Add Roles. 

3 On the Before you Begin page of the Add Roles Wizard, click Next. 

4 On the Select Server Roles page, select the Terminal Services and TS Web Access 

check box, and then click Next. 

5 On the Terminal Services page, click Next. 

6 On the Select Role Services page, select the Terminal Server check box, and 

then click Next. 

7 On the Uninstall and Reinstall Applications for Compatibility page, review the 

information, and then click Next. 

8 On the Specify Authentication Method for Terminal Server page, select the 

desired authentication method, and then click Next. 

9 On the Specify Licensing Mode page, select the licensing mode that applies to 

your Terminal Services environment, and then click Next. 
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10 On the Select User Groups Allowed Access to this Terminal Server page, add 

any users or groups that you want to add to the Remote Desktop Users group, 

and then click Next. 

11 On the Confirm Installation Selections page, verify that the Terminal Server 

role service will be installed, and then click Install. 

 
Install Sage 500 ERP on the terminal server 

Install the software on the terminal server after you have installed the Terminal 

Server role service. To ensure that an application is installed correctly to work in a 

multi-user environment, the Terminal Server must be switched into Install mode 

before the software is installed on the server. 

A Terminal Server can placed into Install mode using one of the following methods. 

 
• Use the Install Application on Terminal Server option in the Control Panel to 

install the software. 

• Before you install a program, run the change user /install command. After the 
software is installed, run the change user/execute command to exit from Install 
mode. For more information, see Using the Change User Function on page 76. 
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Completion of Client Installation 
 

 
Overview 

 
Introduction 

When the client installation is completed, shortcuts are added to your Start menu 

and additional software and Registry settings are created to support the client 

software. These are described in this section. 

 
File locations 

The installation copies all components of Sage 500 ERP, including programs, Help, 

and reports, to the Client folder. Within the folder, there are subfolders for each 

module. 

 

Sage 500 ERP Shortcuts 
 

Start menu 

The following shortcuts are created in the Sage 500 ERP program group on the 

Windows Start menu under Programs: 

• Sage 500 ERP Desktop: Starts the client software. 

• Utilities: A program group containing shortcuts to the following: 

► Client Configuration Utility: Enables you to specify the database used for 

logging on and other logon options. 

► System Inspector: Shows the files and Registry settings associated with the 

client software. Use this utility for troubleshooting. 

• Sage 500 ERP Sage Budgeting and Planning: Starts the Sage 500 ERP Sage 
Budgeting and Planning software. 
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• Sage 500 ERP Sage Budgeting and Planning Admin Tool: Starts the Sage 500 

ERP Sage Budgeting and Planning Admin Tool software. 

• Sage 500 ERP Allocations: Starts the Sage 500 ERP Allocations software. 

• Sage 500 ERP Allocations Admin Tool: Starts the Sage 500 ERP Allocations 
Admin Tool software. 

 

If you already have a Sage 500 ERP Utilities program group from installing the 

Database Utilities, the shortcuts for the Client Configuration Utility and System 

Inspector are added to it. 

 

ODBC, Registry, and OLE DB Additions 
 

Description 

The client installation automatically adds and configures ODBC components, as 

follows: 

• Adds two 32-bit ODBC and SQL Server communications components. 

• Adds the User Data Source Name (DSN), MAS 500, to ODBC. The MAS 500 DSN 
contains vital information used in accessing the SQL Server where the Sage 500 
ERP databases have been created. 

 
Database Connection Registry Settings 

Do not modify database connection settings manually. Instead, use the Client 

Configuration Utility. For more information, see Viewing System Settings on page 144. 
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Installing the Sage Advisor Update 
 

Overview 
 

Introduction 

The Sage Advisor Update tool enables you to keep your Sage products up to date with 

the latest releases and updates. Sage Advisor Update recognizes the Sage products 

you have locally installed and lists the updates available for those products. If you 

have a current Sage Business Care Plan for a product, you can download and install 

the updates available. 

 
Before You Begin 

It is recommended that Sage Advisor Update be installed on an administrator's 

machine so that Product Update release can be properly managed. The updates can 

be downloaded by the administrator when available and distributed to client 

machines once the server update is completed. The client and server for Sage 500 ERP 

must have compatible versions. 

 

Installing the Sage Advisor Update 
 

Procedure 

Download the Advisor Update Utility from the Customer/Partner Portal using the 

following steps: 

1 Log in to the Sage Partner/Customer Portal and enter your user name and 

password. 

2 Click the Sage 500 ERP Version 2023 link to download the Advisor Update. 

3 After the download is complete go to the folder where the install was 

downloaded. 

4 Run the install by clicking Sage500ERPAdvisorUpdate.exe file. 
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Using Sage Advisory Update 

After the installation is complete, Sage Advisor Update automatically starts and is 

accessible through a system tray icon. The system tray icon may not be visible in the 

main area of your system tray, but can be configured by modifying your Customized 

Notification Settings. 
 

When the Sage Advisor Update attempts to query for new updates you are prompted 

to log into the Sage 500 ERP system using your Sage 500 ERP credentials. 

 

 

Note: If you have stopped the System Tray Icon instance of Sage Advisor 

Update you can start the Sage Advisor Update by running it from the Start-> 

Program menu. You are then prompted for then login credentials for the 

Sage 500 ERP system. 
 

The available downloads for the current version of your Sage 500 ERP System 

display, based on the information provided during the Login Process. To change the 

database/Registration information being used, you need to exit Sage Advisor Update 

and start it again to log into the desired system. 
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Installing the updates 

1 When updates are available they are listed in the screen shown below: 
 

 
2 Click the check box for the item(s) you would like to download. Then click the 

Download Only button. 
 

 
3 When the download is complete a message displays showing where the 

downloaded file(s) are located. 
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4 Go to the location where the files were downloaded. 

► You will see two files in this location. One file is a compressed version of 

the file which is used for transmission and the other file is the extracted 

version of the compressed transmission file. 

► In the example below there were two files downloaded but you see four 

files in the folder. Two of the files are the compressed files and two are the 

extracted files. 
 

5 Select the .exe file you need to install and apply your updates where 

appropriate (client or server). 
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Installing Crystal Reports Designer 
 

 
Overview 

 
Introduction 

During installation of the client, the Crystal Reports runtime engine is also installed. 

This provides you with the ability to print and preview reports in the software. 
 

To modify or create reports, install the Crystal Reports Designer. This component 

accompanies your software, but you must install it separately. It is included with a 

local installation license. Contact Business Objects to purchase a network license. 

 

Prerequisites 
 

Description 

Before you install the software, do the following: 

• Uninstall previous versions of Crystal Reports and Crystal Reports Designer. 

• Shut down all running software. 

• Have a default print device. 
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Installing Crystal Reports Designer 
 

Procedure 

You are now ready to install Crystal Reports. 

1 Start the Crystal Reports installation from the Sage 500 ERP folder. The 

installation software checks for any earlier versions of the software and 

prompts you to remove them before installing the software. 

2 Complete the windows in the Installation wizard as prompted. 
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Registration and 
 
Security 

 
 

The final steps in completing the installation are to register the software and grant 

access rights to users. These functions are part of System Manager, and this chapter 

provides instructions for using System Manager to perform these tasks. 

In this chapter 

Starting Sage 500 ERP as an Administrator ............................................. 88 

Registering the Software .................................................................................... 91 

Setting Up Companies and Modules ..................................................... 100 

Setting Up Users .................................................................................................. 106 

5 
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Starting Sage 500 ERP as an 
Administrator 

 

 
Overview 

 
Introduction 

To register the software and assign access rights to users, log on to the software using 

the admin logon you defined when you created the databases. As administrator, you 

can set up appropriate security for users on the SQL Server where the databases are 

located, including users configured for Windows authentication. 
 

This section explains the logons available for administrators. For information about 

logging on to the software, refer to the Getting Started guide. 

 

Default Logon 
 

Default admin logon 

Use the default admin logon the first time you log on to the software. The admin 

logon allows you to grant users access rights and perform other administrative tasks. 
 

Use the logon name and password entered in the Database Creation Utility. For an 

upgraded database set, use an admin logon that was created for the database or the 

default of admin and no password. For more information, see Default Administrative 

Logon on page 39. 

Before modifying passwords and permissions for the admin logon or any other users, 

see Setting Up Users on page 106. 
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Logging on as an Administrator 
 

Description 

To start Sage 500 ERP, select Windows Start menu > Sage 500 ERP Desktop. The Sage 

500 ERP Login window appears. 
 

 

First-time logon 

For your first-time logon as admin, complete the window as follows: 

1 Clear the Use Windows Authentication check box. 

2 Log on with the admin user name and password. For an explanation of which 

user name and password to use, see Default Logon on page 88. 

3 Select the Advanced Options check box. If this check box is selected, the logon 

window expands and displays the fields for selecting the server and database. 

4 Verify the server and database fields display the server and system and 

application databases to use. If not, select the Change Server/Database check 

box, and select the server and databases to use. If you do not see the servers or 

databases you want, click Refresh to list the SQL servers in the domain and the 

databases in the selected SQL server. 

5 Select the company to use at the Company field. 
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6 Select the Save Setting As Default check box to log on to the same server and 

database each time you start the software. 
 

When you are finished, click OK to log on. The Desktop opens. For information on 

using the Desktop, refer to the Getting Started guide. 

 
Admin logon with Windows authentication 

If you are logging on with Windows authentication and the admin logon uses SQL 

Server authentication (which is the case if you use the default logon), use the Client 

Configuration Utility to change to SQL Server authentication and log on as admin. 

For information about using the Client Configuration Utility, refer to the Getting 

Started guide. 
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Registering the Software 
 

 
Overview 

 
Description 

After you install the software, register it as shown in this section. For an overview of 

the registration process, see Registration Process on page 20. 

If your software is already registered, you must reregister it if you perform any of the 

following: 

• Rename the SQL server 

• Rename the Sage 500 ERP database 

• Change the network card on the SQL server 

• Move the Sage 500 ERP database to another server 

 

Prerequisite Steps 
 

Procedure 

Before registering the software, do the following: 

• Have all users log off. 

• Get the packing list that accompanied your Sage 500 ERP package. The packing 
list contains your customer number, System Manager serial number, and 
unlocking key. 

• To use automatic registration, verify that the SQL Server Agent is running and 
ready to run a scheduled event, and that you have a continuously working 
Internet connection. 
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Serial number and unlocking keys 

The serial numbers and unlocking keys contain alphanumeric characters, which can 

be entered in upper or lower case letters. Unlocking keys are unique to each system 

and cannot be used for other installations. 
 

If you have questions about the unlocking keys, contact the Sage 500 ERP Product 

Registration Department at 

(800) 944-5487. 

 
 

Registration Procedure 
 

Starting the registration 

Follow these steps to register the software: 

1 Log on to the software. For more information, see Starting Sage 500 ERP as an 

Administrator on page 88. 
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Finish and Exit button 

Cancel and Exit button 

 

 
2 In the Tasks pane, select System Manager Maintenance menu > Maintain Site. 

The Maintain Site window appears. 

 

3 At the License Type field, select whether you are installing a Demonstration, 

Developer, Test, or Production system. 

4 Enter the Company Name and Contact Name fields. 

5 Complete the Registration tab with the information from the packing list: 

a Type the customer number as it appears on the packing list at the 

Customer Number field. 

b Type the System Manager serial number in capital letters as it appears on 

the packing list at the Serial Number field. This field is available only if 

Production is selected at the License Type field. 

c Type the System Manager unlocking key as it appears on the packing list at 

the Unlocking Key field. 

Important: If you are upgrading from a previous version, use the customer 

number, System Manager serial number, and System Manager unlocking 
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key from that version. If the customer number has ten digits, enter the first 

nine digits. 

 
6 Click Save to save the customer number, System Manager serial number (if 

entered), and System Manager unlocking key. 

7 Select whether you are performing an automatic or manual registration. For an 

explanation of these options, see Registration Process on page 20. Depending on 

which method you use, see Automatic registration or Manual registration to 

continue the procedure. 

 
Automatic registration 

Before performing automatic registration, do the following: 

1 Have all other users log off. 

2 Verify that you have a working Internet connection either at the server or the 

client where you are performing the registration. 

Then, follow these steps: 

1 Click Automatic Internet Registration. The system processes the registration 

and enables automatic updates on a periodic basis. 

2 Go to Verifying and completing the registration on page 96 for instructions on 

completing the installation. 

 
Manual registration 

Before performing manual registration, verify that you have a working Internet 

connection. Then, follow these steps: 

1 Click Manual Registration. 

2 Highlight all of the text in the Registration Request Message box in the 

Maintain Site window by placing the cursor in the Registration Request 

Message box and pressing CTRL+A. After the text is selected, press CTRL+C to 

copy the text to the clipboard. 
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3 In a Web browser, go to this address: 

http://registration.sagesoftware.com/registration 

The following page appears: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4 Paste the registration request message at the Registration Request Message 

field. Place the cursor in the text box next to the Registration Request Message 

and press CTRL+V. 

5 Click Submit. A registration message appears in the bottom box. 

6 Highlight all of the text at the Registration Message field (CTRL+A) in the Web 

browser and copy it (CTRL+C) to the clipboard. Close the Web browser. 

7 Return to the Maintain Site window and paste (CTRL+V) the text at the 

Registration Message field. 

8 Click Save in the Maintain Site window to record the message. 

9 Go to the next section, Verifying and completing the registration, for instructions 

on completing the installation. 

http://registration.sagesoftware.com/registration
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Verifying and completing the registration 

After you complete the automatic or manual registration, follow these steps to verify 

and complete it. 

1 Click the Registration Log tab. The tab shows registration requests and any 

errors that occurred. 

 

 

Read the log as follows: 
 

► If a request was successful, the Error Message column is blank. Scroll to the 

right to view more information about the registration. 

► If an error occurred, a description of it appears to the right of the date and 

time in the Error Message column. 

Note: The log can be printed or exported to Excel. Right-click the log and 

select Print or Export from the menu that appears. 

 
To purge the log of errors, enter the date at the Purge Errors Prior To field and click 

Purge Errors. Errors logged before the date entered are purged. 

2 Run the Site Profile listing to view the license information and list of registered 

modules. Click the Print button in the toolbar to generate the report. Confirm 

that the license information in your system is correct. For more information 
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about this report, see Site Profile List on page 170. 

Note: You can also view license information by clicking the License tab. 

 

 
If the settings do not match your license, contact Sage for assistance. 

3 When you are finished, click Finish and Exit to close the window. 

4 Close and reopen the software. The settings defined in the license take effect. 

 
 

Registration Renewals 
 

Introduction 

You are prompted to renew registration when your maintenance and support 

agreement is about to expire. Register again whether or not you plan to continue 

with the maintenance and support agreement as follows: 

• If you are continuing with the maintenance and support agreement, renewing 
your registration enables you to continue to install patches and updates 
according to your license agreement. 
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• If you are not continuing with the maintenance and support agreement, renew 

your registration so that you can continue using the software. The new 
registration does not enable you to install patches and updates. 

 
Grace period after registration expires 

If you do not renew the registration before it ends, the system enters a 45-day grace 

period. During this grace period, you have access to the same modules with the same 

number of users as you did when the software was registered. 

 
Procedure 

To renew your registration, repeat the registration procedure with the following 

exceptions: 

• Do not change the customer number, System Manager serial number, and 
System Manager unlocking key. The registration system uses the same 
information for renewals. 

• If you are using automatic registration, the registration renewal is sent 
automatically when required. 

• If you are using manual registration, you have the following options: 

► To renew registration automatically, click Automatic Internet Registration. 

The registration will continue to be renewed at regular intervals. 
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► If you still cannot use automatic registration, renew the registration 

manually. Click Manual Registration to generate a new registration request 

message. Repeat the procedure for manual registration as shown in Manual 

registration on page 94. 

 
Troubleshooting Automatic Registration 

 
Description 

If you have difficulties with automatic registration, perform the following: 

1 Verify that SQL Server Agent is running. If you need to start it, use an 

administrative logon. For information, see Running and Viewing Scheduled Tasks 

on page 59. 

2 Set the automatic registration schedule to the desired interval. 

3 Run automatic registration from a client workstation with an Internet 

connection instead of a server. 

4 Verify that you have a working Internet connection either at the server or the 

client where you are performing the registration. 

5 Check for recently installed operating system patches. A patch may interfere 

with registration data. If you have any problems, contact Sage Customer 

Support. 

6 Verify that the license components are installed correctly in the Windows 

system folder. 

► For 32-bit Windows, LicRegClient.dll and LicRegServer.dll are installed in 

the C:\Program Files\Common\Sage Software\Sage 500 ERP\Shared folder 

for both the client and the server. 

► For 64-bit Windows, LicRegClient.dll is installed in the C:\Program 

Files\Common Files\Sage Software\Sage 500 ERP\Shared folder for the 

client, and LicRegServerX64.dll is installed in the System32 folder for the 

server. 

7 Use manual registration if automatic registration fails or if you have a firewall 

that prevents registration through the Internet. 
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Setting Up Companies and Modules 
 

 
Overview 

 
Introduction 

The next task is to create the companies that you will use in the system and activate 

the modules to be used with each company. 

 
Multiple companies 

You can create more than one company in a set of system and application databases. 

All of the companies are linked together so that they can be consolidated or used for 

intercompany transactions. The number of companies you can create in a database 

set is determined by the license you purchased. 

 
Company setup and security 

Company setup is important from a security standpoint for the following reasons: 

• You grant users access by company, as well as module and task. For example, 
you might want an Accounts Payable clerk to only enter vouchers for one 
company and not the others. 

• You activate modules by company. For example, if you designate a company to 
be a parent for consolidations, you might only activate the Advanced 
Consolidations module. 

Warning: Only activate the modules that have been registered. You cannot 

access data in unregistered modules after the grace period has expired. For 

an explanation, see Registration Grace Period on page 23. 
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Information Used in Setting Up Companies 
 

Required information 

When you set up the company, provide the following information: 

• Company name, address, phone numbers, and tax IDs. This information is 
used in reports and transaction documents. 

• Home currency for the company. A set of predefined currencies is provided. 
You can set up additional currencies with the Multicurrency module. For more 
information, see Multicurrency in the Help system. 

 

Setting Up the Company 
 

Procedure 

Follow these steps: 

1 Log on as shown in Logging on as an Administrator on page 89. 

2 In the Desktop, select System Manager Maintenance menu > Maintain 

Companies. 
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Save button (available when 

you enter a company code) 

Activate Modules button 

(available when you enter a 

 

3 At the Company field, type a code for the company you are creating. This code 

is used to identify the company. 

The company code must start with a letter for consolidations to work properly. 

4 Enter the remaining fields. This information is used in financial statements, 

reports, and other documents generated for that company. 

5 Click Save. 

 
 

Activating Modules 
 

Introduction 

You are now ready to activate the modules for that company. Do not activate 

modules you do not intend to register. You cannot access data in modules that are 

not registered after the grace period has expired. 

company code) 
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Procedure 

Follow these steps from the Maintain Companies window. 

1 Click Activate Modules. The following window appears: 
 

Proceed button 

 
 

2 The window lists all of the modules you have installed. For each module to 

activate for the company, select the Set Active check box. If a module requires 

tasks in another module, those specific tasks are activated as well. 

3 When you have finished selecting the modules, click Proceed. The system 

updates the database to support the module. When the process is complete, 

close the window. 

4 When you are finished setting up companies, close the Maintain Companies 

window, or create or change another company in the Maintain Companies 

window. 
 

Activating a module does not affect the appearance of modules in the Desktop. If 

you try to use a module that is not activated for that company, you get the following 

message: “Unable to start the selected task. The module associated with this task is 

not activated.” You can customize the Desktop to remove modules that you did not 

activate for any of the companies. For more information, see Desktop Customizations 

on page 130. 
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Fixing modules that are activated but not registered 

If you activate a module that you did not register, you will not be able to access data 

in that module after the grace period ends. You cannot deactivate a module after you 

have activated it. 

The only way to stop the system from generating inaccessible data is to reinstall the 

database. You will lose any data you have entered. Follow this procedure: 

1 Run the Database Creation Utility to create a new database set. See Creating New 

Databases on page 36. 

2 Register the modules you purchased. 

3 Activate only the modules you registered. 

 
 

Editing Companies 
 

Procedure 

To change company information, do the following in the Maintain Companies 

window: 

1 At the Company field, type the company code, or click the Navigator button to 

select it from a list. 

2 Edit the fields and click Save. 

The following fields can only be viewed: 

► Company: You cannot change the company code. 

► Home Currency: You cannot change the home currency after transactions 

are entered. 

3 Repeat these steps to change another company or close the Maintain 

Companies window. 
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Deleting Companies 
 

Precaution 

If you delete a company, it permanently deletes all data for that company. It cannot 

be restored, and you cannot undo the deletion. If you mistakenly delete a company, 

you must use backup files to restore information. 

 
Prerequisites 

Before deleting a company, do the following: 

• Stop all other activity on the software. 

• Back up the databases used by the software. 

• Delete all open intercompany transactions for the company you are deleting. 

• Look for closed intercompany transactions for that company. If there are any, 
the company cannot be deleted. 

• Allow sufficient time for this process to be completed. 

 
Procedure 

To delete a company, do the following in the Maintain Companies window: 

1 At the Company field, type the company code, or click the Navigator button to 

select it from a list. 

2 Click the Delete button. 

A dialog box asks you to confirm. When you start, the dialog box shows the status 

of the deletion. When the deletion is finished, the dialog box closes. 

3 Repeat these steps to delete another company or close the Maintain Companies 

window. 
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Setting Up Users 
 

 
Overview 

 
Introduction 

To set up users, follow these general steps: 

• Set up security groups for different types of users, such as administrators, 
clerks, and managers. You can define a default group that applies to all new 
users, unless you specify a security group for that user. 

• Create users. You can create new users directly from Sage 500 ERP or grant 
access to Sage 500 ERP to existing SQL Server and Windows Domain users. As 
you create users, you set their access rights. 

 

These steps are described in this section. 

 
 

Set Up Security Groups 
 

Description 

A security group defines a set of access permissions, which are the rights to view, 

change, or manipulate data. Users you assign to a security group have the access 

permissions of that security group. Set up security groups to grant access rights to 

different modules and tasks for different sets of users. 

 
Ways of setting up security groups 

You can set up security groups in the following ways: 

• By a specific module: For example, you might assign all Accounts Payable 
clerks to a security group called APTASKS and give that group access only to 
tasks within the Accounts Payable module. 
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• By type of task: You can define a group that accesses similar tasks across all 

modules. For example, you might assign those who analyze your financial data 
to a group called REPORTS and give that group access to all reporting tasks. 

• By default: You can create a default security group that is used when users are 
not granted a specific security group for a company. This default security group 
should contain permissions only to tasks necessary for all users within all 
companies. 

 
Prerequisites for setting up security 

When you set up security groups, do the following: 

• See the module guides for information about which tasks different users need. 

• Assign permissions from least permissive to most permissive. 

 
Procedure 

Follow these steps to set up security groups: 

1 Verify that the company for which to assign security groups is active. For 

information about logging on to different companies and changing between 

them, refer to the Getting Started guide. 
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2 Select System Manager Maintenance menu > Maintain Security Groups. The 

following window appears: 

 

3 Type a name and description for the security group. 

4 You have two options for creating a new security group: 

► Create a new group. By default, a new security group is excluded access 

from all tasks and security events for all modules. Set up security to the 

tasks and security events. 

► Copy access rights from another group and make necessary changes. Click 

Copy From. Select the security group to use as the basis for the group you 

are creating. You can then change the security setup for your new group. 

Warning: Do not use the system-defined security group SysAdmin as the 

basis for the default group. SysAdmin provides high-level security access, 

such as module activation, which should be carefully restricted. 

5 At the Module ID field, select the module for which to assign access rights. You 

can grant rights to all modules at one time by selecting All. 

6 The Tasks tab allows you to grant levels of access to the commands that you 

can perform with the selected module. For each task, select one of these 

security levels: 
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► Select Excluded to prevent the user from seeing the task. 

► Select Display Only to allow the user to see data in the task but not change 

or use it. 

► Select Normal to allow the user to use the task and change the data at all of 

the fields in the task window. 

► Select Supervisory to allow the user all the normal rights, and has the 

ability to perform supervisory tasks, such as posting private batches. 

Select the level for each task. If you select a different module ID, you are prompted 

to save the settings. 

Tip: To change the permissions of all of the tasks or security events at one 

time, click the plain gray box in the upper left corner of the Tasks grid. This 

selects all rows and enables the Default Permission field. Select the security 

level and click Apply. 

 
7 The Security Events tab allows you to grant access to module-specific overrides 

in tasks. Security Events handle special circumstances that occur occasionally, 

such as when a customer exceeds a credit limit or when you need to grant 

override approval to continue processing data. You may prefer to grant only a 

few people the permission to override security events. For each security event, 

you can select either of the following: 

► Select Yes to allow the user to perform the event. 

► Select No if the user is not allowed to perform the event. 

Select the choice for each security event. If you select a different module ID, you 

are prompted to save the settings you made. 

8 Repeat steps 5 through 7 for each module (if you did not select All). 

9 Click Save. You can create another security group or close the window. 
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Changing security groups 

You can change settings for existing security groups. Open the group by typing its 

code at the Security Group field or click the Navigator button to select it from the 

list. When you save the changes, they will apply to all users who are assigned to that 

security group. 

 
Deleting security groups 

When you delete a security group, users assigned to that group lose the access rights 

defined in that group. You can assign users to other security groups to give them 

access. 

Warning: You cannot undo the deletion of a security group. 
 

To delete a security group, open it and click the Delete button. A deletion cannot be 

undone. To reestablish a security group that you have deleted, you must reenter all 

information for the security group or copy the information from another security 

group. 

 

Setting Up Users 
 

Ways of adding users 

You can set up users in the following ways: 

• Add an existing SQL Server user. 

• Add an existing Windows user or group, who can be on the same or a different 
domain. The domain needs to be one to which you have permissions and is 
accessible from the SQL Server. 

• Create a new user who is not already on the SQL Server but has a Windows 
logon. 

 
SQL Server access for users 

When you add a user, that person is also granted access rights to the SQL Server 

where the databases are located. You can restrict access to databases on that SQL 

Server from other applications by using application roles. For more information, see 
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Security Options on page 116. 

 
Restriction in logon names 

Do not use reserved SQL Server names, keywords, or characters. 

 
Requirements for users on the SQL Server 

You do not need to create logons in SQL Server before you add them. When you 

select an existing Windows domain user or group or create a new user in Maintain 

Users, the SQL Server logon is created automatically. For Windows users who already 

have a SQL Server associated with them, the software uses that SQL Server logon. 

It is not necessary to create a logon on the SQL server before adding it to the 

software. 
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Procedure 

To add users, follow these steps: 

1 Verify that the company for which to assign security groups is active. For 

information about logging on to different companies and changing between 

them, refer to the Getting Started guide. 

2 Select System Manager Maintenance menu > Maintain Users. The following 

window appears: 

 

 
Browse for 

Windows 

Users button 

 

Navigator 

button 
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3 Perform one of the following to define or select a user ID: 

 

Existing logon Methods for selecting ID 

None Type the logon name at the User 
field. 

 

SQL Server Do either: 

• Type the SQL Server logon 
name at the User field. 

• Click Navigator and select the 
SQL Server logon. 

 

Windows Do either of the following: 

• Type the Windows logon 
name and domain at the User 
field (such as domain\user). 
If this is a user on the current 
domain, type just the logon 
name; the domain name 
appears automatically. 

• Click the Browse for 
Windows Users button and 
select the user from the 
domain. For more 
information, see Selecting the 
Windows user and domain on 
page 115. 

 

 

Note: If you have logged on with a logon other than the default admin 

logon, when you click the Browse for Windows Users button, you are 

prompted to enter the system administrator password. 

 
4 Type the user's name at the Name field. 
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5 If desired, select a default security group for this user. This security group is 

used if you do not assign the user to a group for a company. The default group 

is also assigned to the user automatically when new companies are added to 

the system. 

If you do not assign a default security group, the user needs to be assigned to a 

security group for each company to which the user has access. If you do not assign 

the user to a security group for a company when there is no default, that user will 

be excluded from all tasks within all companies in which permissions have not 

been granted. You can use this approach to exclude users from a company. 

You can set roles for users that control access for AppRole and read-only status by 

selecting the Use Application Role or Allow Read Access check box. You can also 

set roles for users who will be creating, maintaining, or running import jobs 

within the Data Import Manager module. These roles are established by selecting 

the DI Package User or DI Package Administrator check box for users. For more 

information, see Security Options on page 116 and Appendix B, Data Import 

Manager Installation & Configuration. 

6 To assign the user to a different security group for each company, do the 

following: 

a Select a company code at the Company field. 

b Select a security group at the Group field. 

c Click OK. The group is added to the list at the bottom of the window. If 

you change your mind about adding the company and security group to 

the user, click Undo. 

Repeat this step for each company to which to assign the user a security group 

other than the default. 

You can assign users to more than one security group. If the user is in more than 

one security group for the same company, the system grants the user access 

permissions of the security group with the highest access permissions per task. 

Note: You must specify a default security group if you are implementing 

modifications by group using the Customizer module. 

 
7 When you are finished assigning security groups to that user, click Save. You 

can then assign security groups to another user or close the window. 



Registration and Security 

Installation and System Configuration 115 

 

 

Group 

Individual user 

 

Selecting the Windows user and domain 

If you are assigning a Windows user or group, click the Browse for Windows Users 

button in the Maintain Users window to select the domain and user or group name. 

The Domain Users window appears: 
 

 
Perform the following: 

1 At the List Names From field, select the domain where the user or group is 

located. The list changes to show the users and groups in the domain. 

2 Select the user or group. If you select a group, you can click Members to list the 

members in the group. 

3 Click Add. The user or group you selected appears at the Add Name field. 

4 Click OK. The Domain Users window closes and the user or group you selected 

appears at the User field in the Maintain Users window. 
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Security Options 
 

Description 

When you add users, they are granted access to the SQL server where the databases 

are located. If you have databases from other applications, you can control the access 

that Sage 500 ERP users have to them. You can also enable read-only access to Sage 

500 ERP databases from other applications. 

 
Using application roles 

The application roles (also known as AppRoles) feature allows users to access 

databases through the client software, but not other applications. This option creates 

an application role logon on the SQL server that enables the application to assume 

the access rights to complete tasks without granting the user explicit rights. The user 

can have the access you granted while in the software, but not access to the other 

application databases on that SQL server. 

 
Procedure 

To use application roles, you need to follow these steps in System Manager: 

1 In the Maintain Site window, click the Options tab and select the Enable 

Application Role check box to set up the ApplicationAppRole. Assign a 

password. 

2 When you use Maintain Users to grant user access rights, select the Use 

Application Role check box to restrict the rights of that user to the databases. 
 

For more information about application roles, see the SQL Server Books Online. 

 
Allow read access 

When the application role is enabled and the Use Sage AppRole option has been 

selected, users cannot access databases except through the client software. Select the 

Allow Read Access option to grant users read-only access to databases from other 

programs. 
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Setting Data Import Manager roles 

You can set roles for users who will be creating, maintaining, or running import jobs 

within the Data Import Manager module. These roles are established in the Maintain 

Users window by selecting the DI Package User or DI Package Administrator check 

box for users. For more information, see Appendix B, Data Import Manager Installation 

& Configuration. 

 
Requiring passwords 

Another way to add security to the system is by requiring passwords for users. In the 

Maintain Site window, click the Options tab and select the Require Passwords check 

box. 

 

Changing User Settings 
 

Introduction 

To change settings or delete a user, follow the instructions in this section. 

 
Changing user security rights 

You can change the security groups to which the user has access at any time. Follow 

these steps: 

1 At the User field, select the user to change. For users set up in the system, Yes is 

selected at the Is Sage 500 ERP User field. 

2 Make the changes. Note the following: 

► To remove the user from a security group, right-click it and select Delete 

from the menu that appears. 

► To insert a row into the list, right-click where to put the row and select 

Insert Line. A blank row is inserted above the row you selected. Select the 

company at the Company field and security group at the Group field, and 

click OK. The information is inserted into the blank row. 

3 Click Save. 
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Clearing passwords 

The Maintain User window also enables you to clear the password of users who have 

forgotten them. This applies only to users with SQL Server authentication. 
 

Open the user information by selecting the user at the User field. Click Clear 

Password. Users can define a new password in the User Preferences window, which is 

described in Chapter 7, System Configuration and Management. 

 
Deleting users 

When you delete a user from the system, you remove all access rights to all 

companies for that user. You are not deleting the user from SQL Server. Deleting user 

access also does not affect references to that user in Sage 500 ERP data, which 

preserves the audit trail. 
 

Open the user information by selecting the user at the User field and then click the 

Delete button. 
 

To delete a user from both Sage 500 ERP and SQL Server, delete the user from Sage 

500 ERP first. Then, delete the user from SQL Server. 
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Managing and  
 
Protecting  
 
Databases 

 

This chapter shows how to move and copy databases, and synchronize users. 

In this chapter 

Using the Database Synchronization Utility .................................... 120 

Options for Copying or Moving Databases ....................................... 124 

6 
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Using the Database Synchronization 
Utility 

 

 
Overview 

 
Introduction 

Use the Database Synchronization Utility after you move or copy databases. This 

utility enables you to use databases on another SQL Server by adding users in the 

databases to the new SQL Server and resetting internal database references in the 

databases. 
 

This section explains how to use the Database Synchronization Utility and configure 

the client software after moving or copying the databases. For instructions on how to 

move or copy databases in different configurations, see Options for Copying or Moving 

Databases on page 124. 

 

Precautions 
 

Introduction 

This section lists information you should be aware of before you move or copy 

databases. 

 
Installation 

The Database Synchronization Utility is installed with the Database Utilities. If you 

have not installed the database software, see Chapter 3, Database Creation and Upgrade 

for procedures. 
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Preliminary tasks 

Before performing the procedures shown in this chapter, note the following: 

• Verify that the SQL Server meets the requirements. For more information, refer 
to the Compatibility and Resource Guide located in the Support page on the Sage 
Customer Portal at: 
https://customers.sagenorthamerica.com 

• To perform these procedures, you must have knowledge of SQL Server and 
systems functions. The operations are, therefore, beyond the general scope of 
Sage Customer Support. If you are not familiar with these operations, defer the 
procedure to a knowledgeable professional. 

 
Effects on registration 

Registration of the software is tied to a database set and the SQL Server where it is 

installed. If you change the database names or place the databases on another SQL 

Server, you need to reregister. For more information, see Registering the Software on 

page 91. 

 

Starting the Database Synchronization Utility 
 

Procedure 

To start the Database Synchronization Utility, follow these steps: 

1 Select Windows Start menu > All Programs > Sage > Sage 500 ERP 20121 
Utilities > Database Synchronization Utility. 

2 You are prompted to log on. Select the SQL Server where you put the moved or 
copied files. Type the sa password for that SQL Server. Click OK. 

https://customers.sagenorthamerica.com/
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Using the Utility 
 

Description 

To use the utility, select the databases that you moved or copied to the SQL Server. 

You then use options to indicate what items to reset, as described in this section. 

 
Synchronize users 

The Synchronize logons on a new SQL Server check box adds the users created in 

Sage 500 ERP to the SQL Server where you put the databases. Select this check box if 

you copy or move databases to a new SQL Server. 

When you recreate the users on the new SQL Server, the following options are 

available: 

• The Create new SQL Server logon with no password and clear user password 
option creates a new SQL Server logon for each user with a null password. The 
users in the databases are removed and recreated, and their database object 
permissions are regranted. 

• The Create new SQL Server logon with the same name and password option 
creates a new SQL Server logon for each user with the password defined in the 
software. The new logons are linked to the users in the databases, and their 
database objects permissions are retained. 

 
Check database name references 

The Check database references check box resets the internal name references used by 

the software to refer to the other databases in the set. Select this check box when you 

rename databases or copy them to another server. 

 
Registering the new databases 

Databases need to be registered when they are moved to a new server. To register the 

databases as you sync them, select the Send new registration request check box. Type 

your existing information or new registration information at the Customer Number, 

SM Serial Number, and SM Unlocking Key fields. 
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To develop databases on a test server and then move them to another server when 

you are ready to use them for production use, first create the databases on the test 

server using TEST as the System Manager serial number along with your customer 

number and System Manager unlocking key. When you move the databases and run 

the Database Synchronization Utility, select the Send new registration request check 

box and type the same customer number and System Manager unlocking key, but 

enter the System Manager serial number from your packing list. 

During synchronization, the system performs automatic registration. If automatic 

registration fails, you need to run manual registration after the database has been 

synchronized. 
 

For more information about the registration process, see Registration Process on 

page 20. For the registration procedure, see Registering the Software on page 91. 

 

Connecting the Client 
 

Procedure 

After moving or copying databases, change the pointers the software uses to find the 

server and clients. Perform these changes by following these steps: 

1 Start the Client Configuration Utility within ODBC and add any required 

advanced information for the new server. For detailed instructions, see 

Appendix D, Protocol Issues. 

2 Run the Client Configuration Utility as shown in Viewing System Settings on 

page 144. 

3 Select the server and click Refresh. Select the system and application database 

to use. 

4 Start the client. For instructions, see Starting Sage 500 ERP as an Administrator on 

page 88. 

5 In the logon window, select the Advanced Options check box to verify or 

change the server and databases to which the client is connecting. 
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Options for Copying or Moving 
Databases 

 

 
Overview 

 
Introduction 

This section explains ways for copying or moving databases either to the same SQL 

Server or another SQL Server. 

 

Copying Data Between Companies 
 

Description 

Note the following to make copies of settings used by a company: Assisted Company 

Setup enables you to copy settings and data from one company to another within 

the same set of databases. It cannot transfer settings from a company on another 

database. 

To create a company using settings in another database, do the following: 

1 Make a copy of the database containing the company you want using the 

procedures in this section. 

2 Create the company on the database. 

3 Use Assisted Company Setup to copy settings from the desired company to a 

new one. 

4 If desired, delete the company from which you copied the settings after you 

have set up the company to your satisfaction. 
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Single-User Unique Set on the Same SQL Server 
 

Procedure 

You can create more than one database set on the same SQL Server. 

To create a second unique database set using the same server with access granted to 

the “admin” user ID only, follow the steps below. This scenario does not allow a 

password or password change in either database set for the admin user. 

1 Run the Database Creation Utility. For instructions, see Chapter 3, Database 

Creation and Upgrade. 

2 From the Database Creation Utility, specify device and database names 

different from those previously created. 

 

Multi-user Duplicate Set on the Same SQL Server 
 

Procedure 

You can create a duplicate database set on the same SQL Server with access granted 

to multiple users. 

To create a second duplicate database set using the same server with access granted 

to multiple users, follow the steps below. This scenario does not enable a password 

change in either database set for SQL Server users. This does not apply when using 

Windows authentication. 

1 Run SQL Server Management Studio. 
 

2 Create a new database for the application database by performing the 

following: 

a Select the server where you want to put the database. 

b From the Action menu, select New > Database. 

c Specify the same file sizes for the database and transaction log as those 

shown in the production database. 
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3 Back up the application database. On the Tools menu, select Tools > Backup 

Database. Then select these options: 

a Select the application database to back up. 

b Under Backup, select Database - complete. 

c Under Destination, add a new backup destination. It can be either a local 

or mapped hard drive or tape. Verify there is enough space to 

accommodate the data. 

d On the Options tab, select Overwrite existing media, Verify backup upon 

completion, and Initialize and label media. Assign the proper name and 

description to the media set. 

Click OK to start the backup. 

4 Repeat steps 1 and 2 for the production system database. 

5 Restore the databases you backed up into the databases you created. From the 

Tools menu, select Restore Database. Starting with a restore of the application 

database, specify the settings as follows: 

a At the Restore as database field, select the database you created on the 

destination server as the application database. 

b Select From device. 

c Select the device where you backed up the production application 

database. 

d Select Restore backup set and Database - complete. 

e On the Options tab, select the Force restore over existing database check 

box and the Restore database files as check box. Enter the drive, path, and 

file name where the database will be restored. 

Click OK to start the restore. When you are finished with the application database, 

repeat this step to restore the system database. 

6 Run the Database Synchronization Utility as shown in Using the Database 

Synchronization Utility on page 120. Log on to the destination SQL server. 

7 Log on and select the new databases created. Select Check database reference, 

and click Proceed. 
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Multi-user Duplicate Set on a Separate SQL 
Server 

Description 

You can create a duplicate set of databases on a separate SQL server. You can grant 

access to either set to multiple users, and this configuration enables the use of 

passwords and permits password changes for all users. 

If all users created use Windows authentication and the new SQL Server does not 

connect to the same domain, these users will no longer have logon abilities into the 

software. New Windows or SQL Server users will have to be created. 
 

To make a duplicate set, you back up the original databases and restore the data into 

new databases you create on the other SQL Server. 
 

In this procedure, the SQL server on which the databases originate is referred to as 

the production server. The destination SQL Server is referred to as the destination 

server. 

 
Procedure 

Follow these steps. If you need more information about performing these 

procedures, see the SQL Server documentation. 

1 Run SQL Server Management Studio. 

2 Verify that the production and destination servers are registered. 

3 Back up the application database. From the Tools menu, select Tools > Backup 

Database. Then select these options: 

a Select the application database to back up. 

b Under Backup, select Database - complete. 

c Under Destination, add a new backup destination. It can be either a local 

or mapped hard drive or tape. Verify there is enough space to 

accommodate the data. 
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d On the Options tab, select Overwrite existing media, Verify backup upon 

completion, and Initialize and label media. Assign the proper name and 

description to the media set. 

Click OK to start the backup. When you have finished backing up the application 

database, repeat this step to back up the system database. 

4 On the destination server, create two new databases: One for restoring the 

system database and the other for restoring the application database. Make the 

new databases and their accompanying transaction logs the same size as the 

ones on the production server. 

5 Select the destination server. From the Tools menu, select Restore Database. 

Starting with a restore of the application database, specify the settings as 

follows: 

a At the Restore as database field, select the database you created on the 

destination server as the application database. 

b Select From device. 

c Select the device where you backed up the production application 

database. 

d Select Restore backup set and Database - complete. 

e On the Options tab, select the Force restore over existing database check 

box. 

Click OK to start the restore. When you are finished with the application database, 

repeat this step to restore the system and Internet Application databases. 

6 Run the Database Synchronization Utility as shown in Using the Database 

Synchronization Utility on page 120. Log on to the destination SQL Server. 

7 In the Database Synchronization Utility, enter the destination databases into 

which you restored the databases. Select the Synchronize logons on a new SQL 

Server check box and the Check database references check box. Click Proceed. 
 

The new databases are ready to use. 
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System Configuration 
 
and Management 

 
 

This chapter shows you how to customize the Desktop and perform system 

management tasks. 

In this chapter 

Desktop Customizations ................................................................................. 130 

System Management ............................................................................................ 141 
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Desktop Customizations 
 

 
Overview 

 
End-user customizations 

End users can customize the Desktop by adding tasks to My Tasks, arranging and 

changing toolbars, and docking the Desktop to the tops of their screen. For 

customization procedures, refer to the Getting Started guide. 

 
Administrator customizations 

As an administrator, you can make additional customizations to the Desktop: 

• Change tasks in the Tasks tab. This determines which tasks are available to the 
users. 

• Select a task menu that applies to all users. 

• Create different menus for different users. For example, you can create a task 
menu for Accounts Payable clerks and assign it to each clerk. 

 

These are described in this section. 

 
When customizations are applied 

All customizations to the Desktop take effect the next time you start the software. To 

apply the customizations, shut down the software and log back on. The 

customization changes appear in the Desktop. 
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Prerequisites for Making Administrative 
Customizations 

 
Requirement for access rights 

To make administrative customizations, you need Supervisory or Normal rights for 

SM Desktop Customizer. For information about setting access rights, see Set Up 

Security Groups on page 106. 

Important: Set all other security groups to Excluded for SM Desktop 

Customizer. This prevents unauthorized users from making changes that 

affect all users. 

 

Changing and Saving Task Menus 
 

Understanding tasks menus 

You can modify the collection of folders, tasks, and shortcuts in the Tasks pane and 

save it as a task menu. You can save multiple task menus for different types of users. 

 
Default task menu 

The following task menus are provided: 

• Standard: Default task menu. Use it when restoring a customized Task menu to 
its original settings. 

• Sage 100 ERP (formally Sage MAS 90 and 200) Menu: Uses the same 
organization as Sage 100 ERP menus. This task menu is helpful if you are 
migrating from Sage 100 ERP. 

 

These provided task menus cannot be changed or deleted. 

 
Commands for customizing task menus 

Commands for customizing task menus are available from the Tools menu by using 

the Menu Maintenance toolbar. To open the toolbar, right-click a toolbar and select 

Menu Maintenance. 
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Saving task menus 

To change the menu in the My Tasks menu and save it, do the following: 

1 In the My Tasks menu, add, move, or delete tasks and folders as shown in the 

Getting Started guide and the Help Center. 

2 From the Tools menu, select Organize Menu > Save As. The Save As window 

appears: 

 

3 Type a name and description for the task menu. The name can be up to 15 

characters, and the description can be up to 30 characters. Select the Use as Site 

Default check box to use the task menu as default for this site. Click Save. 

 
Opening an existing task menu 

To open a task menu, from the Tools menu, select Organize Menu > Open. A task 

menu can also be accessed by clicking the menu bitmap on the status bar or by 

double-clicking the menu on the status bar. The following window appears: 
 

 
Select the task menu and click OK. The task menu changes to the tasks you selected. 

 
Restoring a task menu 

To undo modifications to the current task menu made from the previously saved 

task menu, select Tools menu > Organize Menu > Reset. Any changes you have made 

from the last saved version will be lost. 
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Changing a task menu 

To make further changes to a task menu, select Tools menu > Organize Menu > Save. 

This saves your changes using the same task menu name. 
 

This command is not available when the standard or Sage 100 ERP task menu is 

active. Use the Save As command to save the task menu under a different name. 

 
Deleting a task menu 

To delete the open task menu, select Tools menu > Organize Menu > Delete. This 

command is not available when the standard or Sage 100 ERP task menu is active. 

 

Setting Task Menus for Users 
 

Description 

You can select a task menu for all users and assign task menus for individual users. 

 
Setting the task menus for all users 

In Maintain Site, set the default task menu. This is used for all users for whom you 

have not assigned a task menu. For security, assign the task menu with the minimum 

needed menu items. 

Perform the following: 

1 Create and save the task menu to set as default as shown in Changing and Saving 

Task Menus on page 131. 

2 In the Desktop, select the System Manager Maintenance menu > Maintain Site. 
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3 On the Maintain Site window, click the Options tab. 

 

At the Default Task Menu field, select the task menu to use as default. Click Finish 

and Exit. 

 
Setting a task menu for a user 

You can set a task menu for an individual user or user group. Perform the following: 

1 In the Desktop, select System Manager > Maintenance > Maintain Users. 

2 At the User field, select the user or user group to whom you are assigning the 

task menu. 

3 At the Task Menu field, select the task menu you are assigning. 

Note: It is recommended that you assign the System menu only to system 

administrators. 

 
4 Save the settings. 

 
For more information about Maintain Users, see Setting Up Users on page 106. 
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Adding Custom Reports 
 

Description 

You can create custom reports that can be used from the Desktop. You create the 

report in Crystal Reports Designer and then add it to the Desktop. 

 
Custom reports 

To see examples of custom reports, see the files in the Sample Custom Reports folder 

in the client folder. The following sample reports are provided: 

• CustomerListing.rpt: A simple list of customers selected from one table in the 
database. 

• CustomerSalesByPeriod.rpt: A more complex example that selects header and 
detail records from two separate tables. This report totals sales per customer, 
and groups sales per fiscal period. 

 
Creating reports 

Follow the instructions in the Crystal Reports Designer documentation to create a 

report. 
 

For the database connection, use ODBC with the DSN name, MAS 500. 

The following formulas are available to populate data from the databases and to 

select data to include in the report. For example, a report can be restricted to include 

only the records of the company from which the report was run. 

• CompanyID 

• CompanyName 

• UserID 

• BusinessDate 

• RunDate 

• RunTime 

• ReportFileName 
 

Create the formulas in Crystal Reports as "". 
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Where to place a report 

When you finish a report, you can save it either on your local drive or on the 

network. If you save it on your local drive, only you will have access to it. To make 

the report available to other users, save it on a network drive and grant users access 

to the folder where you saved the report file. If you are saving the file on an NTFS 

volume, grant NTFS and Share permissions to the users who will use the report. Users 

who do not have these permissions will not be able to run the report even if they 

have been granted rights to run it in System Manager. 

 
Adding reports to the Desktop 

Follow these steps: 

1 In the Explorer Bar, navigate to where you want to place the report. 

2 Right-click and select Create New Task > Custom Report. The following 

window appears: 

 

3 Complete the window as follows: 

a Select the module for the custom report. 

b Type the file name at the Custom Report field or click Browse. If the file is 

on the network, use the UNC path (\\server\path) so that users do not 

need to have the drive mapped to that path. 

c At the Name field, type the name that you want to appear in the Desktop. 

d At the Task Name field, type a name that will be used internally by the 

software to identify the report. This name will be used when you grant 

security access, create shortcuts elsewhere in the Desktop, and other tasks. 

e Type a description of the report. 
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f Click OK. The report is added to the Desktop and created as a task in the 

software. 

4 In Maintain Security Groups, create or modify groups to grant access to the 

custom report you added. The report is listed in the Tasks tab and using the 

module and task name you assigned. Save the changes you made. 

5 In Maintain Users, assign the security group to the users or groups who will be 

able to run the report. Verify that the user also has access to the folder where 

the report file is located. 
 

In the Desktop, users who have access to the report can open it like any other report. 

 
 

Search Form Customization 
 

Administrative customizations 

Users can customize the Search form by selecting the columns to appear in the grid, 

setting their column width and order, and then saving the settings in views. Search 

criteria settings on the Filter tab can be saved with the view. For instructions, see the 

Getting Started guide. 
 

As an administrator, you can control Search form customizations by changing the 

SQL view by the lookup, or by customizing the lookup view using Maintain Lookup 

Views. Changing the SQL view is more complex than Maintain Lookup Views but 

offers the maximum flexibility in customization. For each lookup, you can limit the 

columns that users can select and create your own views. 

 
Procedure for maintaining lookups 

Maintain Lookup allows you, as an administrator, to associate a lookup ID with a 

SQL view. You can use SQL to create your own views that can then be used by a 

lookup. 

Note: Tasks are dependent on some fields returned from the view. Because of 

this, you should never remove columns from a SQL view. When creating 

your own SQL views, start by making a copy of the SQL view used by the 

software and then altering the new SQL view to add the new columns or 

tables. 



System Configuration and Management 

Installation and System Configuration 138 

 

 

 

 
Perform these steps: 

1 Select System Manager Maintenance menu > Maintain Lookups. The Maintain 

Lookups window appears. 

2 At the Lookup field, select the lookup to change. 

3 At the Current SQL Command field, type or select a SQL view to associate with 

this lookup. The SQL view currently associated with this lookup automatically 

displays. 

You can also choose to include both ANSI and non-ANSI queries. 

Note: For all customizations to take effect, users need to close any tasks they 

are currently running and reopen them. 

 
Effects to the underlying SQL query 

The following table outlines some of the possible effects to the underlying SQL query 

in various circumstances: 

 
If... Then... 

...the customization refers to 
a column that no longer 
exists 

 
 
 
 

 
...the customization impacts 
the query and causes an error 

 

...the SQL query is modified 
so that critical columns 
required by the program are 
missing or the factory 
definition fails 

...the customizations are 
automatically removed 
without notification. This 
allows administrators to 
change the lookup without 
causing error messages to 
appear on end user 
workstations. 

 

...the lookup attempts to use 
the standard (factory) 
settings to retrieve the data. 

 

...an error message displays 
and no data is returned. 
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Procedure for maintaining lookup views 

Maintain Lookup Views allows you, as an administrator, to control the 

customizations that end users make to the Search window. You can also create 

customized lookups and make them available to users. 

Follow these steps: 

1 Select System Manager Maintenance menu > Maintain Lookup Views. The 

Maintain Lookup Views window appears: 

 
 

Search for a lookup 

by its name 

 

Search for a lookup 

by a view name 

 
 
 
 

 
2 At the Lookup field, select the lookup to change. 

3 Select the view for the lookup to which to apply settings. 

4 Select the display options for the view. 

a Select the Set as Default check box to use the Lookup View field as the 

default for this lookup. When users open the Search form, it opens with 

the default view. 

b Select the Restrict to Display Columns check box to limit which columns a 

user can add to a view. When a user opens the Lookup View Columns 

window to select columns, that user can only view the columns you have 

selected. Select this check box when there are columns with sensitive data 

that you do not want users to view. 

c Select the Load Data Immediately check box to load data when the Search 

window is opened. If search criteria is saved with a view or the Search 

window, the lookup retrieves the data according to the criteria. 

Note: Select the Load Data Immediately check box to reduce the number of 

steps a user must perform in order to find data, if there is only a small 
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dataset to load. Clear this check box for large datasets so that excessive 

amounts of data are not returned. 

 
5 To change the width and order of columns, click Edit Lookup View. The Search 

window appears, where you can change column widths by dragging column 

borders and add or remove columns by clicking the Form Customizer button. 

Save the view. For instructions, refer to the Getting Started guide. 

6 Save the changes. 
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System Management 
 

 
Overview 

 
Introduction 

The software has several system management features that enable you to monitor 

and manage the usage of the system. These features enable you to perform the 

following: 

• Set the business date. 

• Monitor who uses the system. 

• View system settings. 
 

These are described in this section. 

 
 

Setting the Business Date 
 

Description 

The business date is the default date for the reports and transactions you generate. 

For an explanation of how the software uses dates, refer to the Getting Started guide. 
 

End users have some control over what date is used as the business date through the 

User Preferences task in System Manager. The system date (that is, the date in the 

client system) can be used as the business date, or the same business date can be used 

for all modules. 

 
When to change the business date 

There are situations to use a different business date, such as when you need to enter 

a journal entry for a future date. You can change the business date ahead to next 

month, write the journal entry, and return the business date back to the present 

month. 
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Procedure 

To change the business date, do either of the following in the Desktop: 

• Select File menu > Change Business Date. 

• Double-click the business date at the far right of the status bar. 

 

 

Depending on the settings in User Preferences, one of the following versions of the 

window will appear. 

• If the Use Same Business Date for All Modules check box is selected, the 
following window appears. 

 

Select the business date and then click the Finish and Exit button (on the left). The 

date applies to all modules. 

• If the Use Same Business Date for All Modules check box is cleared, the 
following window appears. 

 

Select the module and then select the business date for that module. Repeat for 

each module you need, and then click the Finish and Exit button. 
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Monitoring System Usage 
 

Ways of tracking usage 

The software has several tools that enable you to track who is using the system. 

 
System Status window 

To view who is currently logged on to the database you are using, use System Status. 

In the Tasks pane, select System Manager Tools menu > System Status. 
 

A window appears that displays the user lD and name, when the user logged on, and 

what companies the person is using. The window appears as follows: 

 

 
This information is useful when you need exclusive use of the software or of a 

company. 
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Tracker 

Tracker shows messages generated by events, such as opening forms and saving data. 

Any errors appear in the message. Sage Customer Support might ask you to view the 

Tracker window to help you resolve a problem. 
 

To open the Tracker window, from the Desktop Tools menu, select Display Tracker. 
 

To close the Tracker window, from the Desktop Tools menu, select Display Tracker 

again. 

 
User IDs on reports 

You can print the ID of the user who ran a report. This feature is helpful when 

several people use a shared printer, or you need to track the report generation when 

deciding who should have access to reports. 
 

Select System Manager Maintenance menu > Maintain Site. In the Maintain Site 

window, click the Options tab and select Print User ID on Reports. 

 

Viewing System Settings 
 

Tools for viewing settings 

To help you troubleshoot your system, the software has three tools for viewing 

system settings: 

• Client Configuration Utility shows the SQL server and databases you are 
currently logged on to and the location of program files. 

• System Inspector displays system and Sage 500 ERP settings, files, and Registry 
entries. 

• Report Update Utility scans through all Crystal Reports files installed for the 
client installation and sets the default database name to the database name 
selected when the utility is run. 

 

These tools are described in the following sections. 
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Desktop (Client) Configuration Utility 

To start the Client Configuration Utility, select Windows Start menu > All Programs 

> Sage > Sage 500 ERP 2023 > Utilities > Client Configuration Utility. The Client 
Configuration Utility window appears: 

 

As described in the Getting Started guide, the Client Configuration Utility can be used 

for changing the SQL Server and database you are logged on to. If you are using 

Windows authentication, you can make the logon window reappear by clearing the 

Use Windows Authentication check box. You can also clear the Show Startup Logo 

check box to remove the logo to improve startup speed over Windows Terminal 

Services. 

Note: “Sotaadmin” is no longer used in this utility. If you do not have a 

windows logon to the SQL Server, a logon dialog will appear. 
 

You can configure the settings for each user or for all users on the system. The 

application settings are written to the registry for each user in C:\Documents and 

Settings. 

The Client Configuration Utility also allows you to view the folders used for program 

and Help files for the client system you are using. If you get errors in launching parts 

of the program or Help, this window shows the folders where the files are supposed 

to go. You can change the path by clicking a path button. Avoid using this feature 

because you can render the client unusable if you set the folders incorrectly. 

If you change settings in the Client Configuration Utility while the software is 

running, the changes are applied when you close and re-log on to the software. 
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System Inspector 

To start the System Inspector, select Windows Start menu > All Programs > Sage > 
Sage 500 ERP 2023 > Utilities > System Inspector. The System Inspector window 
appears: 

 

The left pane shows the types of information available in System Inspector. Select 

the type of information, and the data appears in the right pane. If a type has a + in 

front of it, double-click it to drill down to additional information. 

You can save the information by performing one of the following: 

• Click the Save button or select Save As from the File menu to save the 
information in a file. 

• Click the Print button or select Print from the File menu to print the 
information. 
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Report Update 

To start the Report Update Utility, select Windows Start menu > All Programs > Sage 

> Sage 500 ERP 2023 > Utilities > Report Update Utility. The Report Update Utility 
appears: 

 

 
Select the location of the Crystal Reports (.rpt) files and where to output the log file. 
After the utility is run, the results are displayed in the Results grid. 

 

Each report is generated using a template that contains the database name as part of 

the report structure. By default, the report's database name is set to mas500_app. If 

you are logged on to a database with a different name, the system must rename the 

database and validate it for each report that is run. When the database name is 

changed at runtime, Crystal Reports validates the schema of each table in the report 

by calling stored procedures in SQL Server. These calls increase the load on the 

server. If a large number of reports are run on a continual basis, the many validation 

calls that occur can affect report performance. 
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To improve SQL Server performance, this utility reduces the number of validation 

calls by setting the database name in the report files to match the database name 

used to log on to the software. 

Note: Organizations where report processing is a less frequent occurrence 

are unlikely to see a noticeable gain in performance by using this utility. 
 

Updating the Crystal Report files requires System Administrator privileges in order to 

save files in the Program Files folder. 
 

The Crystal Report files must be updated on each client system where they are used. 

In a Citrix or Windows Terminal Server environment, the report files are updated on 

the terminal server. 
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Working with Visual 
 
Process Flows 

 
 

Visual Process Flows incorporated into Sage 500 ERP graphically displays several 

business processes typically completed during the normal course of business. These 

graphical representations allow you to click on graphical components to launch Sage 

500 ERP tasks. All Visual Process Flows are displayed within the browser pane of the 

undocked desktop. If the desktop is docked, all Visual Process Flows appear disabled 

within the docked desktop's menus. All Visual Process Flow editing is also performed 

within the browser pane of the undocked desktop. 

8 
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In this Chapter 

This chapter describes the Visual Process Flow features available and how to 

incorporate them into the Sage 500 ERP product. 

In this chapter 

Requirements .......................................................................................................... 150 

Launch Sage 500 ERP Task Embedded within Visual Process Flows150 

Edit a Visual Process Flow............................................................................... 151 

Create a Visual Process Flow ........................................................................ 152 

Embed a Sage 500 ERP Task into a Visual Process Flow ........... 153 

Embed Link to Another Sage 500 ERP Visual Process Flow 155 

Add a Visual Process Flow to Menu ........................................................ 156 

Changing Desktop Users ............................................................................... 158 

Add Visual Process Flow Toolbar Option ............................................. 158 

Export/Import ........................................................................................................ 160 

Miscellaneous .......................................................................................................... 162 

Requirements 

Adobe Flash must be installed on the client workstation to view or edit Visual 

Process Flows. This component is not installed by the Sage 500 ERP installation. This 

component can be downloaded from Adobe's website. 

Launch Sage 500 ERP Task Embedded within 
Visual Process Flows 

To launch a Sage 500 ERP task embedded within the Visual Process Flow, single-click 

on the node below the task description. 
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Edit a Visual Process Flow 

To edit an existing Visual Process Flow, do the following: 

1 Right-click on the Visual Process Flow desired as a template and select Edit 

Visual Process Flow. 
 

 
2 Edit the Visual Process Flow using the designer. 

3 Click the Save button in upper right corner of designer, if enabled. 

If the Save button is disabled then the Visual Process Flow is a factory flow and 

cannot be overwritten; in this case you must use Save As and create a new Visual 

Process Flow. 
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4 Close the Visual Process Designer by clicking the X in the upper left corner of 

the web browser tab or right-click the web browser tab and select Close. 

Clicking the Close button in the upper right corner of the designer causes the 

designer to close and run the Visual Process Flow. 

 

Create a Visual Process Flow 

To create a Visual Process Flow, you can use one of the two following methods. 

 
Using the standard template 

1 Start the Visual Process Flow Designer menu option. 

2 Design the Visual Process Flow. 

3 Click the Save As button in upper right corner of designer. 

4 Enter the name of Visual Process Flow in the Save As dialog and click Save. 

5 Close the Visual Process Designer by clicking the X in the upper left corner of 

the web browser tab or right-click the web browser tab and select Close. 

6 Add your new Visual Process Flow to menu. 

 
Using existing a Visual Process Flow as a template 

1 Right-click the Visual Process Flow you want to use as a template and select 

Edit Visual Process Flow. 

2 Edit the Visual Process Flow using the designer. 

3 Click the Save As button in upper right corner of designer. 

4 Enter a name for the new Visual Process Flow in the Save As dialog and click 

Save. 

5 Close the Visual Process Designer by clicking the X in the upper left corner of 

the web browser tab or right-click the web browser tab and select Close. 

6 Add the new Visual Process Flow to menu. 
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Embed a Sage 500 ERP Task into a Visual 
Process Flow 

To embed a task into a Visual Process Flow, do the following: 

1 Open Visual Process Flow for editing. 

2 Select the link (node) and click the Link button. 
 

 
3 Within the Link to screen, set the Link to drop down to ERP Function and 

enter, paste or lookup the Sage 500 ERP task ID into the Function text box. 
 

 
To obtain the Sage 500 ERP task ID through one of the Sage 500 menus, do the 

following: 

• Within the Sage 500 ERP Desktop, find the menu item desired such as Enter 
Sales Orders and Quotes. 

• Right-click the menu item and select Properties from the context menu. 

• On the Properties dialog, click the Show More link. 
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• After the dialog expands, select the Task ID value and copy to the 

clipboard(Ctrl C). 

To obtain the Sage 500 ERP task ID through the lookup: 

• Click the … button to the right of the Function text box to display a task ID 
lookup. 

 

 
• Locate the desired task and select it. 
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Embed Link to Another Sage 500 ERP Visual 
Process Flow 

1 Open the Visual Process Flow for editing. 

2 Select the link (node) and click the Link button. 
 

 
3 Within the Link to screen, set the Link to drop down to Other process and 

enter, paste or lookup the Sage 500 process ID into the Page text box. 
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To obtain the Sage 500 ERP process ID through the lookup: 

• Click the … button to the right of the Function text box to display a Visual 
Process Flow lookup. 

 

• Locate the desired Visual Process Flow and select it. 

 
 

Add a Visual Process Flow to Menu 

To add a Visual Process Flow menu item to the Desktop menu, right-click the desired 

menu folder or menu area and select Create New Task and then Visual Process Flow. 

If the Visual Process Flow toolbar option is not available, see Add Visual Process Flow 
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Toolbar Option. 

 

 
Within the Add Visual Process Flow screen, fill in the description (this will be the 

menu caption) and select a Visual Process Flow with the process flow lookup. Click 

OK. 
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Changing Desktop Users 

Visual Process Flows are very similar to Sage 500 ERP menus; in fact both the menus 

and Visual Process Flows use the same internal mechanisms to launch Sage 500 ERP 

tasks. The Sage 500 ERP Desktop allows several users to be logged-in at once, when 

the user context is changed that user's menus are loaded. To ensure the Visual 

Process Flows are associated with the user context, any Visual Process Flows opened 

when the user context is changed will be closed. 

 

Add Visual Process Flow Toolbar Option 

To add the Visual Process Flow toolbar, do the following: 

1 Click Tools > Customize Toolbars... 

2 When the Customize dialog appears, click the Commands tab. 

3 In the Categories list box, click Create Task Commands. 
 

 
4 In the Commands list box, click and drag Visual Process Flow to the Desktop 

Tools > Organize Menu > Create New Task > under Custom Report... and drop. 

5 Click Close on the Customize dialog. 
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Export/Import 
 

Exporting a VPF 

To export the Visual Process Flow, perform the following steps: 

1 Open the Visual Process Flow for editing. 

2 Click File -> Export as text… 
 

3 In the Export dialog (labeled Your data) ensure all the data is highlighted; right 

click and select Copy. 
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Open any text editor (Notepad) and paste contents into it; then save as a text file. 

 
To Import a VPF 

To import the Visual Process Flow perform the following steps: 

1 To import the visual process flow perform the following steps: 

Start the Visual Process Flow Designer menu option. 

Click File -> Import… 
 

 
2 Open the previously saved exported text file and copy its' contents to the 

clipboard. 

3 Within the Import dialog (labeled Paste your data here) right-click and select 

Paste. 

4 Click OK on the Import dialog. 

5 Click Save As button in the upper right-corner of the designer to save the 

Visual Process Flow. 
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Miscellaneous 

The following methods of opening and saving Visual Process Flows should be 

avoided: 
 

 

 

 
These options will open and save a Visual Process Flow from/to a file location on the 

current machine. Since the Visual Process Flows do not go into the Sage 500 ERP 

database they are not available for other users, cannot be associated with a menu 

item and are not accessible if the user logs-in through a different machine. 
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Working with Reports A 
 
 
 
 
 

System Manager reports provide information about the system, including system 

activity, security, and system-wide information. You can use reports to maintain a 

history of system activity or to troubleshoot problems. 
 

This appendix describes the report and inquiry options available in System Manager.  

For information on report types and features, and how to generate and print reports, 

refer to the Getting Started guide. 

Important: Some reports contain sensitive information. Control access to 

these reports and keep printouts in a safe location. 

In this appendix 

System Manager Reports ................................................................................ 164 

System Manager Lists ....................................................................................... 168 
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System Manager Reports 
 

 
Overview 

 
Definition 

Reports present a record of activity over a period of time. 

 
Reports 

System Manager reports are generated from the Reports menu. 

System Activity Log ......................................................................... on this page 

Maintenance Audit Log .................................................................................. 165 

Company Profile Report ................................................................................ 166 

Company User Group Permissions Report ........................................ 167 

 
 

System Activity Log 
 

Contents 

This report provides information on any major event that occurs in your system, 

such as the addition or deletion of users, intercompany transactions, or 

unrecoverable errors. 

 
Sorting 

You can sort the list by: 

• Event Date 

• Event Description 

• Event Time 

• User 



Generating 
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Select Reports menu > System Activity Log. 

 
Purging 

Periodically, purge the System Activity Log to keep it a manageable size. Follow 

these steps: 

1 Back up the data before purging any information. 

2 Select System Manager Activities menu > Purge Activity Log. The following 

window appears: 

 

3 Select the items to purge. 

4 Click the Finish and Exit button. 

 
 

Maintenance Audit Log 
 

Contents 

This report provides information on any major event that occurs in your system, 

such as the addition or deletion of users, intercompany transactions, or 

unrecoverable errors. 

 
Database option 

The report can generate information from the application or system database. 
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You can sort the list by: 

• Company 

• Operation 

• System Date 

• User 

 
Generating 

Select Reports menu > Maintenance Audit Log. 

 
 

Company Profile Report 
 

Contents 

This report provides information for a company, including its address, telephone 

and fax numbers, Federal ID number, database connections, and home currency. 

This information is drawn from information you enter in Maintain Companies. 

 
Sorting 

You can sort the list by: 

• Company 

• Company Name 

 
Generating 

Select Reports menu > Company Profile. 



Installation and System Configuration 167 

 

 

Company User Group Permissions Report 
 

Contents 

This report provides a list of all companies and their corresponding security groups. 

 
Generating 

Select Reports menu > Company User Group Permissions. 



Installation and System Configuration 168 

 

 

System Manager Lists 
 

 
Overview 

 
Definition 

Lists contain settings and definitions established for the operation of the system. 

 
Lists 

System Manager lists are generated from the Maintenance or Reports menu, or by 

clicking the Print button in the associated task. 

User List................................................................................................. on this page 

Security Group List ............................................................................................ 169 

Company List ........................................................................................................ 169 

Site Profile List ...................................................................................................... 170 

Assisted Company Setup List ...................................................................... 170 

 

User List 
 

Contents 

The User List provides a list of user codes, names, and default security groups. 

 
Sorting 

You can sort the list by: 

• User 

• User Name 
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Generating 

Produce this list in one of the following ways: 

• Select Reports menu > Other Lists > User Group List. 

• In the Maintain Users window, click the Print button. 

 
 

Security Group List 
 

Contents 

The Security Group List provides a list of security group codes, descriptions, and 

assigned access permissions. 

 
Generating 

Produce this list in one of the following ways: 

• Select Reports menu > Other Lists > Security Group List. 

• In the Maintain Security Groups window, click the Print button. 

 
 

Company List 
 

Contents 

The Company List provides a list of all the companies defined in your system and 

includes company codes, names, and database connections. 

 
Generating 

Produce this list in one of the following ways: 

• Select Reports menu > Other Lists > Company List. 

• In the Maintain Companies window, click the Print button. 
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Site Profile List 
 

Contents 

This report lists the modules you have registered and activated and information 

about the registration. You can print this report and save it for your records. 

 
Format 

The report is available in these formats: 
 

Format Description 

Site Profile  Displays information about your license; 
your customer number, System Manager 
serial number, and System Manager 
unlocking key; and the registered modules. 

 

Activated 
Modules 

Lists the modules you have activated. 

 
 

 

Generating 

Generate the report by performing one of the following: 

• Select Site Profile List from the Reports menu. 

• Click the Print button in the Maintain Site window. 

 

Assisted Company Setup List 
 

Contents 

The Assisted Company Setup List produces a list of all of the phases and steps of 

Assisted Company Setup. For each phase and step, the list shows the status, the user 

assigned to it, and comments. 
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Generating 

Produce this list in one of the following ways: 

• Select Reports menu > Other Lists > Assisted Company Setup List. 

• In the Assisted Company Setup window, click the Print button. 
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Data Import Manager  Installation & 
Configuration 

 

This appendix provides information for installing and configuring SQL Server and 
for configuring the Data Import Manager (DI) module after installing the software. 

Important: The Data Import Manager module is not compatible with Office 

365. Refer to the Compatibility and Resource Guide located in the Support 

page on the Sage Customer Portal to verify what versions of Office and 

Windows are compatible with the module. Visit the portal at: 

https://customers.sagenorthamerica.com 

In this appendix 

Installation and Configuration Checklists ......................................... 173 

SQL Server Installation and Configuration ........................................ 176 

Sage 500 ERP Installation and Configuration Requirements 180 

B 

https://customers.sagenorthamerica.com/
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Installation and Configuration 
Checklists 

 

 
Overview 

 
Introduction 

The Data Import Manager module allows you to import certain predefined data entities, 
such as customers and sales orders into databases in compliance with Sage 500 ERP 
business rules. Data Import Manager uses SQL Server Integration Services (SSIS), which 
is a component of Microsoft SQL Server that provides a platform to build data 
integration and applications. 

Note: SSIS is also known as Integration Services. 
 

Use the following checklists to install and configure your system to work with the 

Data Import Manager module. The checklist is broken into two sections for the 

server and client. Depending on your setup, you may have already accomplished 

some of these checklist items. If so, skip to the next checklist item. The following 

general steps are described in detail later in this appendix. 
 

Before using the Data Import Manager module to import data from the external data 

sources to the destination database tables, you should have a strong understanding 

of the source data structure and predetermine which tables and columns from the 

source system to map to the destination tables and columns in Sage 500 ERP. 
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Use the following checklist for the server-side configuration. 

1   Verify that your system meets the hardware and software requirements. For 

more information, refer to the Compatibility and Resource Guide located in the 

Support page on the Sage Customer Portal at: 

https://customers.sagenorthamerica.com 

2   Install SQL Server. For more information, see SQL Server Installation and 

Configuration on page 176. 

Install the following services and utilities: 

► Database Services 
► Integration  Services 
► Client Utilities 

3   For SQL Server, use SQL Server Configuration Manager to set the logon 

accounts for the SQL Server Agent Service. There is a known issue if other 

methods are used. For more information, refer to the Microsoft knowledge base 

article 911305 titled, "Replication agent jobs may fail..." at: 

http://support.microsoft.com/kb/911305 

4  Ensure the SQL Server Agent Service is running. 

5   If data sources are going to exist on a machine other than the server where SQL 

Server is installed, the Windows Firewall needs to be configured to allow 

communication with external machines. 

6   Install the database. For more information, see 

Chapter 2, Overview of Installation. 

7   If you are planning to use Excel 2007 (or greater) files as source data in Data 

Import Manager, install the 2007 Office System Driver Data Connectivity 

Components. This installation file is located on the Sage 500 ERP software in 

the ..\Support\Microsoft\2007 Office system Drive Data Connectivity folder. 

8   Designate a Windows account for the Sage 500 ERP Credential in SQL Server 

Management Studio. For more information, see Configuring the Sage 500 ERP 

Credential After Installing Sage 500 ERP on page 185. 

https://customers.sagenorthamerica.com/
http://support.microsoft.com/kb/911305
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Use the following checklist for the client-side configuration. 

1   For client machines that will be used to create import jobs using Maintain 

Import Jobs in the Data Import Manager module, run either the SQL Server 

Tools Install or the SQL Server Servers Install. For more information, see Sage 

500 ERP Client Installation and Configuration Requirements on page 181. 

2   If you are planning to use Excel 2007 (or greater) files as source data in Data 

Import Manager, install the 2007 Office System Driver Data Connectivity 

Components. This installation file is located on the Sage 500 ERP software in 

the ..\Support\Microsoft\2007 Office System Driver Data Connectivity 

Components folder. 

3  Install the client. 

4  Log on as admin. 

5   Activate the Data Import Manager module in the Maintain Companies task in 

the System Manager module. 

6   Make the Windows account assigned to the Sage 500 ERP Credential a Sage 500 

ERP user. 

7   Create the logon accounts for users, depending on their intended roles (create 

and maintain, or run import jobs) in Maintain Users. For more information, 

see Creating the Logon Accounts for Users Working with Data Import Manager on 

page 184. 

8   Set the passwords for the users with a standard SQL Server logon in User 

Preferences. Passwords are required for users creating packages. For more 

information, see Setting Passwords for Sage 500 ERP Accounts with a Standard SQL 

Server Logon on page 186. 

You can now use the Data Import Manager module in the client to define the source 

data connection, create import job definitions, and execute an import job. For more 

information, see the Help system. 

Note: Using local file paths in the Maintain Source Connections task in the 

Data Import Manager module is not recommended. To eliminate conflicts, 

configure a file share and use the UNC name in Maintain Source 

Connections. For more information, see Accessing Source Files and Shared 

Folders for Hosting on page 188. 



Installation and System Configuration  176 

 

 

SQL Server Installation and 
Configuration 

 

 
Overview 

 
Introduction 

SQL Server is required to run Data Import Manager. The following section provides 

information for installing and configuring SQL Server, as well as configuring the 

Data Import Manager. 

 
Procedure 

You must perform the following procedures on the SQL Server for the Data Import 

Manager to work properly. 

1 Install SQL Server services and utilities. For more information, see Installing 

Services and Utilities on page page 177. 

2 To process Data Import Manager jobs, SQL Server should allow local and 

remote connections. 

3 Install the Sage 500 ERP database. 
 

4 Install the files needed to process Data Import Manager jobs. For more 

information, see Data Import Manager Database Upgrade and Relocation on 

page 178. 

5 Install the files needed to process multi-format text files. This step is optional. 

For more information, see Working with Multi-Format Text Files on page 177. 

6 Use the SQL Server Configuration Manager to configure SQL Server to allow 

local and remote connections. 
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Installing Services and Utilities 
 

Procedure 

To install and configure the SQL Server 

1 Ensure that the SQL Server Agent is running. 

2 Install SQL Server. 

Note: SQL Server and SQL Server Integration Services (SSIS) must reside on 

the same machine. 

Note: If the database resides on a named instance of SQL Server, refer to 

the following article about configuring SSIS to work with a named 

instance of SQL Server: 

https://docs.microsoft.com/en-us/sql/integration-services/service/integration- 

services-service-ssis-service?view=sql-server-ver15 
 

Working with Multi-Format Text Files 
 

Support for 
multi-format text files 

The Data Import Manager module supports multi-format text files when defining the 

source type to use for the data source (in the Maintain Source Connection window). 
 

To import data from multi-format files in Data Import Manager, you must install the 
DI Server Utilities.msi package on the server. The DI Server Utilities.msi installation  

package is located on the Sage 500 ERP software in the \DIServerUtilities folder. You 
can access this utility from the Start menu > All Programs > Sage > Sage 500 ERP 2023 
> Utilities. 

https://docs.microsoft.com/en-us/sql/integration-services/service/integration-services-service-ssis-service?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/integration-services/service/integration-services-service-ssis-service?view=sql-server-ver15
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Data Import Manager Database Upgrade and 
Relocation 

 
Upgrade new server from SQL Server 2005 
(32- or 64-bit) to SQL Server 2008 R2 SP3 or 2012 (32- or 64-bit) 

Perform the following steps. 

1 Run the Database Synchronization Utility. For more information, see Using the 

Database Synchronization Utility on page 120. 

2 Configure the Sage 500 ERP credential created 

in SQL Server. For more information, see 

Configuring the Sage 500 ERP Credential After Installing Sage 500 ERP on page 185. 

3 In Maintain Users, make sure that the credential created in SQL Server has the 

appropriate roles set up to access Data Import Manager. 

4 Install the necessary files to process multi-format text files. This step is 

optional. For more information, see Working with Multi-Format Text Files on 

page 177. 

5 Purge Data Import Manager job history using the Purge Import Job History 

task. 

6 Save all DI jobs using the Maintain Import Job task. 

 
Upgrade in-place SQL Server 2008 R2 SP3 or 2012 (32-bit) to SQL 
Server 2008 R2 SP3 or 2012 (64-bit) 

No additional steps need to be performed. 

 

 
Upgrade new server SQL Server 2008 R2 SP3 or 2012 (32-bit) to 
SQL Server 2008 R2 SP3 or 2012 (64-bit) 

Perform the following steps. 

1 Run the Database Synchronization Utility. For more information, see Using the 

Database Synchronization Utility on page 120. 
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2 Configure the Sage 500 ERP credential created 

in SQL Server. For more information, see 

Configuring the Sage 500 ERP Credential After Installing Sage 500 ERP on page 185. 

3 In Maintain Users, make sure that the credential created in SQL Server has the 

appropriate roles set up to access Data Import Manager. 

4 Install the necessary files to process multi-format text files. This step is 

optional. For more information, see Working with Multi-Format Text Files on 

page 177. 

5 Purge Data Import Manager job history using the Purge Import Job History 

task. 

6 Save all DI jobs using the Maintain Import Job task. 

 
 

Data Import Manager Configuration for SQL 
Server 2008 64-bit 

 
Procedure 

To process Data Import Manager jobs when using SQL Server 2008 64-bit, you must 

install the DI Server Utilities.msi package on the server. The Sage 500 ERP DI Server 

Utilities.msi installation package is located in the ..\DIServer Utilities folder on the 

Sage 500 ERP software. 

Perform the following steps: 

1 Select Windows Start menu > All Programs > Sage > Sage 500 ERP 2014 > 

Utilities. 

2 Select the database to update. 

3 Click Browse to locate the 32-bit version of the DTEXEC.EXE file. The file is 

installed by the SQL Server installation and is located in the ..\Programs Files 

(x86) folder. 

4 Click Proceed. 

Note: If this configuration step is completed after several Data Import jobs 

have been created, you must run the Database Synchronization Utility to 
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correct the created jobs. For more information, see Using the Database 

Synchronization Utility on page 120. 

 

Sage 500 ERP Installation and 
Configuration Requirements 

 

 
Overview 

 
Requirements 

After installing the software, you must run certain SQL components from the SQL 

Server installation media and configure the Data Import Manager module so that 

users can create, maintain, and run import jobs. 

 
Procedure 

You must perform the following procedures on the client for the Data Import 

Manager module to work properly. 

1 Install either SQL Server Tools or SQL Server Servers. For more information, see 

Sage 500 ERP Client Installation and Configuration Requirements on page 181. 

2 Configure the Sage 500 ERP Credential. For more information, see Configuring 

the Sage 500 ERP Credential After Installing Sage 500 ERP on page 185. 

3 Grant permissions to users who will work with the Data Import Manager 

module. For more information, see Creating the Logon Accounts for Users Working 

with Data Import Manager on page 184. 

4 Set up passwords for all Data Import Manager package administrators. 

Passwords are required in the Data Import Manager module. For more 

information, see Setting Passwords for Sage 500 ERP Accounts with a Standard SQL 

Server Logon on page 186. 

5 Set up a file share for use in Maintain Source Connections. This step is 

optional. For more information, see Accessing Source Files and Shared Folders for 

Hosting on page 188. 
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6 Verify access privileges. For more information, see Accessing Data Import Manager 

Tasks on page 189. 

 
 

Sage 500 ERP Client Installation and 
Configuration Requirements 

 
Requirements 

The following procedure is required only on client machines that will be creating or 

editing SSIS packages in the Data Import Manager module data. This procedure is not 

required to run Data Import Manager packages. 

 
Installation options 

Building SQL Server Integration Services (SSIS) packages inside the Data Import 

Manager module requires that components be installed from the SQL Server CD- 

ROM. 
 

For SQL Server 2008/2012, two installation options are available: 

• SQL Server Tools 

• SQL Server Servers 
 

For SQL Server 2008/2012, use the SQL Server Installation Center. 

 
Procedure 

1 Install the Sage 500 ERP client. 

2 Run the SQL Server setup from the SQL Server 2008/2012 DVD. From the SQL 

Server Installation Center message dialog, click Installation. 
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3 In the right pane of the Installation option, click New SQL Server stand-alone 

installation or add features to existing installation. 

 

4 On the Feature Selection screen, select the following options for SQL Server 

2008. 
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5 On the Features Selection screen, select the following options for SQL Server 

2012. 
 

 
6 Install the SQL Server backward compatibility components on each client 

using Data Import Manager. These components are located in the 

..\Support\Microsoft\SQL Server 2008 and 2012\Backward Compatibility 

Components folder on the Sage 500 ERP software. Depending on the type of 

machine, launch the appropriate .msi file. On the Feature Selection screen, 

accept the defaults and click Next. 
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Creating the Logon Accounts for Users Working 
with Data Import Manager 

 
Procedure 

Use the following procedure to grant create, maintain, or run permissions to users 

who will be working with import jobs within the Data Import Manager module. 

To create logon accounts for users working with Data Import Manager 

1 Log on to the software. 

2 Create three user types: credential, administrator, and user. For information 

about setting up a credential user, see Configuring the Sage 500 ERP Credential 

After Installing Sage 500 ERP on page 185. 

For instructions on how to set up administrator and user permissions, perform the 

following substeps: 

a Select System Manager Maintenance menu > Maintain Users. 

b In the Maintain Users window, create a logon for the user account 

designated in the Sage 500 ERP credential. Select the DI Package User check 

box. 

Note: The DI Package User check box allows the user to run existing 

import jobs. 

c In the Maintain Users window, create a new logon for the user to create, 

maintain, or run Data Import Manager packages. At the Default Security 

Group field, enter an appropriate security group, and then select the DI 

Package Administrator check box. When you select the DI Package 

Administrator check box, the DI Package User check box is selected 

automatically. 

Note: The DI Package Administrator check box allows the user to create, 

maintain, and run import jobs. The DI Package User check box allows 

users to run import jobs. 
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Note: Users who will be creating or maintaining SSIS packages in Data 

Import Manager must have a SQL Server logon with a password or have 

a Windows integrated security account. 

 

 
 

Configuring the Sage 500 ERP Credential After 
Installing Sage 500 ERP 

 
Overview 

The Sage 500 ERP Credential in SQL Server must be configured to designate the 

Windows account that will be used to process import jobs. 

 
Procedure 

To designate the Sage 500 ERP Credential after installing Sage 500 ERP 

1 Activate the Data Import Manager module for at least one company (this step 

creates the Sage 500 ERP Credential and /Sage 500 Proxy). 

2 Run SQL Server Management Studio. 

3 Connect to the Sage 500 ERP Server in the Object Explorer. 
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4 Expand the Security node, and then the Credentials node to access Credential 

Properties. 

 

5 If the Data Import Manager data sources will reside on the same machine as the 

SQL Server, set the correct password for the Windows Administrator account 

on the local machine or change the account to a Windows account that can 

access the location of the data sources. 

If the Data Import Manager data sources will not reside on the same machine as 

the SQL Server, set the account and password to a network account that can access 

the location of the data sources. 

 
 

Setting Passwords for Sage 500 ERP Accounts 
with a Standard SQL Server Logon 

 
Overview 

Use the following procedure to set the passwords for the Sage 500 ERP accounts with 

a standard SQL Server logon. Passwords are required in the Data Import Manager 

module. 
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Procedure 

To set passwords for accounts with a standard SQL Server logon 

1 Log on as a Data Import Manager package administrator. For more 

information, see Configuring the Sage 500 ERP Credential After Installing Sage 500 

ERP on page 185. 

2 Select System Manager menu > Tools > User Preferences. 

3 In the User Preferences window, click the Passwords tab. 

 

4 Type a password at the Enter New Password field, and then repeat the password 

at the Repeat New Password field. 

5 Click the Finish and Exit button on the toolbar. 

6 Repeat steps 1 through 5 for all users who are assigned the role of Data Import 

package administrator. 

7 Log off of Sage 500 ERP. 
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Accessing Source Files and Shared Folders for 
Hosting 

 
Overview 

Using local file paths in Maintain Source Connections in the Data Import Manager 

module is not recommended. File paths should be in UNC format. Local file paths 

are absolute paths on a single machine. For example, the file 

C:\FolderName\FileName.txt is not accessible from both the server and client 

machine. 
 

To eliminate conflicts, configure a file share and use the UNC name in the Maintain 

Source Connections task. For example, the file 

\\MachineName\ShareName\FileName.txt is accessible from both the server and 

the client machines using that same name. 

When configuring file shares, make sure the Windows account configured in the 

Sage 500 ERP Credential is able to read the source files on the file share where they 

are stored. 

If files will be archived as they are processed, the Windows account configured in the 

Sage 500 ERP Credential must have permissions to remove files from the source file 

folder and write them to the archive file folder. 
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Accessing Data Import Manager Tasks 
 

Accessing tasks 

The following table provides information about the access privileges for users set up 

as DI Package User and DI Package Administrator. 
 

No admin 

authority - 

password 

optional 

 
Admin 

authority - no 

password 

 
Admin authority 

- with password 

 

Task in 
How Task Is 

No DI 

Sage 500 
Invoked 

pkg 
ERP auth 

DI pkg 

admin 

or 

user 

 

DI pkg DI pkg DI pkg DI pkg 

admin user admin user 

Maintain 
Source 

Data Import 
Manager 

No No Yes No Yes No 

Connec- 
tion 

Maintenance 
menu > 

      

 Maintain 
Source 

      

 Connection.       

Maintain 
Import Job 

Data Import 
Manager 

No No No No Create, 
update, 

Delete 

 Maintenance 
menu > 

    delete, 
and 

 

 Maintain 
Import Job. 

    run an 
import 

 

      job  

Process 
Import Job 

Data Import 
Manager 

No No No No Delete 
and 

Delete 
and run 

 Activities menu 
> Process 

    run an 
import 

an 
import 

 Import Job.     job job 
execu- 

       tion 



No admin 

authority - 

password 

optional 

Admin 

authority - no 

password 

Admin authority 

- with password 

DI pkg 
Task in No DI 
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user 

 

Source 
Connec- 
tion 

 
 
 
 
 
 
 
 

Maintain 
Import Job 

Manager 
Insights menu > 
Import Jobs. In 
the Explore - 
Import Jobs 
window, select 
the Manage bar, 
and then select 
Maintain 
Source 
Connection. 

 

Data Import 
Insights menu > 
Import Jobs. In 
the Explore - 
Import Jobs 
menu, select 
the Manage bar, 
and then select 
Maintain 
Import Job. 

 
 
 
 
 
 
 
 
 
 

 
No No No No Create, No 

update, 
delete, 
and 
run an 
import 
job 

 
 

Sage 500 
How Task Is 

pkg 
admin DI pkg DI pkg DI pkg DI pkg 

ERP 
Invoked 

auth 
or admin user admin user 

Maintain Data Import No No Yes No Yes No 

 



No admin 

authority - 

password 

optional 

Admin 

authority - no 

password 

Admin authority 

- with password 

DI pkg 
Task in No DI 
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Sage 500 

ERP 

 
How Task Is 

Invoked 

 
pkg 

auth 

 
admin 

or 

user 

 
DI pkg 

admin 

 
DI pkg 

user 

 
DI pkg 

admin 

 
DI pkg 

user 

Process Data Import No No No No Delete Delete 

Import Job Manager 
Insights menu > 

    and 
run an 

and run 
an 

 Import Jobs. In 
the Business 

    import 
job 

import 
job 

 Insights Explore 
window, select 

     execu- 
tion 

 the Manage bar 
> Process 

      

 Import Job.       

Process 
Import Job 

Data Import 
Manager 

No No No No Delete 
and 

Delete 
and run 

 Insights menu > 
Job Executions. 

    run an 
import 

an 
import 

 In the Business 
Insights Explore 

    job job 
execu- 

 window, select 
the Manage bar 

     tion 

 > Process 
Import Job. 

      

Process Any module > No Yes No No Delete Delete 

Import Job Process Import 
Job (for a 

    and 
run an 

and run 
an 

 specific entity) 
under that 

    import 
job 

import 
job 

 module.      execu- 
tion 

 



No admin 

authority - 

password 

optional 

Admin 

authority - no 

password 

Admin authority 

- with password 

DI pkg 
Task in No DI 
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user 

 

Import Job 
Execution 

 
 

Explore - 
Import 
Jobs 

 

Explore - 
Import Job 
Executions 

Manager 
Activities menu 
> Purge Import 
Job History. 

 

Data Import 
Manager 
Insights menu > 
Import Jobs. 

 

Data Import 
Manager 
Insights menu > 
Import Job 
Executions. 

 
 
 
 
 

Yes Yes Yes Yes Yes Yes 

 
 
 

Yes Yes Yes Yes Yes Yes 

 
 

Sage 500 
How Task Is 

pkg 
admin DI pkg DI pkg DI pkg DI pkg 

ERP 
Invoked 

auth 
or admin user admin user 

Purge Data Import Yes Yes Yes Yes Yes Yes 
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Working with Alerts C 
 
 
 

 

Introduction 

This chapter provides general information and requirements for Alerts installation 

and configuration. 

In this chapter 

SQL Server Agent ................................................................................................. 194 

Database Mail ......................................................................................................... 195 
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Overview 

Because SQL Server Agent is a core component of Alerts, consider the following 

before you begin Alerts installation: 
 

• SQL Agent must be running. 

• We recommend that SQL Agent be configured to 
auto-start when SQL Service starts. 

• You should be familiar with the Jobs dialog box for SQL Agent under Enterprise 
Management. 

• SQL Agent has multiple options for logging errors: by default, Alert jobs log to 
the SQL Agent Error Log. 

• Changes made to job schedules in Enterprise Manager or SQL Server 
Management Studio will also be made to Sage 500 ERP Set Up Alerts. 

• Do not make changes to the Job or Job Step objects for Sage 500 ERP Alerts 
jobs. 
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Overview 
 

Introduction 

Database Mail must be configured correctly to run Sage 500 ERP Alerts. Consider the 

following before you begin Alerts installation: 

• Database Mail uses the standard Simple Mail Transfer Protocol (SMTP) to send 
e-mails. You can use Database Mail without installing an Extended MAPI client 
on the SQL Server. 

• Database Mail stores configuration and security information in the msdb 
database. Configuration and security objects create profiles and accounts used 
by Database Mail. 

• You can create multiple profiles on the server and select the profile to use 
when you send a message. 

• The msdb database acts as the mail-host database that holds the messaging 
objects that Database Mail uses to send e-mail. 

• Database Mail records logging information in the msdb database and the 
Microsoft Windows application event log. 
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Configuring Database Mail For SQL 2008 
 

Procedure 

This section describes how to configure Database Mail for SQL 2008 using the 

Database Mail Configuration Wizard. 

1 Start the Database Mail configuration by opening Microsoft SQL Server 

Management Studio. 

2 Expand the Management folder, and select Database Mail node. 

3 Right-click, and select Configure Database Mail from the Context menu. 

4 The Database Mail Configuration Wizard window appears. Click Next to 

continue. 
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5 In the Select Configuration Task, select the Manage Database Mail Accounts 

and Profiles option, and click Next to continue. 

 

6 The following message dialog box displays only when enabling the Database 

Mail feature for the first time. Click Yes to continue. 
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7 In the Manage Profiles and Accounts window, verify the Create a new account 

option is selected, and click Next. 

 

8 In the New Account window, enter the information for the new account, and 

click Next to continue. 
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9 After entering the information, click Finish to run the wizard. 

 

10 When the Configuring window displays, click Close to close the window. 

 

11 Start the Database Mail Configuration Wizard again, and click Next to 

continue. 
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12 In the Select Configuration Task window, select the Manage Database Mail 

Accounts and Profiles, and click Next to continue. 

13 In the Manage Profiles and Accounts, select the Create a Profile option, and 

click Next. 

14 In the New Profile window, enter the information, and click Add. 

 

15 Verify the SQL Mail option is selected at the Account name field, and click OK. 
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16 From the Programs group, select Microsoft SQL Server Management Studio > 

Management > Policies. 

 

17 Right-click the Policies folder and click Import Policy. 

 

18 When the Import Policy window appears, in the Files to import field, select the 

Surface Area Configuration for Database Engine 2008 Features.xml file and 

click OK. The file is located at: 
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C:\Program Files (x86)\Microsoft SQL Server\100\ Tools\Policies\Database 

Engine\1033\Surface Area Configuration for Database Engine 2008 

Features.xml. 

 

19 Right-click the server name and select Facets. 
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20 In the Facets drop-down menu, select Surface Area Configuration. 

 

21 In the Facet properties field, enable SQL Mail and click OK to finish the 

process. 
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Protocol Issues D 
 
 
 
 
 

This appendix provides detailed information to help you set up network protocol 

with the server. For more information about network protocols and other 

requirements, refer to the Compatibility and Resource Guide located in the Support 

page on the Sage Customer Portal at: 

https://customers.sagenorthamerica.com 

In this appendix 

Named Pipes over TCP/IP.............................................................................. 205 

Multi-Protocol over TCP/IP .......................................................................... 207 

TCP/IP Sockets over TCP/IP Protocol ..................................................... 209 

https://customers.sagenorthamerica.com/
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Named Pipes over TCP/IP 
 

 
Description 

A general rule for connecting using Named Pipes is that you must be logged on to the 

domain in which the SQL Server resides, or have an open pipe into a resource at the 

SQL Server. A pipe can be opened to the IPC$ sharepoint on the server using the net 

view command-line utility. Connecting to any other shared resource using the 

browse or mapping features in Windows Explorer or the Network Neighborhood 

applet serves the same purpose. 

 
Indication of operating protocol 

When you use Named Pipes over TCP/IP, you should be able to do the following: 

• Ping the SQL Server at a command prompt from the client machine. 

• Connect to the SQL Server using the MAS 500 ODBC DSN. 
 

Use the procedures in the following sections to set up the network protocol. 

 
SQL Server setup procedure 

Follow these steps to set up the SQL Server. 

1 Select Windows Start menu > All Programs > Microsoft SQL Server group > 

Server Network Utility. 

2 Select Add. 

3 Enter the pipe name at the Pipe name field, or accept the default by selecting 

OK. 

4 The SQL Server Network Utility returns you to the General tab page. Select OK. 
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Follow these steps to set up the client. 

1 Remove the NetBEUI protocol from the client system, or specify the TCP/IP 

protocol as the first in the Workstation binding order. 

2 Select Windows Start menu > Settings > Control Panel. In the Control Panel 

window, double-click Administrative Tools. In the Administrative Tools 

window, double-click Data Sources (ODBC). 

3 Select the MAS 500 DSN, and select Configure. If no Data Source Names for 

Sage 500 ERP appear in the list, see Chapter 3, Database Creation and Upgrade for 

installation instructions. 

4 Verify that the correct server name is entered. Select Next, and select Client 

Configuration. 

5 Select TCP/IP in the Network libraries section. 

6 Type the server IP address at the Computer name field and the port number at 

the Port number field. Click OK to accept the changes and close the Edit 

Network Library Configuration window. 

7 Enter a valid user ID and password or sa as the Logon ID with the appropriate 

password. 

8 Select Next to verify connectivity. When verified, select Cancel. 
 

9 Run the System Configuration Utility to check the connectivity to Sage 500 

ERP. Then, run the Sage 500 ERP client software. 
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Note the following when using the protocol: 

• The TCP/IP network protocol should be the first protocol bound to the 
Network Interface Card (NIC). To verify the protocol, use the Network applet 
in the Control Panel and view the settings for bindings. 

• All protocols except TCP/IP may have to be removed from the client system if 
the protocol bindings are not modified. 

 

Multi-Protocol over TCP/IP 
 

 
Description 

A general rule for connecting using Multi-Protocol is that you must be logged on to 

the domain in which the SQL Server resides, or have an open pipe into a resource at 

the SQL Server. A pipe can be opened to the IPC$ sharepoint on the server using the 

net view command-line utility. Connecting to any other shared resource using the 

browse or mapping features in Windows Explorer or the Network Neighborhood 

applet serves the same purpose. 

Note: For the SQL port number, refer to the SQL server documentation 

available on the Microsoft Web site. 

 
Indication of operating protocol 

When you use Multi-Protocol over TCP/IP, you should be able to do the following: 

• Ping the SQL Server at a command prompt from the client machine. 

• Connect to the SQL Server using the MAS 500 ODBC DSN. 
 

Use the procedures in the following sections to set up the network protocol. 
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Follow these steps to set up the SQL Server: 

1 Select Windows Start menu > All Programs > Microsoft SQL Server group > 

Server Network Utility. 

2 Select Add. 

3 Enter a server alias. If you want the alias and the computer name to be 

different, change the name at the Computer Name field. 

4 Select OK. The SQL Server Network Utility returns you to the General tab page. 

Select OK. 

5 Stop, then restart the SQL Server Service. 

 
Client (including Terminal Services) setup procedure 

Follow these steps to set up the client: 

1 Select Windows Start menu > Settings > Control Panel. In the Control Panel 

window, double-click Administrative Tools. In the Administrative Tools 

window, double-click Data Sources (ODBC). 

2 Select the MAS 500 DSN, and then select Configure. If no Data Source Names 

for Sage 500 ERP appear in the list, see Chapter 3, Express Installation for 

installation instructions. 

3 Verify the correct server name is entered. Select Next, and select Client 

Configuration. 

4 In the Client Configuration section on the Advanced tab, enter the server 

name or the Server alias. 

5 Select TCP/IP in the Network libraries section. 

6 Type the server IP address at the Computer name field and the port number at 

the Port number field. Click OK to accept the changes and close the Edit 

Network Library Configuration window. 

7 Enter a valid user ID and password or sa as the Logon ID with the appropriate 

password. 
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8 Select Next to verify connectivity. When verified, select Cancel. 

9 Run the System Configuration Utility to check the connectivity to Sage 500 

ERP. Then, run the Sage 500 ERP client software. 

 

TCP/IP Sockets over TCP/IP Protocol 
 

 
Description 

When you use TCP/IP sockets over TCP/IP, you should be able to do the following: 

• Ping the SQL Server at a command prompt from the client machine. 

• Connect to the SQL Server using the MAS 500 ODBC DSN. 
 

Use the procedures in the following sections to set up the network protocol. 

 
SQL Server setup procedure 

Follow these steps to set up the SQL Server: 

1 Select Windows Start menu > All Programs > Microsoft SQL Server group > 

Server Network Utility. 

2 Select Add. 

3 Enter a server alias. If you want the server alias and the computer name to be 

different, change the name at the Computer Name field. 

4 Select OK. The SQL Server Network Utility returns you to the General tab page. 

Select OK. 

5 Stop, then restart the SQL Server Service. 
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Client (including Terminal Services) setup procedure 

Follow these steps to set up the client: 

1 Select Windows Start menu > Settings > Control Panel. In the Control Panel 

window, double-click Administrative Tools. In the Administrative Tools 

window, double-click Data Sources (ODBC). 

2 Select the MAS 500 DSN, and then select Configure. These DSNs are created 

automatically when you install the client software, as described in ODBC, 

Registry, and OLE DB Additions on page 80. 

3 Verify the correct server name is entered. Select Next, and select Client 

Configuration. 

4 In the Client Configuration section on the Advanced tab, enter the server 

name or the Server alias. 

5 Select TCP/IP in the Network libraries section. 

6 Type the server IP address at the Computer name field and the port number at 

the Port number field. Click OK to accept the changes and close the Edit 

Network Library Configuration window. 

7 Enter a valid user ID and password, or sa as the Logon ID with the appropriate 

password. 

8 Select Next to verify connectivity. When this has been established, select 

Cancel. 

9 Run the System Configuration Utility to check the connectivity to Sage 500 

ERP . Then, run the Sage 500 ERP client software. 

 
IPC mechanism 

This IPC mechanism is specific to the TCP/IP protocol. Although it is not required, 

the connection string specifying the IP address and port number are recommended 

in the case that the IP name resolution service is not operating or available. 
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Silent Installation 
The silent installation feature enables you to install the software 

without having to respond to screens. Silent installation is 

available only for client installation. 

 
 

 
In this appendix 

Using Silent Installation .................................................................................. 212 

E 
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Using Silent Installation 
 

 
Overview 

 
Introduction 

You perform a silent installation by issuing a command in the Command Prompt 

window or running it from a batch file. No screens appear while you run the 

installation. 

You can use the basic command to install the software with default settings. You can 

also add parameters to the command to change options, such as the folder where the 

software is installed. 

 

When to Use Silent Installation 
 

Description 

The silent installation feature allows you to install the software without having to 

respond to screens. You may want to use the silent installation feature in the 

following situations: 

• You want to install the software in the default configuration, and you do not 
want to go through the installation wizard. 

• You want to install the software on several systems with the same settings. You 
can just insert the Sage 500 ERP DVD and run a batch file. 
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Precautions 
 

Description 

Before using silent installation, do the following: 

• Close any open programs. 

• If you have a previous version of the software, uninstall it before running the 
silent installation. 

 
Requirements 

When performing a silent installation with parameters, use Setup.exe to test for the 
presence of .NET Framework and required operating system service packs during client 

installation. 

 

Installing with Defaults 
 

Description 

When you use the version of the command with default settings, the following 

occurs: 

• If you do not already have Windows Installer on the system, it is installed for 
you. 

• The client software is installed in the C:\Program Files\Sage Software\Sage 
MAS 500 Client folder. 

• All software is installed. 

• Shortcuts to the client software are added to the Windows Start menu. 

 
Procedure 

Follow these steps: 

1 Hold down the SHIFT key while you insert the Sage 500 ERP DVD into the DVD 

drive. This prevents the Autorun feature from starting. 
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2 Open the Command Prompt window. 

3 Change to the drive where the Sage 500 ERP DVD is located. Then, change to 

the Client folder. 

4 Type the following command: 

Setup.exe STARTUPOPTION=0 /qn 

Note: There is a space between the 0 and /qn. Also, the 0 is a zero and not 

the letter O. 
 

After the installation is finished, perform any needed post-installation tasks as 

shown in the rest of this guide. 

 

Installing with Parameters 
 

Introduction 

To change the settings used in installation, run Setup.exe. Follow the Setup.exe 

command with parameters to specify installation settings, such as the destination 

folder. 

 
Parameters 

The client software installation has the following parameters: 

 
Property Value 

INSTALLDIR  Destination folder where 
you will install the 
software to. 

 

SERVERNAME The server to which you 
will connect the client 
software. 

 

APPFILENAME Sage 500 ERP database 
name. 
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Property Value 

ADDFEATURE Installs Sgae Budgeting and 
Planning and Sage 
Advanced Allocations if 
specified. 

 

ACP_NETWORK_PATH Folder path where Sage 
Budgeting and Planning 
Network is installed. 

 

AA_NETWORK_PATH Folder path where 
Allocations Network is 
installed. 

 

 

Procedure 

Follow these steps to install the Sage 500 ERP software: 

1 Hold down the SHIFT key while you insert the Sage 500 ERP DVD into the DVD 

drive. This prevents the Autorun feature from starting. 

2 Open the Command Prompt window. 

3 Change to the drive where the Sage 500 ERP DVD is located. Then, change to 

the Client folder. 
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4 Type the appropriate command. The basic syntax is as follows: 

Setup.exe Parameter=Value STARTUPOPTION=0 /qn 

Note: There is a space between the 0 and /qn. Also, the 0 is a zero and not 

the letter O. 

Where Parameter=Value is how you set options for the installation. 

For example, if you are installing the client software to D:\Program Files\Sage 

Software\Sage MAS 500 Client and connecting to server AcctData, you would 

issue the command as follows: 

Setup.exe INSTALLDIR="D:\Program Files\Sage Software\Sage MAS 500 

Client" 

SERVERNAME=AcctData  STARTUPOPTION=0  /qn 

Note the following: 

► The parameters STARTUPOPTION and /qn are always required. 

► INSTALLDIR is required when using parameters. 

► Enclose paths with spaces with double quotation marks, such as 

"C:\Program Files". 

► Separate multiple parameters with spaces. 

► There is a space between the 0 and /qn. Also, the 0 is a zero and not the 

letter O. 

Example 1: 

Use the following command to install Sage Budgeting and Planning Client with Sage 

500 ERP Client. 
setup.exe ADDFEATURE="ActivePlanner" ACP_NETWORK_PATH=" D:\Sage 500 ERP Active Planner\" 

STARTUPOPTION=0 /qn 

 

Example 2 

Use the following command to install both Sage Budgeting and Planning and Sage 

Advanced Allocations Client with Sage 500 ERP Client. 
setup.exe ADDFEATURE="ActivePlanner,Allocations" ACP_NETWORK_PATH="D:\Sage 500 ERP 

Active Planner\" AA_NETWORK_PATH="D:\Sage 500 ERP Allocations\" STARTUPOPTION=0 /qn 

 

 
After the installation is completed, perform any needed 

post-installation tasks as shown in this guide. 
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Desktop and 
 
Command Shortcuts 

 
 

You can launch Sage 500 ERP tasks directly from the Windows Desktop or from a 

command line. This section describes how to create shortcuts and obtain a list of 

Sage 500 ERP task IDs. 

In this appendix 

Command  Formats ............................................................................................ 218 

Task lDs and Programs .................................................................................... 224 

F 
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Command Formats 
 

 
Overview 

 
Introduction 

This section shows how to issue commands to launch Sage 500 ERP tasks directly and 

notes on how to use these commands. 

 

Methods for Creating Shortcuts 
 

Automatic and manual methods 

You can create shortcuts of tasks by performing one of the following: 

• Drag and drop the task from the Desktop to the Windows Desktop. 

• On the Desktop, right-click the task, and from the menu that appears, select 
Create Shortcut on Desktop. 

• From a command line (either with the Run command, at the Command 
Prompt window, or from a batch file), use the Desktop-launching command 
and specify the task's ID. 

 

Command Syntax 
 

Description 

The following programs are used to launch or control from the command line: 

• BusinessDesktop.exe: This is the Desktop program itself. From the command 
prompt, you can launch it directly, have it launch a specified task, or run in a 
specific mode. The program is located in the Sage 500 ERP Client\Managed 
Applications folder. 
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• BusinessDesktopLoader.exe: This is the helper application that communicates 
with the Desktop. This file is located in the system32 folder in your Windows 
folder. 

 
Example of command syntax 

To execute a task from a command, specify the following command: 

path\executable parameters 

Where: 

• Path is the complete path to the program. For BusinessDesktopLoader.exe, use 
C:\windows\system 32\ where windows is the Windows folder. For 
BusinessDesktop.exe, it is the BusinessDesktop folder where the Sage 500 ERP 
client is located (usually C:\Program Files\Sage Software\Sage 500 ERP 
Client\Managed Applications). 

• Executable is BusinessDesktopLoader.exe or BusinessDesktop.exe. 

• Parameters are the command-line parameters you use to specify features. 

 
Desktop commands 

BusinessDesktopLoader.exe uses the following parameters. 

(No parameters) 

If you launch BusinessDesktop.exe with no parameters, the Desktop opens. If SQL 

Server authentication is used, the logon window appears. If Windows authentication 

is used, the Desktop appears directly and logs on the current Windows user. The 

following is an example of the command: 

C:\Program Files\Sage Software\Sage 500 ERP Client\Managed 

Applications\BusinessDesktop.exe 

Note: This command is the same as launching BusinessDesktopLoader.exe 

with no parameters. 
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/Mode:Remote 

Starts the Desktop Loader, but does not log on a user. This command is used in the 

Startup program group to place the Desktop in the Windows System Tray so that 

Sage 500 ERP loads quicker. The following is an example of the command: 

C:\Program Files\Sage Software\Sage 500 ERP Client\Managed 

Applications\BusinessDesktop.exe 

/Mode:Remote 
 

You can follow /Remote with /Tasks parameters to launch tasks. The user is 

prompted to log on for each task. 

/Mode:RemoteLogin 

Starts the Desktop service and logs users on to Sage 500 ERP (either through the 

logon window with SQL Server authentication or automatically if Windows 

authentication is used), but does not open the Desktop. The following is an example 

of the command: 

C:\Program Files\Sage Software\Sage 500 ERP Client\Managed 

Applications\BusinessDesktop.exe 

/Mode:RemoteLogin 
 

You can use /Mode:RemoteLogin with /Tasks to start individual Sage 500 ERP tasks. 

Users are prompted to logon only the first time. The logon stays active even after the  

last specified task is shut down. 

/Mode:RemoteShow 

Starts the Desktop and prompts users to log on, if SQL Server authentication is used, 

or logs users on automatically if Windows authentication is used. When the user 

shuts down tasks, the Desktop and Desktop Loader stay loaded. The following is an 

example of the command: 

C:\Program Files\Sage Software\Sage 500 ERP Client\Managed 

Applications\BusinessDesktop.exe 

/Mode:RemoteShow 
 

Note: This command represents the default mode. 
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/Mode:StandAlone 
 

Opens the Desktop as a standard application. If SQL Server authentication is used, 

the logon window appears. If Windows authentication is used, the Desktop appears 

directly and logs on the current Windows user. When you exit Sage 500 ERP, both 

the Desktop and Desktop Loader are closed. 

The following is an example of the command: 

C:\Program Files\Sage Software\Sage 500 ERP Client\Managed 

Applications\BusinessDesktop.exe 

/Mode:StandAlone 

/Tasks:xxxxx 

Opens the Desktop service and the task with the specified task ID number. For 

information on obtaining a list of task ID numbers, see Task lDs and Programs on 

page 224. 

If SQL Server authentication is used, the logon window appears. If Windows 

authentication is used, the Desktop appears directly and logs on the current 

Windows user. The following is an example of the command: 

C:\Program Files\Sage Software\Sage 500 ERP Client\Managed 

Applications\BusinessDesktop.exe 

/Tasks:16843152 
 

This command uses BusinessDesktop.exe to launch task ID 16843152 for Assisted 

Company Setup. 

You can also use /Tasks with other parameters and use multiple /Tasks parameters to 

open several programs at the same time. The /Tasks parameters come after other 

BusinessDesktopLoader.exe parameters. For example, to launch View/Edit Invoices 

and the Aged Receivables Report while the system is in stand-alone mode, use the 

following command: 

C:\Program Files\Sage Software\Sage 500 ERP Client\Managed 

Applications\BusinessDesktop.exe 

/Mode:StandAlone /Tasks:84279346 /Tasks:84479240 

Note: This command is the same as launching BusinessDesktopLoader.exe 

with the /T parameter. 
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Desktop Loader parameters 

BusinessDesktopLoader.exe uses the following parameters. 

(No parameters) 

If you launch BusinessDesktopLoader.exe with no parameters, the Desktop opens. If 

SQL Server authentication is used, the logon window appears. If Windows 

authentication is used, the Desktop appears directly and logs on the current 

Windows user. The following is an example of the command: 

C:\Windows\system32\BusinessDesktopLoader.exe 
 

This is the command used for launching the Desktop from the Windows Start menu. 

Note: This command is the same as launching BusinessDesktop.exe with no 

parameters. 

/L 

Starts the Desktop loader, but does not open the Desktop or log on any users. The 

following is an example of the command: 

C:\Windows\system32\BusinessDesktopLoader.exe  /L 

/S 

Opens the Desktop but does not show the Desktop icon in the Windows System 

tray. If SQL Server authentication is used, the logon window appears. If Windows 

authentication is used, the Desktop appears directly and logs on the current 

Windows user. The following is an example of the command: 

C:\Windows\system32\BusinessDesktopLoader.exe  /S 

/Txxxxxx 

Opens the task with the specified task ID number. For information on obtaining a 

list of task ID numbers, see Task lDs and Programs on page 224. 

If SQL Server authentication is used, the logon window appears. If Windows 

authentication is used, the Desktop appears directly and logs on the current 

Windows user. The following is an example of the command: 

C:\Windows\system32\BusinessDesktopLoader.exe 

/T16843152 
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This command uses BusinessDesktopLoader.exe to launch task ID 16843152. 

Note: This command is the same as launching BusinessDesktop.exe with the 

/Tasks parameter. 

/X 

Closes the Desktop and the Desktop loader in the Windows System tray. The 

following is an example of the command: 

C:\Windows\system32\BusinessDesktopLoader.exe  /X 

 
 

Directly Launched Tasks and the Desktop 
 

Description 

Tasks launched through shortcuts behave just like every other Sage 500 ERP task. The 

Desktop supports shortcuts and does not appear unless specifically launched. 

 
Logon and company used 

If you launch a task from a shortcut, and it is the first Sage 500 ERP task to run on 

that machine, you are prompted with the logon window. After a successful logon, 

only the task invoked appears; the Desktop does not. Subsequent executions of 

shortcuts in this session do not launch the logon window. This limits you to working 

in only the company specified during the original logon. If it is necessary for you to 

work within multiple companies in one session, start the Desktop. 
 

If the Desktop is running when you launch a task directly, a shortcut execution 

launches the task in the company currently specified in the Desktop. 
 

If you launched a task from a shortcut, and the Desktop is not running, a subsequent 

execution of the Desktop does not invoke the logon window. 

 
Shutting down the Desktop 

If the Desktop is shut down, all tasks, including tasks started with a shortcut, are 

shut down. 
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Task lDs and Programs 
 

 
Overview 

 
Introduction 

You can generate a list of task IDs with menu titles and program names to identify 

the tasks for which to create shortcuts. This section describes how to obtain the task 

IDs. 

 

Obtaining the Task ID 
 

Description 

In a query tool, such as SQL Server Query Analyzer or SQL Server Management 

Studio, run the queries on the system database as shown in this section to get task 

IDs and program names. The queries shown here sort and present the information in 

different ways. 

 
Listing tasks for a specific module 

The following query lists only the tasks for a specific module. Tasks are organized by 

menu title. An ampersand (&) appears if shortcut characters are considered in the 

sort. 

SELECT DISTINCT f.Caption AS 'Menu Item', 

CASE TaskInterfaceType WHEN 5 THEN CONVERT(CHAR(255),TaskOleProgID) 

ELSE CONVERT(CHAR(255), UPPER(SUBSTRING(t.TaskOleProgID,1,8))) 

END AS 'Program Name', 

t.TaskID AS 'Task ID' 

FROM tsmPrimaryMenuItem f JOIN tsmPrimaryMenu p ON f.PrimaryMenuKey = 

p.PrimaryMenuKey JOIN tsmTask t 

ON f.TaskID = t.TaskID 
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JOIN tsmModuleDef m ON t.ModuleNo = m.ModuleNo 

WHERE p.PrimaryMenuID = 'Standard' AND m.ModuleID = 'XX' 

ORDER BY [Menu Item] 
 

Replace XX with the abbreviation of the module to obtain task IDs for. For example, 

to get a listing of System Manager tasks, change the WHERE line as follows: 
 

WHERE p.PrimaryMenuID = 'Standard' AND m.ModuleID = 'SM' 
 

This query will return all tasks with program names that start with the module 

abbreviation (such as an Inventory Management query that returns IMZMR001). The 

query does not return tasks added to one module that are based on a program for 

another module. For example, the Common Information module uses IMZMR001 

for Maintain Non-Inventory items, but IMZMR001 does not appear in a Common 

Information query. 
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Listing all tasks in order of module 

The following query lists all tasks in order of module and includes long task names. 

The query lists tasks assigned to a module that come from other modules, such as 

IMZMR001 for the Maintain Non-Inventory Item task in the Common Information 

module. 
 

SELECT DISTINCT m.ModuleID AS 'Module', f.Caption AS 'Menu Item', 

CASE TaskInterfaceType WHEN 5 THEN CONVERT(CHAR(255),TaskOleProgID) 

ELSE CONVERT(CHAR(255), UPPER(SUBSTRING(t.TaskOleProgID,1,8))) 

END AS 'Program Name', 

t.TaskID AS 'Task ID' 

FROM tsmPrimaryMenuItem f JOIN tsmPrimaryMenu p ON f.PrimaryMenuKey = 

p.PrimaryMenuKey JOIN tsmTask t 

ON f.TaskID = t.TaskID 

JOIN tsmModuleDef m ON t.ModuleNo = m.ModuleNo 

WHERE p.PrimaryMenuID = 'Standard' 

ORDER BY m.ModuleID 
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Best Practices for SQL 
 
Server Maintenance 

 
 

This appendix explains best practices for SQL Server maintenance in Sage 500 ERP. 

Successful management of your SQL environment is vital to the success of Sage 500 

ERP. Sage recommends the following best practices, arranged by frequency. 

Note: The tasks described in this section require expertise in SQL Server and 

database administration. It is recommended that you also have T-SQL 

(Transact-SQL) knowledge. 

In this appendix 

Best Practices to Perform Once ................................................................... 228 

Daily Best Practices ............................................................................................ 229 

Weekly Best Practices ....................................................................................... 230 

Monthly Best Practices .................................................................................... 231 

Miscellaneous Best Practices ......................................................................... 232 

G 
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Description 

Perform the following tasks once for SQL server maintenance. 

• Set up a test environment (ideally, a separate physical machine from 
production). 

• Disaster recovery strategy 

► Develop a disaster recovery strategy. 

► Test the disaster recovery strategy. 

► Document this strategy and place it in an obvious, accessible location. 

Write the document in a step-by-step format so that anyone can follow it. 

• Set up a help desk system where users can go. 

• Be sure that you are using the features you have enabled, especially if they 
have a performance impact (for example, application auditing or preload 
lookups). 

• Create a strategy to allow or deny ad-hoc queries from other applications. For 
example, determining whether to use Application DB roles in Sage 500 ERP. 

• Define your maintenance window. 

► Document the maintenance window and all the jobs that run within it. 

► Document the purpose of each custom job. 

• Create SQL Operators and define alerts to notify by text or phone of emergency 
situations (for example, database is down or bottleneck occurrences). 

• Consider creating event log notifications. 

• Determine the possibility to off load reporting to a dedicated report server. If 
you plan to use a report server, train users to run reports on the report server. 
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Description 

Perform the following tasks daily for SQL server maintenance. 

• Check the following SQL jobs in Sage 500 ERP installs: 

► QtyOn job 

► Registration job 

► Maintenance job 

► These jobs should be checked to make sure they have been set to active, are 

running, and have not failed. 

• Monitor SQL performance by using Performance Monitor (perfmon) to gather 
information about possible resource bottlenecks (for example, memory, CPU, 
or disk). 

• Check hardware for any potential problems. 

• Perform backups. 

► Verify the previous night’s backup by restoring. 

• Check event logs. 

• Check SQL Server logs. 
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Description 

Perform the following tasks weekly for SQL server maintenance. 

• Use a performance metric tool such as Quest PA or Microsoft Dashboard to 
determine long running queries, missing indexes, indexes that can be dropped, 
and so on. 

• Observe how users look up information and how they process tasks. This 
identifies tasks a user does that are incorrect or unnecessary, and identifies a 
need for new indexes. 

• Trend uptime and downtime statistics. 

► Trend performance metrics. 
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Description 

Perform the following tasks monthly for SQL server maintenance. 

• Monitor database growth in mas500app, tempdb, and the transaction log. 

• Monitor table growth. If tables are growing and they are heavily used, consider 
moving them to their own drive array. You will need to have a plan for 
database and user growth. 

• Check for fragmentation on machines periodically. 

• Check tciDbAcuityLog entries. 

► Check timQtyOnOrderVarianceLog. 
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Description 

Perform the following tasks as needed for SQL server maintenance. 

• Keep a log of customizations, their purpose, and contact information for third- 
party customizations. 

• Test the disaster recovery strategy at least once or twice a year. 

• Be sure that new code (for example, reports) that is written by anybody other 
than Sage, is not deployed to production without first being performance 
profiled. 

• Create a formal process that requires steps for deployment before being 
introduced into the production database. 

• Consider implementing change management control. 

► Review proposed reports, views, and queries for inefficient code before 

deployment to production. 

► Verify the potential performance impact. 
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Upgrading from SQL 
 
Server version 2008 R2  
 
SP3 or 2012 

 

This appendix explains how to upgrade from SQL Server 2008 R2 SP3 or SQL Server 

2012 to SQL Server 2014 Express. If you are upgrading from an edition other than 

SQL Server 2008 R2 SP3, refer to the Microsoft Web site for instructions. 

In this appendix 

Upgrading from 2008 R2 SP3 or 2012 .................................................. 234 

H 
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Upgrading from 2008 R2 SP3 or 2012 
 

 
Procedure 

To upgrade from SQL Server 2008 R2 SP3 or 2012 to SQL Server Express 2014 

1 On the server where SQL Server 2008 R2 SP3 is installed, right-click the SQL 

Server 2014 setup.exe file and click Run as administrator. 

2 In the SQL Server Installation Center window, click the Installation option. 

3 Click “Upgrade from SQL server 2005, SQL server 2008, SQL server 2008 R2 or 

SQL server 2012”. 

4 Double-click the setup.exe file to start the installation. 

5 Proceed through the wizard to complete the installation. 

• In the Upgrade Rules window, if any errors appear, correct them before 

proceeding. 

• In the Install Rules window, if any errors appear, correct them before 

proceeding. 

6 When the installation is complete, start SQL Server 2014. 

7 Verify that version 2014 is installed by executing the following query: 

select @@version 
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Error Messages I 
 
 
 
 
 

This appendix explains errors messages that might appear and recommends 

solutions for solving them. 

In this appendix 

Setup and Configuration Errors ............................................................... 236 

Registration Errors ............................................................................................. 237 

System Configuration Errors ...................................................................... 240 

Additional Error Messages ............................................................................. 242 
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Setup and Configuration Errors 
 

 
Description 

This section describes messages that appear as a result of setup and configuration 

errors. Check the system and Sage 500 ERP configuration to verify everything is 

correct. 

 
Messages 

An error occurred while trying to start Sage 500 ERP. Check the tracker log file for 

details regarding the problem. 

This problem may be caused by a problem with the client workstation. To verify that 

the problem is only with a specific client system, try logging on to Sage 500 ERP 

from another system. If you can log on successfully, try the following on the 

defective client system: 

• Run the Client Configuration Utility to verify the ODBC setup. 

• Verify that the client can connect to the SQL Server. Use ISQL, Enterprise 
Manager, or SQL Server Management Studio to check server communication. 

• Verify that the Sage 500 ERP installation did not encounter any errors. 

• Run a disk diagnostic tool such as Scandisk to verify that there are no drive 

errors. 

If you cannot log on to Sage 500 ERP from any client system, there might be a 

problem with the databases. Do the following: 

• View the generated log file located in C:\Program Files\ Sage Software\Sage 
500 ERP Client\SM\date.tracklog (where date is the current date) in Notepad or 
any text editor. This file lists information about the error. 

• Run database consistency check commands (DBCC) to check the databases. If 
there are no database errors, refer the problem to your system administrator 
who can contact your Sage business partner (reseller) or Sage Customer Support 
for further assistance. 
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Unable to load <path>sotainst.dll 
 

Verify the SQL Server and communications components have properly installed. 

ODBC access should be available to the SQL Server where Sage 500 ERP is located. 

Unable to register sotaview.dll 
 

Install Crystal Reports, and then reinstall Sage 500 ERP. 

 

Registration Errors 
 

 
Description 

The following messages provide information about the registration status. For 

instructions about registration, see Registering the Software on page 91. 

 
Messages 

Your Sage 500 ERP is not registered or the registration has expired. You have xx day(s) 

to register Sage 500 ERP. After the expiration date, you will not be able to access 

application tasks. 
 

This message appears during the grace period. For information, see Registration Grace 

Period on page 23. When you register the software, the message stops appearing until 

the registration expires and a new grace period begins. 

Your Sage 500 ERP is not registered or the registration has expired. Please use SM 

Maintain Site to register the software. If you need assistance, please contact your Sage 

business partner or Sage Customer Support. 
 

The 45-day grace period has expired. You do not have access to the system until you 

register the software. 

Your Sage 500 ERP installation is not registered to use the name module. Unable to start 

the task. 
 

The indicated module is not registered, and the 45-day grace period has expired. You 

must register the module to use it. 
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You have reached your Sage 500 ERP license limit of xx concurrent users. Please either 

close one of the Sage 500 ERP instances currently running on another workstation or 

purchase more Sage 500 ERP licenses. 
 

You have exceeded the maximum number of concurrent users granted by your 

license. Another user needs to log off before that user can log on. 

Your business date cannot exceed your registration expiration date plus 45 days. 
 

You cannot set the business date, either from the software or in the back end, past 

the grace period on a system that is unregistered or has an expired registration. 

Change to a business date within the grace period or register the software. 

Your Sage 500 ERP license allows you to run on SQL Server edition SQL Desktop or 

SQL Standard only. Please contact your Sage business partner or Sage Customer 

Support to resolve. 
 

The version of SQL Server you are using with Sage 500 ERP is unregistered. Register 

SQL Server before using it with Sage 500 ERP. 

The server side registration component is missing. Please resolve this by installing the 

Sage 500 ERP database utility on the server. 
 

The database installation is incomplete. Use the Custom installation of the Database 

Utilities and install the License Server Component. Then, try the registration again. 

For information about installing the Database Utilities, see Installing the Database 

Utilities on page 33. 

Your Site Information in the Registration Message does not match the data in your 

current configuration. To resolve, verify the Customer Number, SM Serial Number, and 

SM Unlocking Key and reregister. 

This is caused by either of the following: 

• You copied a registration message from a different site into a copy of Sage 500 
ERP. Submit a registration request from this site. 

• SQL Server Scheduler is not set up correctly. Verify that it is set up correctly 
before attempting automatic registration. 
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The URL to Sage 500 ERP Registration Web Service site is missing. Please contact your 

Sage business partner or Sage Customer Support to resolve. 
 

The URL was deleted from the database when modifications were made on the back 

end. Contact your Sage business partner or Sage Customer Support for instructions 

on correcting the deletion. 

The requested site is not known by Enterprise Registration Web Services. Please 

contact your Sage business partner or Sage Customer Support to resolve. 
 

Verify that you have entered the customer number, System Manager serial number, 

and System Manager unlocking key correctly. If you have entered them correctly but 

still get this error, contact Sage for assistance. 

The requested site is not active in Enterprise Registration Web Services. Please contact 

your Sage business partner or Sage Customer Support to resolve. 
 

Contact Sage for assistance. 

Site information (UserCustomerNo, SMSerialNo or SMUnlockKey) is missing. Please 

use SM Maintain Site to enter the proper values. 
 

The system attempted to send your registration automatically through SQL Server 

Agent, but you have not entered the registration information. Enter your customer 

number, System Manager serial number, and System Manager unlocking key in 

Maintain Site before attempting to sending the registration information. 

The Internet connection is not set up on your Sage 500 ERP database server. Please 

contact your system administrator to resolve. 
 

The system attempted to send registration information when the Internet 

connection was down. Verify that your Internet connection is up before sending the 

registration information. If you have a dial-up connection or trouble with your 

Internet connection, consider using manual registration. 

Your database server cannot connect to Enterprise Registration Web Services through 

the internet. Please contact your Sage business partner or Sage Customer Support to 

resolve. 
 

The system was unable to connect with the Enterprise Registration Web Services 

database because of a problem at Sage or in the Internet connection. Try registering 

the software again later. 
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System Configuration Errors 
 

 
Description 

The following messages refer to errors with Sage 500 ERP configuration. Check 

security settings and installation to resolve these problems. 

 
Message 

Security group must be different than the default security group. 
 

In Maintain Users, the default security group must be different than the groups 

entered into the Company/Group table. 

Unable to start the selected task. The task is either not active or not installed on your 

machine. 
 

Verify the programs for the module you are attempting to access have been installed 

at the client machine. If necessary, reinstall the client software. 

Sage 500 ERP does not support this client's current regional setting. 
 

The client system is set to a regional setting different from the Sage 500 ERP 

databases. By default, Sage 500 ERP databases are set to English (United States), code 

1033. It is recommended that client systems use this locale. 

If you need the client workstations to be of a different locale, change the locale of 

the Sage 500 ERP to one of the following. Only these English-language locales are 

supported. 

 
Locale Code 

English (Australian) 3081 

English (Belize) 10249 

English (Canadian) 4105 

English (Caribbean) 9225 
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Locale Code 

English (Ireland) 6153 

English (Jamaica) 8201 

English (New Zealand) 5129 

English (South Africa) 7177 

English (Trinidad) 11273 

English (United Kingdom) 2057 

English (United States) 1033 

 

To change the locale, run the following SQL command in Query Analyzer: 
 

spChangeLocaleID 'SageAppDB', CurrentLocale, NewLocale 
 

Where SageAppDB is the application database, CurrentLocale is the current locale code 

(default 1033), and NewLocale is the code of the locale to which you want to use. The 

single quotes around the application database name are required. 
 

For example, to change MAS500_app to English (Australia), execute the following 

command: 
 

spChangeLocaleID  'MAS500_iapp',  1033,  3081 
 

After you have changed the database locale, all of the client systems must be 

changed to match the locale. 
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Additional Error Messages 
 

 
Description 

In addition to error messages from Sage 500 ERP, you might see error messages from 

other software applications that work in conjunction with Sage 500 ERP. The 

following is a list of other areas or software applications that might display error 

messages while you are using Sage 500 ERP: 

• Microsoft Windows 

• Microsoft SQL Server 

• Microsoft Visual Basic 

• Microsoft Office 

• Crystal Reports for Sage 500 ERP 

• Any ODBC software applications 
 

See the documentation or the product's support Web site for information about 

resolving the error. 
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A 
Activation 

correcting unregistered modules 104 
modules 102 

Admin logon 
creating 39 
logging on with 88 
password 89 
Windows authentication 90 

Adobe Acrobat Reader, installation 8 
Allow read access option 116 
Application database 

comparing 50 
creating 40 
creating multiple 125 
name of 38 
selecting for logon 89 
upgrade script for 44 
upgrading 52 
where to install 37 

Application roles (AppRoles) 116 
ApplicationAppRole 116 
Assisted Company Setup 

copying company data 124 
list 170 

Automatic registration 94 

B 
Backup 

for duplicating databases 126 
prior to upgrading 46 
setting up periodic 58 
starting 58 

Best Practices for SQL Server Maintenance 
228, 234 

C 
CAD software demo, installing 69 
Checklist, client installation 66 
Client Configuration Utility. See Desktop 

Configuration Utility 
Client installation 

preliminary steps 64 
starting 67 

Client workstations 
changing installed modules 70 
connecting to moved or duplicated 

databases 123 
description of 14 
file locations 79 
ODBC and Registry additions 80 
options for software installation 64 
regional setting 240 
reinstalling software 70 
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Client workstations (continued) 

SQL Server and 65 
starting software as administrator 88 
Terminal Services installation 74 
uninstalling software 70 

Command-line parameters 218 
Companies 

copying data between 124 
creating 100 
deleting 105 
demo 31 
editing 104 
home currency 101 
listing of 169 
multiple in a database set 100 
report on 166 
selecting for logon 89 

Company List 169 
Company Profile report 166 
Company User Group Permissions report 

167 
Comparisons, database upgrades 

options for 49 
performing 50 
when to do 49 

Credential, designating for Data Import 
Manager 185 

Credit Card 
overview 2 
setting up module 2 

Crystal Decisions. See Crystal Reports 
Crystal Reports 

runtime 85 
uninstalling for upgrade 65 

Customizations 
database upgrades and 43 
preserving during upgrades 65 

D 
Data Import Manager 

checklist 173 
components needed for building SSIS 

packages 181 

 
Data Import Manager (continued) 

designating the Sage 500 ERP 
credential 185 

installing and configuring 173 
SQL Server installation and 

configuration 176 
Data Migrator and DataPorter, grace period 

restriction 24 
Data Source Names (DSN) 80 
Database backup 

for duplicating databases 126 
prior to upgrading 46 
setting up periodic 58 

Database Creation Utility 
creating databases 40 
database sizes 40 
description of 36 

Database Maintenance wizard 
starting after a wizard 41, 55 
starting by itself 57 

Database software. See Database Utilities 
Database Synchronization Utility, using 

120 
Database Upgrade Utility 

performing upgrades 52 
running after Database Utilities 

installation 33 

starting 43, 48 
when to do a comparison 49 

Database Utilities 
creating databases 36 
creating databases without 28 
installing 33 
prerequisites for installing 30 
uninstalling during upgrade 33 
upgrading with 43 

Databases 
adding 45 
comparing for upgrade 49 
creating multiple sets 125 
creating new 36 
duplicating 127 
Express Installation 28 



Index 

Installation and System Configuration  245 

 

 

 

 
Databases (continued) 

invalid names 38 
maintenance of 56 
master 13 
naming convention of 38 
populating 37 
preliminary steps 30 
protecting during upgrades 46 
setting size of 40 
SQL Server upgrades and 47 
tempdb 13 
upgrade log file 55 
which to install 37 

DBError.log 55 
Debugging 144 
Default administrative logon. See Admin 

logon 
Demo data 

contents of 31 
Desktop 

activating modules and 103 
application of customizations 130 
loading options 218 
shortcuts and 223 
supported customizations 130 
task menus 131 
user’s task menu 133 

Desktop Configuration Utility 
changing client settings with 80 
effects on Terminal Services 74 
location in Windows Start menu 79 
Windows authentication 90 

Distributed Management Objects (DMO) 
30 

F 
Fail-over clustering 23 

G 
Grace period 

access during initial period 24 
description 23 

Groups, selecting Windows 115 

H 
Hardware changes, effect on registration 23 
Home currency 101 

I 
Installation 

Adobe Acrobat Reader 8 
checklist 66 
client software 67 
client with Terminal Services 74 
Crystal Reports 85 

Crystal Reports Designer 81, 86 
Data Import Manager 173 
database express 28 
overview 17 
silent 211 
starting 7 
supplemental software 26 
third-party utilities 8 
web browser 7 

Installation and System Configuration guide, 
links in 2 

Installation window, using 8 
Internet Applications database. See 

eCustomer database 

L 
License 

number of systems 25 
selecting 93 
types 25 
viewing 96 
See also Registration 

Links, Installation and System Configuration 
guide 2 

Lists 
Assisted Company Setup 170 
Company 169 
Security Group 169 
Site Profile 170 
User 168 

Log file, database upgrades 55 
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Logging on 

administrative 88 
first-time 89 
restrictions on names 111 
shortcuts and 223 
window for 89 

Logs 
Maintenance Audit 165 
purging system activity 165 
System Activity 164 

M 
Maintain Lookup Views 139 
Maintain Lookups 137 
Maintain Site window 93 
Maintain Users 240 
Maintenance and support agreements, 

renewal of 23 
Maintenance Audit log 165 
Maintenance, database 56 
Manual registration 

procedure 94 
when to use 99 

Manufacturing 
CAD software demo 69 

Master database, description of 13 
Microsoft Windows, protocol 

configurations for 205 
Modules 

activation and Desktop 103 
changing installed 70 
fixing unregistered 104 
launching directly 219 
security events 109 
tasks 108 

Multi-Protocol 207 

N 
Named Pipes 205 
NT authentication. See Windows 

authentication 

O 
ODBC, additions for client software 80 

P 
Packing list, use in registration 91 
Passwords 

administrator 89 
clearing 118 
requiring 117 

Production license 25 
Program groups 79 
Protocols 

Multi-Protocol 207 
Named Pipes 205 
TCP/IP sockets 209 

Public security group 108 
Purge Activity Log 165 
Purging, system activity log 165 

R 
Read-only access 116 
Regional setting 

changing 240 
Registration 

automatic 94 
database changes and 121 
description 20, 91 
fixing activated unregistered modules 

104 
grace period 23 
hardware changes 23 
license settings 96 
log 96 
maintenance and support agreement 

renewals 23 
manual 94 
performing 92 
prerequisite steps 91 
renewing 97 
troubleshooting automatic 99 
unlocking information 91 
upgrades 20 
See also License 
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Registry, additions for client software 80 
Removal. See Uninstallation 
Reports 

Company Profile 166 
Company User Group Permissions 167 

using as maintenance tools 163, 193 
See also Lists and Logs 

S 
Scripts, upgrade 

generating 44 
names of generated 44 
selecting one for upgrade 52 

using generated 53, 54 
Security 

application roles (AppRoles) 116 
description 15 
groups 106 
module-specific events 109 
read-only access 116 

Security events 109 
Security Group list 169 
Security groups 

changing permissions 109 
changing settings 117 
default 114 
deleting 110 
description of 15 
Desktop customizations and 131 
high-level access 108 
listing by company 167 
listing of 169 
order of 107 
setting up 106 
troubleshooting 240 

Serial number 91 
Server 

in Sage 500 ERP structure 12 
See also SQL Server 

Server license component 99 
Service packs, provided 8 

 
Shortcuts 

commands for 219 
logging on with 223 

Silent installation, when to use 212 
Site Profile list 

description 170 
using 96 

Sockets 209 
SQL Server 

authentication 88 
client software on 65 
configuration for Data Import 

Manager 176 
creating logons 111 
creating multiple databases on 

different 125 
creating multiple databases on same 

125 
default administrative logons 88 
deleting users from 118 
duplicate databases on separate 127 
fail-over clustering 23 
installation for Data Import Manager 

176 
registering after changing 121 
reviewing database maintenance in 59 
selecting for logon 89 
upgrading 47 
Windows authentication and 15 

SQL Server Agent, running 62 
Starting client software as administrator 88 
Support 

contact information 4 
debugging information for 144 

SysAdmin security group 108 
System Activity log 164 
System Status 143 

T 
Task IDs 

obtaining 224 
Task menus, Desktop 131 
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Tasks 

assigning to security groups 108 

launching directly 219, 221, 222 
obtaining ID of 224 

TCP/IP 
Multi-Protocol 207 
Named Pipes 205 
TCP/IP sockets 209 

Technical support 
contact information 4 
debugging information for 144 

Tempdb, description of 13 
Terminal Services 

client installation 74 
installation with Add/Remove 

Programs 75 
setting changes and 74 
when to use 64 

Test systems, license for 25 
Tracker 144 
Transaction logs 

creating 40 
description of 13 
naming convention for 39 

Troubleshooting 
automatic registration 99 
database naming problems 38 
maintenance plans 61 

Two-tier architecture 12 

U 
Uninstallation 

client software 70 
Crystal Reports runtime 65 
during client upgrade 65 
during Database Utilities upgrade 33 

Unlocking keys 
entering 93 
where to find 91 

Upgrade scripts. See Scripts, upgrade 

 
Upgrades 

client 65 
customized databases 43 
Database Utilities 33 
log file for databases 55 
overview 18 
preliminary client software tasks 65 
registration 20 
uninstalling the client before 65 

User list 168 
Users 

adding to SQL Server 111 
clear passwords 118 
deleting 118 
listing of 168 
restrictions on logon names 111 
security groups for 106 
selecting groups 115 
selecting Windows 115 
task menu setting 133 
viewing logged on 143 

V 
Visual Process Flow 149 

add to menu 156 
add toolbar options 158 
create 152 
edit 151 
embed link to another VPF 155 
export or import 160, 161 
Launch embedded task 150 
requirements 150 

W 
Web browser, installation 7 
Windows authentication 

admin logon 90 
selecting users 115 
setting up users 15 

Windows Installer, description of 30, 66 


